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1 What�s New in This Release
What�s New in Siebel Marketing User Guide, Version 7.8, Rev. A
Table 1 lists changes described in this version of the documentation to support release 7.8 of the 
software.

Table 1. What�s New in Siebel Marketing User Guide, Version 7.8, Rev. A

Topic Description

Managing the catalog

Read Managing the Catalog on page 36

Added information on how to manage the 
catalog.

Refreshing display

Read Refreshing the Display on page 37

Added information on how to refresh the 
display of segments and segment trees.

Reloading server metadata

Read Reloading Server Metadata on page 37

Added information on how to reload 
server metadata to reflect the most 
recent metadata changes.

Results sets

Read Saving Result Sets for Marketing Segments on 
page 43

Added information on requirements.

Added information on saving results sets 
for segment trees.

Added information on purging results 
sets.

Segment advanced options

Read Segment Advanced Options on page 45

Added information on new controls.

Segment Designer

Read About Segment Designer on page 33

Added information on features available 
on the start page.

Segment extension attributes

Read Segment Extension Attributes on page 46

Added information on the new extension 
attributes feature for segments.

Segment tree advanced options

Read Segment Tree Advanced Options on page 55

Added information on new controls.
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What�s New in This Release ■ 
NOTE: In addition to the content-based changes listed in Table 2, this entire book has been revised 
to match the new documentation model.

Selection rules for segment trees

Read Adding Selection Rules to a Segment Tree on 
page 50

Added information on using the Selection 
Rules tab for segments trees.

Selection rules for segments

Read Adding Selection Rules on page 40

Added information on using the Selection 
Rules tab for segments.

Table 2. What�s New in Siebel Marketing User Guide, Version 7.8

Topic Description

Contact Call offers

Read Contact Call Offers on page 106

Added information on contact call offers 
for users of Oracle�s Siebel Pharma 
Marketing and Siebel Pharma Campaigns.

Enhanced adding contacts and prospects

Read Adding Contacts and Prospects to Campaigns 
Individually on page 156.

Revised the procedure.

Enhanced deleting lists.

Read Deactivating or Deleting Lists on page 203.

Added a procedure on deleting lists and a 
procedure on deactivating lists.

Enhanced executing programs.

Read Executing Programs on page 69.

Added a procedure on executing 
programs.

Enhanced procedures for viewing charts.

Read Displaying Campaign Charts in Siebel 
Campaigns on page 170 and Process of Displaying 
Response Charts in Siebel Campaigns on page 175.

Added a list of procedure heading for 
viewing charts topics.

Loyalty Programs

Read About Loyalty Programs on page 31.

Added information about associating 
loyalty programs with campaigns. For 
users of Siebel Loyalty Management only.

Marketing Plans and Budget Process

Read Process of Creating Marketing Plans and Budget 
Requests on page 19.

Added this process to clarify the steps to 
create a marketing plan and a budget 
request.

Marketing Program Design Process

Read Process of Designing Marketing Programs on 
page 57.

Added a process to clarify the steps to 
design marketing programs.

Table 1. What�s New in Siebel Marketing User Guide, Version 7.8, Rev. A

Topic Description
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What�s New in This Release ■
New HTML editor

Read Using the HTML Editor on page 85.

Added information on the new features of 
the HTML Editor.

Process flow

Read Marketing Process Flow on page 15.

Added new chapter on the process of 
constructing and executing campaigns 
and programs.

Relocated topics

Read About Associating Web Offers, Web Surveys, 
Events, and URLs with Offers on page 104, and 
Associating Web Offers, Web Surveys, Events, and URLs 
with Offers on page 105.

Moved these topics to a new location in 
the chapter for easier access and 
understanding.

Specialized Offers

Read Creating Other Offer Types on page 106.

Created a new topic that contains offers 
for specific specialized needs.

Waves for stand-alone campaigns

Read Using Waves with Campaigns on page 159.

Stand-alone campaigns can now include 
waves, and have hour-based lags.

Wireless offers

Read Wireless Offers on page 109.

Added information about wireless offers.

Table 2. What�s New in Siebel Marketing User Guide, Version 7.8

Topic Description
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2 Marketing Process Flow
Siebel Marketing helps you automate, design, and target marketing campaigns and programs. A 
marketing program can be complex, involving multiple stages, some that can recur automatically and 
can trigger new stages based on customer responses. For simpler needs, you can use a stand-alone 
campaign.

This chapter includes the following sections:

■ About Campaigns

■ Executing Campaigns from Start to Finish on page 17

About Campaigns
A campaign is a marketing tool to target and motivate specific segments of your customer base to 
achieve a specific result. Campaigns can be stand-alone or part of a multistage program. Stand-alone 
campaigns include the elements listed in Table 3.

Table 3. Elements in Stand-Alone Campaigns and Multistage Campaigns

Element Description

Offer Offers are a way to present content on product and services to current and 
potential customers as part of a campaign. Offers are associated with a 
campaign, and then presented to contacts and prospects when the campaign is 
launched. Offers can be reused in many campaigns, but the campaign is a one-
time instance of the offer presented to a customer at a certain point in time.

Offers associated with campaigns are created using the Offers screen. Typically 
each campaign has a single offer, but you can associate multiple offers with one 
campaign. For example, a single campaign may have email and Web offer 
treatments. For more information, read Creating and Using Offers on page 71.

Segment A segment defines a target set of customers or prospects. A campaign can target 
one or more segments. For more information, read Marketing Segments and 
Segment Trees on page 33.
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Marketing Process Flow ■ About Campaigns
For campaigns that are more complex than a stand-alone campaign, there are additional elements 
for planning, organizing, and targeting. Complex campaigns have multiple stages in which contacts 
in the first stage receive follow-up treatment in the program�s second and third stages, often based 
on the contact�s response to the original campaign. For more information, read About Multistage 
Programs on page 58. Tab lists elements found in multistage campaigns.

Source code A source code is composed of multiple codes that represent information about the 
customer, and the offer sent to the customer, so that you can track the customers� 
responses and gauge the reaction to a campaign and its offers. An administrator 
creates the source code definitions for you. For more information, read Siebel 
Marketing Installation and Administration Guide.

Vendor A vendor is a company that you retain to help you in a campaign, such as printing 
house, a fulfillment house, and a telemarketer. An administrator enters the 
vendor information for you. For more information, read Siebel Marketing 
Installation and Administration Guide.

Table 4. Elements Used Only in Multistage Campaigns

Element Description

Marketing 
Plans

Marketing plans provide support for planning and budgeting across the marketing 
organization. Using marketing plans, marketing executives and managers can 
create high-level business plans that cover a broad set of tactics, including 
outbound and inbound programs, campaigns, and events. For each plan, the 
marketing executive or team can set goals and objectives, identify available funds, 
assign budgets, associate multichannel marketing tactics, share documents, and 
generate forecasts. For more information about marketing plans, read Planning and 
Budgeting for Marketing on page 19.

Programs A program is a container for organizing, designing, and executing multistage, 
triggered, and recurring marketing programs using new or existing campaigns, lists, 
and segments. You can establish multiple stages for a marketing program. Each 
stage can have multiple campaigns, lists, segments, and segment trees. 
Subsequent stages can be based on a customer response or any other event. For 
example, a visit by a sales person to a premium customer may trigger a follow-up 
email to that customer for the selected product. For more information, read 
Designing Marketing Programs on page 57.

Table 3. Elements in Stand-Alone Campaigns and Multistage Campaigns

Element Description
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Marketing Process Flow ■ Executing Campaigns from Start to Finish
Executing Campaigns from Start to 
Finish
The approach for executing campaigns depends on if you are executing a stand-alone campaign or 
a marketing program (multistage campaigns):

■ Executing Stand-Alone Campaigns from Start to Finish on page 17

■ Executing Marketing Programs from Start to Finish on page 17

Executing Stand-Alone Campaigns from Start to Finish
To execute a stand-alone campaign you need to complete the following elements:

1 Segments. Read Marketing Segments and Segment Trees on page 33.

2 Offers. Read Creating and Using Offers on page 71.

3 Campaigns. Read Planning and Designing Marketing Campaigns on page 113.

4 (Optional) Waves. Read Setting Up Waves for Campaign Loads on page 65.

5 Launch campaign. Read Process of Launching Campaigns on page 164.

Executing Marketing Programs from Start to Finish
To execute a marketing program, you need to complete the following elements:

1 (Optional) Marketing Plan. Read Planning and Budgeting for Marketing on page 19.

2 Marketing Program. Read Designing Marketing Programs on page 57.

3 Segments. Read Marketing Segments and Segment Trees on page 33.

4 Offers. Read Creating and Using Offers on page 71.

Responses Response handling is essential in triggering follow-up stages. Whenever prospects 
or contacts respond to an offer through any channel (by inbound email, the Web, a 
call center, or sales representative, and so on), their responses may be captured in 
detail. You can use this data to determine which contacts to pursue as opportunities. 
For more information, read About Using Response Management on page 143.

Waves Waves are a method of phasing the delivery of a campaign or stage over time. For 
example, you want to extend an offer to millions of customers, but do not want to 
add more inbound call center staff to handle the load. Using waves, you can phase 
the delivery of offers over any time delay (in hours or days) you need. For more 
information, read Setting Up Waves for Campaign Loads on page 65.

Table 4. Elements Used Only in Multistage Campaigns

Element Description
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Marketing Process Flow ■ Executing Campaigns from Start to Finish
5 Response Handling. Read About Using Response Management on page 143.

6 (Optional) Waves. Read Setting Up Waves for Campaign Loads on page 65.

7 Launch program. Read Launching Programs and Campaigns on page 163.
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3 Planning and Budgeting for 
Marketing
Siebel Marketing provides support for planning and budgeting across the marketing organization.

This chapter contains the following sections:

■ About Planning and Budgeting for Marketing on page 19

■ Process of Creating Marketing Plans and Budget Requests on page 19

■ Creating and Submitting Budget Requests on page 29

■ About Loyalty Programs on page 31

About Planning and Budgeting for 
Marketing
Siebel Marketing provides support for planning and budgeting across the marketing organization. 
Using marketing plans, marketing executives and managers can create high-level business plans that 
cover a broad set of tactics, including outbound and inbound programs, campaigns, and events. For 
each plan, the marketing executive or team can set goals and objectives, identify available funds, 
assign budgets, associate multichannel marketing tactics, share documents, and generate forecasts.

The Marketing Planning module can be applied to fit any organizational planning approach, including 
plans based on time periods (such as quarterly or annual planning cycles), business units, product 
lines, or any other management structure. Plans can be organized in hierarchies with any number of 
levels to support small marketing organizations as well as more complex planning processes.

Executives can also set high-level corporate objectives and then assign goals to each business unit 
that is participating in the plan. Each business unit can then create its marketing plan to meet its 
own assigned goals, forecast the organization�s ability to achieve the assigned goals, and submit the 
plan for approval. Based on common goals and performance metrics, marketing organizations can 
develop their own set of key performance metrics and institute the use of those metrics across their 
marketing plans.

Process of Creating Marketing Plans and 
Budget Requests
To create marketing plans and budget requests, perform the following tasks:

■ Creating Marketing Plans on page 20

■ Setting Goals for Marketing Plans on page 21

■ Creating Plan Tactics and Associating Plan Tactics with Marketing Plans on page 23

■ Developing and Tracking Budgets for Marketing Plans on page 25
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Planning and Budgeting for Marketing ■ Process of Creating Marketing Plans and Budget 
Requests
■ Associating Fund Requests with Marketing Plans on page 26

■ Attaching Documents to Marketing Plans on page 26

■ Adding Expenses for Events, Campaigns, and Programs on page 26

■ Associating Invoices and Invoice Items with Expenses on page 28

■ Using the Marketing Plan Explorer on page 28

Related Topic
■ About Developing and Tracking Budgets for Marketing Plans on page 24

Creating Marketing Plans
You create a marketing plan in the Marketing Plans screen. The Marketing Plans list provides a list 
of the marketing plans to which you have access.

The visibility filter provides several levels of visibility, including the following views:

■ My Marketing Plans displays marketing plans with which you are associated as a team member.

■ All Marketing Plans displays marketing plans in your assigned organizations.

■ All Marketing Plans across My Organizations displays marketing plans that exist in your 
organizations and in any suborganizations in your organizations.

■ All Marketing Plans across Organizations displays the marketing plans that exist in every 
organization in your application.

To create a marketing plan

1 Navigate to the Marketing Plans screen.

2 In the Marketing Plans list, create a new record.

3 Complete the fields, using Table 5 as a guide.

Table 5. Marketing Plans Fields

Field Description

Marketing Plan 
Name

(Required) The name of the marketing plan.

Plan Code (Required) An identification code provided by you. Must be a unique value.

Type (Optional) A list of the category types of marketing plans. Examples of 
possible values include Corporate, Regional, Business Unit, and Department.

Objective (Optional) A text description of the objective of the marketing plan.
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Setting Goals for Marketing Plans
Each marketing plan can be associated with a set of goals. Each goal is a metric against which the 
performance of the plan is measured.

To create a goal for a marketing plan

1 Navigate to the Marketing Plans screen.

2 In the Marketing Plans list, click a plan name.

3 In the Marketing Plans form, use the Type drop-down list to choose a type of plan.

4 Click the Goals view tab.

5 In the Goals list, click Apply Goal Template.

The goals from the template populate the Goals list.

NOTE: If a template is not available, a message appears indicating that there is no active goals 
template for the specified type that you chose in Step 3.

6 If a goal template is not available, in the Goals list, create a new record.

Planning Period (Optional) You associate the planning period with the plan so that you can use 
it during categorization and reporting. For example, you may need to track a 
quarterly or annual planning period.

Execution Period (Optional) The period in which the plan is to be executed.

Approval Status A status field that indicates that the plan has been Approved, Declined, 
Submitted, or Needs Revision.

Approval History Displays the history of approvals for the budget request.

Region (Optional) A listing of regions that you can associate with this plan. Regions 
are organized using a region hierarchy.

Organization (Optional) A multivalue field displaying organizations associated with the 
plan. Organizations that appear in this list have visibility to the plan.

Team (Optional) A multivalue field containing members of the team for the plan.

Table 5. Marketing Plans Fields

Field Description
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Requests
7 In the new record, complete the fields using Table 6 as a guide.

NOTE: Make sure that you select the appropriate number format for the goal type.

Table 6. Fields for Marketing Plan Goals

Field Description

Metric Type of goal. The following are some of the values for this field:

■ Average Cost per Lead. (Number Format=Currency) The expected cost of the 
marketing activities in the plan divided by the number of sales leads 
generated.

■ Average Cost per Opportunity. (Number Format=Currency) The expected 
cost of the marketing activities in the plan divided by the number of sales 
opportunities generated.

■ Average Cost per Order. (Number Format=Currency) The expected cost of 
the marketing activities in the plan divided by the number of sales orders 
generated.

■ # Leads. (Number Format=Integer) The number of sales leads this plan is 
expected to yield. The definition of lead may vary based on your company�s 
business process.

■ ROI %. (Number Format=Percentage) The Return on Investment percentage 
that this plan is expected to earn.

■ Unit Volume. (Number Format=Integer) The number of product units that 
are expected to be sold as a result of this plan.

Number Format The types of formats are Number (nonfinancial), Percentage (nonfinancial), and 
Currency (financial).

■ If you select the Currency number format (a financial goal), complete the 
Target Amount field.

■ If you select a different number format (a nonfinancial goal), in the Target 
Qty field, enter the target number for the goal.

NOTE: If the goal has a Number Format of Percentage be sure to enter whole 
number values, not decimal values. For example, an ROI goal of 15% should 
be entered as �15�, not �.15�.

Forecast 
Amount or 
Forecast 
Quantity

If you know the expected forecast value, enter it in the Forecast Amount or 
Forecast Quantity field. If you do not know the expected forecast value, leave 
the Forecast Amount or Forecast Quantity field empty, and add the value after 
you develop a forecast.
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Creating Plan Tactics and Associating Plan Tactics with 
Marketing Plans
A plan tactic is a marketing program, event plan, or stand-alone campaign that you have associated 
with a marketing plan. A marketing plan can be associated with any number of marketing programs, 
event plans, or stand-alone campaigns:

■ A marketing program is any program created in the Programs screen.

■ An event plan can be any event plan created in the Events screen.

■ A stand-alone campaign can be any campaign created in the Campaigns screen that is not 
associated with a marketing program.

You can create new tactics while developing your marketing plan or associate existing tactics with 
the marketing plan.

To create a new plan tactic and associate it with a marketing plan

1 Navigate to the Marketing Plans screen.

2 In the Marketing Plans list, click a marketing plan name.

3 Click the Plan Tactics view tab.

4 In the Plan Tactics list, create a new tactic.

5 In the new tactic record, complete the Tactic Name and Type fields.

CAUTION: Be sure to select the correct Tactic Type (Event Plan, Program, or Standalone 
Campaign) before saving the record, because the type cannot be changed after the record is 
saved.

To associate an existing plan tactic with a marketing plan

1 Navigate to the Marketing Plans screen.

2 In the Marketing Plans list, click a marketing plan name.

3 Click the Plan Tactics view tab.

4 In the Plan Tactics list, click Add.

You can modify every fields in this record except Type.

5 In the Pick Tactic dialog box, query for an event, program, or stand-alone campaign, and click 
OK.

NOTE: Each tactic can be associated with only one marketing plan.
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About Developing and Tracking Budgets for Marketing 
Plans
You can use marketing plans to develop budgets. As you implement tactics, you can track the 
financial status of the marketing plan. A marketing plan contains financial details that provide 
visibility across your company's marketing spending. The following list includes some of the financial 
details you may want to use:

■ Authors of the plan can add the expected cost of the plan and owners of the budget can allocate 
money to the plan.

■ An associated group of budget requests so that tactic owners can send requests for funding 
through an approval process.

■ A list of tactics, including their requested and allocated budgets, can be associated with the plan.

■ Financial summary fields can calculate the forecast and actual revenue and expenses for the 
tactics in the plan.

Use the marketing plan to review and approve budgets, to forecast expenses and revenues, and to 
record actual expenses and revenues for the campaigns, events, and programs in your organization. 
The marketing plan provides the following categories of values for managing marketing budgets:

■ Requested and Assigned Budget. The Plan Tactics view tab contains two fields that show how 
much money the plan owner has requested (Requested Budget) and how much money has been 
approved by the budget owner (Assigned Budget). These fields can be edited.

■ Forecast and Actual Expenses. The total forecast and actual expenses across tactics in the 
marketing plan.

■ Forecast Expenses. Total forecast expense value for expense records associated with the 
tactics (programs, campaigns, and events) in the marketing plan.

■ Actual Expenses. Total actual expense value for expense records associated with the tactics 
in the marketing plan.

Table 7 identifies the location of expense data for each type of tactic.

Table 7. Expense Source Fields (Forecast and Actual)

Tactic Type Where to Find the Input Data

Event Plans Events screen > Event Plans > Plan > Expenses 

Events Events screen > Plan > Expenses

Programs Programs screen > Plan > Expenses Campaigns screen > Plan > 
Expenses (for campaigns associated to programs)

Standalone Campaigns Campaigns screen > Plan > Expenses
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■ Forecast and Actual Revenue. The total actual expenses and revenues across tactics in the 
marketing plan. The Plan Details view tab includes a Financial Summary section summarizing 
total revenues for the tactics in the plan.

Table 8 identifies the location of revenue data for each type of tactic.

■ Forecast Revenue. A total of forecast values for revenue goals such as forecast amount for 
tactics in the marketing plan.

■ Actual Revenue. The Total Order Revenue for orders associated with a tactic using values 
obtained from the Siebel Analytics Server after the Siebel Data Warehouse is populated from 
the Siebel transactional database. If the value from the Analytics Server is not integrated 
into your environment, the value is blank.

Developing and Tracking Budgets for Marketing Plans
You can use marketing plans to develop budgets. As you implement tactics, you can track the 
financial status of the marketing plan.

To assign requested and assigned budgets to marketing plan tactics

1 Navigate to the Marketing Plans screen.

2 In the Marketing Plans list, click a marketing plan.

3 Click the Plan Tactics view tab, and verify that you have associated your targeted programs, 
events, and stand-alone campaigns.

For more information on associating plan tactics, read Creating Plan Tactics and Associating Plan 
Tactics with Marketing Plans on page 23.

4 If the columns for Assigned Budget and Requested Budget are not visible in the list, then make 
them visible.

a From the Plan Tactics Menu, choose Columns Displayed.

b In the Columns Displayed dialog box, move Assigned Budget and Requested Budget to the 
Selected Columns list and click Save.

5 In the appropriate column, enter the assigned or requested or amount.

If you developed forecast expenses for the tactic, you can verify the plan is within budget by 
comparing your assigned budget to the forecast expenses.

Table 8. Revenue Goals Source Fields (Forecast and Actual)

Tactic Type Where to Find the Input Data

Campaigns Campaigns screen > Plan view tab > Goals link

Event Plans Events screen > Event Plans link > Plans view tab > Revenue link

Programs Programs screen > Plan view tab > Goals link
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Associating Fund Requests with Marketing Plans
If your company uses the Market Development Funds module (MDF), any fund request can be 
associated with a plan tactic. For more information about creating fund requests, read the section 
about fund requests in Siebel Partner Relationship Management Administration Guide.

To associate a fund request with a marketing tactic, each fund request needs a link to the Marketing 
Purpose field in the request. After you associate fund requests with a tactic, the total value of the 
associated fund requests appears in the Total Funds field in the Marketing Plan form.

To associate a fund request with a marketing plan

1 Navigate to the Fund Requests screen.

2 In the Fund Requests list, select the fund request, and then click the Marketing Purpose select 
button.

To display the Marketing Purpose field, you may need to click the menu button, choose Columns 
Displayed, and add the column.

3 In the Pick Source dialog box, select the marketing tactic (program, campaign or event) that you 
want to associate with the fund request.

Attaching Documents to Marketing Plans
You can attach planning documents to a marketing plan using the Documents view. These documents 
are visible to anyone who has access to the plan.

To attach a document to a marketing plan

1 Navigate to the Marketing Plans screen.

2 In the Marketing Plans list, click a Marketing Plan name.

3 Click the Documents view tab, and attach the document to the marketing plan in either of the 
following ways:

■ If the document is a file on your computer or network, click New File, then navigate to the 
file, and click Open.

■ If the document is a Web page, click New URL, paste the URL into the URL field, and click Add.

Adding Expenses for Events, Campaigns, and Programs
Using the Expense views for event plans, events, campaigns, and programs you can add the type 
and amount for each budget expense along with information, such as the purchase order number 
and invoice details. After you add expenses, the total forecast and actual values are calculated and 
displayed in the parent marketing plan for the tactic.
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To add expenses for a campaign, event, event plan, or program

1 Use one of the following steps.

2 Navigate to the appropriate screen for your product:

■ For campaigns, navigate to the Campaign Management screen.

■ For events, navigate to the Events screen > Events view.

■ For event plans, navigate to the Events screen > Event Plan view.

■ For programs, navigate to the Programs screen.

3 In the list, click a campaign, event, event plan, or program name.

4 Click the Plan view tab.

5 In the Plan link bar, click Expenses.

6 Create a new record, and complete the fields.

7 (Optional) For programs only, associate the expense to a specific campaign by choosing the 
campaign in the Campaign Name field, if appropriate.

Table 9 on page 27 contains descriptions of some of the fields available.

Table 9. Expense Fields for Campaigns, Events, Event Plans, and Programs

Field Description

Expense (Campaigns 
and Programs only)

A reference name for the expense.

Campaign Name 
(Programs only)

A reference name for the campaign.

Purpose (Campaigns 
and Programs)
Cost Type (Events and 
Event Plans)

The category for the expense.

Unit (Campaigns and 
Programs only)

Indicates if the expense is a fixed or unit (variable) cost.

Invoice Id# The Id that corresponds to the invoice received. This information is 
available only if your company stores invoice information in the 
application. For more information, read Associating Invoices and 
Invoice Items with Expenses on page 28.

Assigned Budget 
(Campaigns only)

The amount budgeted for the expense.

Forecast # Units,
Forecast Unit Cost, 
and
Forecast Expense

Typically, the Forecast amount indicates the expected cost of the 
expense before the actual quote or invoice is received for the expense.

The Forecast Expense column is calculated by multiplying Forecast # 
Units by Forecast Unit Cost.
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Associating Invoices and Invoice Items with Expenses
Invoice values are available only if your company stores invoice information in the application.

To associate invoices and invoice items with expenses

1 Navigate to the Campaigns, Events, or Programs screen.

2 Click the campaign, event, event plan, or program name.

3 Click the Plan view tab.

4 In the Plan link bar, click Expenses.

5 In the Expenses list, locate the expense record to associate the invoice and Invoice item.

6 Click the Invoice Id # select button, query for the invoice number, and click OK.

NOTE: Only Invoices with a type of Payable appear.

7 Scroll down to the Invoice Line Items list, and click Add.

8 In the Pick Line Items dialog box, select one or more line items to associate with the expense.

9 Click Update Actual Cost to update the Actual Expense field on the expense record.

NOTE: You can associate different line items from the same invoice to different expense records.

Using the Marketing Plan Explorer
To review the organization of your marketing plans and its associated budget requests and plan 
tactics, use the Plan Explorer.

Actual # Units,
Actual Unit Cost,
and
Actual Expense

Typically, the Actual amount indicates the true cost of the expense 
after the quote or invoice is received.

The Actual Expense column is calculated by multiplying Actual # Units 
by Actual Unit Cost.

Variance Calculated as Actual Expense less Forecast Expense.

Event (Event Plans 
only)

Associates the expense with a specific event.

Session (Events and 
Event Plans only)

Associates the expense with a specific session.

Expense Date Determines the correct exchange rate, if your application spans 
multiple currencies.

Table 9. Expense Fields for Campaigns, Events, Event Plans, and Programs

Field Description
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To use the Plan Explorer

1 Navigate to the Marketing Plans screen > Plan Explorer view.

2 Expand the Marketing Plans folder.

3 To display budget requests associated with a marketing plan, expand a budget requests folder in 
the parent plan folder.

4 To display plan tactics associated with a marketing plan, expand a plan tactics folder in the parent 
plan folder.

Creating and Submitting Budget 
Requests
Use budget requests to request money to pay for a marketing activity such as a campaign, event, or 
program. You can specify the amount of funding you need, associate the tactics related to the 
request, and submit the request for approval from the budget owner in your organization. Budget 
requests can be associated with a marketing plan or created and approved without establishing a 
relationship to a marketing plan.

To create a budget request

1 Navigate to the Marketing Plans screen.

2 In the Marketing Plans link bar, click Budget Requests.

3 In the Budget Requests list, create anew record, and complete the fields using Table 10 on 
page 29 as a guide.

4 To associate campaigns, or event plans programs, with a budget request, select the Plan Tactics 
view tab, and click Add.

Table 10. Budget Request Fields

Field Action

Total Requested Total amount of the budget request. This field must be completed, or 
the budget request cannot be submitted.

Approval Status A status field that indicates that the plan has been Approved, 
Declined, Submitted, or Needs Revision.

Marketing Plan Associates the request with the marketing plan.

MDF Requested Calculated by totaling the MDF Requests associated with any tactics 
in the budget request.

Approval History Displays the history of approvals for the budget request.

Planning Period Indicates the time period during which the request is active. For 
example, an annual or quarterly budgeting period.
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Budget Category (G/L 
Account)

Choose a budget category for the request. The categories typically 
correspond to the values in the back-office accounting general 
ledger.

Net Requested Calculated by subtracting the MDF Requested from the Total 
Requested.

Approved Budget Specify the amount of money approved for the request. This field 
should be used only by employees with budget authority.

Region Select the region authorized to spend the funds.

Type The value corresponds to the categories that your organization uses 
to organize and review requests.

Line Number You can use this field in any way that meets your business needs. For 
example, some general ledger applications generate a line number 
for each budget item.

Organization Associates the request with organizations that should have visibility 
to the request.

Pre-Approved Indicates if approval has already been provided. When you check the 
preapproval flag, the value in the Approval Status field is prefilled 
with Approved.

Delivery Date The date that the funds need to be available.

Team Select the employee positions that should have visibility to the 
request.

Brand The Brand (category) related to the tactics for the request.

Product Lines The product lines related to the request.

Products The products related to the request.

Target Industry The target industry for the tactics in the request.

Market Development Funds Select an MDF Fund to indicate the source of any MDF Requests to 
be associated with tactics for the request. This relationship does not 
limit any associations between MDF Request and the tactics.

Actual Total Expense The calculated total of expenses from the tactics associated with the 
budget request.

Actual MDF Received The calculated total of MDF Requests associated with the budget 
request tactics.

Table 10. Budget Request Fields

Field Action
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After you create the budget request (making sure that the Total Requested field is complete), submit 
the budget request.

NOTE: Be sure that the marketing plan for the budget request is associated with a tactic before 
submitting the request. For instructions, read Creating Plan Tactics and Associating Plan Tactics with 
Marketing Plans on page 23.

To submit a budget request

1 From the Approval Status drop-down list, choose Submitted.

The Pick Employee dialog box opens.

2 In the Pick Employee dialog box, select the employee to whom you want to submit the budget 
request.

3 (Optional) Add a comment to the request.

To approve or decline a budget request

1 Navigate to the My Approvals Inbox view.

2 Click the budget request name.

The Marketing Plans > Budget Request view appears.

3 In the Approval Status drop-down menu, choose Approved, Declined, or Needs Revision.

The Pick Employee dialog box opens.

4 In the Pick Employee dialog box, select the employee who submitted the budget request.

5 (Optional) Add a comment to the request.

To associate a budget request with a marketing plan

1 Navigate to the Marketing Plans screen

2 In the link bar, click Plan Explorer.

3 In the Marketing Plans list, expand a Marketing Plan name.

4 Click the Budget Requests folder.

5 In the Budget Requests list, click Add.

6 In the Pick Budget Request dialog box, select the budget request, and click OK.

NOTE: If there are any tactics associated with the budget request that are not already associated 
with a marketing plan, the tactics are then associated with the marketing plan.

About Loyalty Programs
Loyalty programs are available in Siebel Loyalty Management only.
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You can associate a campaign to your loyalty promotions by first associating the loyalty program with 
a marketing plan. Any expenses for the loyalty promotion are then rolled up to the marketing plan 
and appear in the audit trail.

To associate a loyalty program with a marketing plan

1 Navigate to the Marketing Plans screen.

2 Click a marketing plan.

The Plan Tactics view tab appears.

3 Click the Plan Details tab.

4 In the Marketing Plan Details form, choose a Loyalty Program.

To associate a loyalty promotion with a campaign

1 Navigate to the Marketing Plans screen.

2 Click a marketing plan.

The Plan Tactics view tab appears.

3 Add a new plan tactic.

4 Click the plan tactic.

5 Click the Design view tab.

6 Click the Related Loyalty Promotions link.

Siebel Marketing displays a list of Loyalty programs that are associated with the selected 
Marketing plan.

7 Add a promotion.
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4 Marketing Segments and 
Segment Trees
You can use Siebel Marketing to develop target segments for marketing campaigns. From the 
segmentation home pages, you can perform the following tasks:

■ Create a segment. A segment defines a target set of customers or prospects. In most cases, 
the members of a segment change over time because the criteria are reevaluated against the 
most current data in your database.

■ Create a segment tree. Use a segment tree to select one or more segments and split the 
segment members into smaller groups (or target cells).

■ Create a List format. List Formats define the layout of files that you can use for purposes such 
as mailing to postal addresses or email addresses.

■ Manage marketing jobs. The Manage Marketing Jobs link on the segmentation home pages 
displays your jobs and cache entries. The administrator can display job and cache entries for 
every user. For more information about managing marketing jobs, read Siebel Marketing 
Installation and Administration Guide.

This chapter contains the following sections:

■ About Segment Designer on page 33

■ About Segment Tree Designer on page 46

■ Creating and Editing Segment Trees on page 47

About Segment Designer
The Segment Designer determines how many prospects or customers qualify for a series of criteria. 
Each Segment is created by adding a sequence of successive criteria blocks to refine the segment 
membership. With each additional criteria block that you add, the membership can either increase 
or decrease depending on whether the criteria excluded or added members. You can create a new 
segment, you can click the new icon or open a saved segment, modify it, and save it with a new 
name.

Each segment is based on a target level that indicates the type of customer you plan to count and 
target for your campaigns. For example, target levels may include companies, individuals, or 
households.

For each target level there are a set of relevant subject areas that contain the information about that 
target level. These subject areas organize available facts and attributes into common topics such as 
Campaign History, Orders, Products Owned, or Service History.

From the start page for the Segment designer, you can do the following:

■ Open a Saved Segment. To open an existing segment, drill down on the segment folders in the 
left column.
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■ Create a New Segment. To create a new segment, select a target level from the list of target 
levels.

■ Manage Marketing Jobs. To view the status of jobs that are processed by the server, click the link.

For additional information, read the following topics:

■ Frequently Used Terms for Marketing Segmentation on page 34

■ Managing the Catalog on page 36

■ Refreshing the Display on page 37

■ Reloading Server Metadata on page 37

■ Creating Segments in Segment Designer on page 37

■ Adding Criteria Blocks to Segments on page 38

■ Saving Result Sets for Marketing Segments on page 43

■ Segment Advanced Options on page 45

Frequently Used Terms for Marketing Segmentation
Table 11 defines frequently used segment and segment tree terms.

Table 11. Frequently Used Terms for Marketing Segmentation

Term Description

Criteria Block Building block of a segment. With each additional criteria block that you 
add, the membership can either increase or decrease. 

Cumulative Count A type of count computed by the Segment Designer. The cumulative 
count represents the total number of segment members that qualify for 
the indicated criteria block as well as the criteria blocks above it. As you 
add an additional criteria block at the bottom of the stack, the 
cumulative count either increases or decreases depending on whether 
you add, keep, or exclude segment members from the previous result.

Deduplication Calculation that removes overlapping members of a segment tree 
branch. Overlapping members are members of one branch that also 
qualify for any higher priority branch.

Eligible Audience A set of criteria that constrain the members of a segment tree. The 
eligible audience appears in the top section of the segment tree. The 
Eligible Audience criteria are defined by selecting a segment with the 
criteria and then adding the segment to the Eligible Audience section of 
the Segment Tree. For example, you may have an eligible audience 
which excludes inactive customers or only selects customers in your 
geographic region.

Global Audience A default eligible audience set by an administrator to apply to every 
segment and segment tree.
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Gross Count In a segment, gross count represents the total number of members that 
qualify for a specific criteria block, independent of any other criteria 
block in the segment design. This value tells you how many segment 
members would be selected if the specific criteria block was the only 
criterion in your segment.

In a segment tree, the gross count represents the total number of 
members that qualify for a tree branch, taking into account the full set 
of criteria in the parent branches.

Groups A group is a combined set of criteria blocks that evaluate together. A 
group is like a pair of parentheses in an equation, so that the qualifying 
members for the group are determined before adding or removing the 
group members from the cumulative segment membership.

List format Define the layout of files that you can export for a variety of purposes 
such as importing targeted customers into a campaign, building a 
customer email list, or generating a list for execution by a third-party 
vendor.

Nested Segment A segment that is embedded within another segment definition. When a 
nested segment is used, its corresponding counts apply the criteria for 
the nested segment and then add, keep, or exclude the qualifying 
customers to the cumulative count for the main segment.

Net Count A type of count computed by the Segment Tree Designer. The net count 
represents the number of members that qualify for a target cell in the 
segment tree. The net count displays how many members qualify based 
on the splitting and sampling criteria. Net count displays the members 
after deduplication.

Not Included Count A type of count computed by the Segment Tree Designer. The Not 
Included Count represents the number of members that were removed 
from a tree branch because they also qualified for any higher priority 
cell.

Priority Each target cell has an assigned priority number, which is used to apply 
deduplication when some members qualify for more than one target cell. 
Priority must be an integer value of 1 or higher and no two cells can 
share the same priority. The smallest value in the tree (usually 1) is the 
top priority.

Saved Result Set A fixed set of segment members that are recorded at a particular point 
in time. They are saved in the database so that they can be reused in 
the future without reevaluating the criteria again.

Table 11. Frequently Used Terms for Marketing Segmentation

Term Description
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Managing the Catalog
Use the Manage Catalog feature to edit, rename, set permissions for, and delete folders and items 
in the Siebel Analytics Web Catalog. To manage the catalog, click the Manage Catalog link in the 
Segments or Segment Trees column.

Segment A target set of customers or prospects that qualify for a set of criteria. 
In most cases, the exact members of a segment changes over time 
because the criteria are reevaluated against the most current data in 
your database. However, using saved result sets, you can also save a 
segment as a static set of customers that were recorded at a particular 
point in time.

Segment Tree Use to select one or more segments and split the segment members into 
smaller groups (or target cells). As you split a segment into smaller 
groups, the groups are displayed in a tree diagram. As in segments, 
segment trees can save a static set of customers derived from any 
target cell.

Splitting and Sampling The action you take to break a segment or segment tree branch into 
smaller groups. 

Subject Area A set of facts and dimensions that are organized by a common topic, 
such as Orders, Products Owned, Service History, or Campaign History. 
Within each subject area, you can choose any fact or dimensional 
attribute to create a criteria for your segment.

Target Cells An end point branch of a segment tree, meaning that the branch does 
not have any child branches. Target Cells are the only branches that can 
be associated with a marketing campaign. Target Cells have an assigned 
priority number, and you can use deduplication to deduplicate members 
that qualify for more than one target cell.

Target Level Indicates what type of customer are counted in the segment 
membership and included in associated campaigns. For example, target 
levels may include target levels, companies, individuals, or households. 
The gross and cumulative counts for a segment are counted based at the 
selected target level. In most situations, target levels represent some 
type of customer, such as an individual or company. However, target 
levels can also be created by your administrator to create more 
advanced segment definitions. For example, advanced target levels can 
include Assets or Products that a customer owns.

Web Catalog The Siebel Analytics Web Catalog stores content created with the 
Segment Designer, Segment Tree Designer, and List Format designer. 
Content can be organized into folders, which are either shared or 
private. Types of content that can be stored in the Web Catalog include 
segments, segment trees, list formats, as well as reports, filters, and 
dashboards created with Siebel Answers.

Table 11. Frequently Used Terms for Marketing Segmentation

Term Description
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For more information on managing the catalog, read Siebel Analytics Web Administration Guide or 
access the online help from the Manage Catalog window.

Refreshing the Display
The Segments column and Segment Trees column is populated when you first access the Segments 
or Segment Tree Designers. New folders, segments, and segment trees added by other users during 
your session do not automatically appear in your session. To keep your display current so you can 
access any new items, click Refresh Display at the bottom of the column.

Reloading Server Metadata
When creating a segment you use columns that are created in Siebel Analytics. The list of columns 
available to you is populated when you start the Segment Designer, and is not automatically updated 
during your session. To update the list of columns, click Reload Server Metadata at the bottom of the 
Segments column.

Creating Segments in Segment Designer
The Segment Designer applies criteria blocks in a top-down sequence so that each criteria block that 
you add refines the segment membership of the criteria immediately above it. As you add criteria 
vertically down the screen, the Cumulative Count keeps track of how many customers have qualified 
for that criteria and those above it. At the bottom of the view, the total count of qualifying segment 
members appears with the criteria applied.

NOTE: The Segment Designer computes two types of counts, gross count and cumulative count. For 
descriptions, read Frequently Used Terms for Marketing Segmentation on page 34.

For special situations where you need to create a group of criteria blocks (similar to parentheses in 
an equation), you can drag one criteria block on top of another to create a group. This method applies 
a combined set of criteria as a single constraint on the main segment membership.

The Segment Designer can include a reference to another existing segment (referred to as a nested 
segment) within the segment you are building.

After you create a segment, you can save it in one of the folders in the Web Catalog.

To create a new nested segment based on a different target level, click the Select Another Target 
Level button. This action saves the current segment. You can then build a nested segment and return 
to the main segment when you are finished.

NOTE: The subject areas that you can display are dependent on the security settings specified for 
you by your site's administrator.
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About Using the Marketing Segment Panel to Add Criteria to Segments
Use the segment selection pane to add criteria blocks when creating new or changing existing 
segments. To create a new segment, you can click the new icon or open a saved segment, modify it, 
and save it with a new name. Using either method, you select the subject area and field to use for 
a segment criteria. The panel displays the subject areas that are relevant for the target level for your 
segment.

You can also add a nested segment to your segment by selecting a folder displayed in the bottom of 
panel and clicking the segment name.

Adding Criteria Blocks to Segments
Each criteria block denotes a set of criteria that are evaluated together. This means that any segment 
member that qualifies for the criteria block must meet the criteria displayed within the block.

For example, if a segment has the following criteria block:

Product purchased is a blue hat
AND
Purchase date is December 31, 2004

This segment finds the customers who purchased a blue hat on December 31, 2004. Because the 
criteria are in the same block, the criteria are applied to the lowest level dimension related to the 
criteria, which, in this case, is Purchases (record-level evaluation).

If your segment places criteria into separate criteria blocks, each criteria block finds segment 
members that satisfy each criteria block. After segment members have been identified, the segment 
designer determines how many segment members qualified for both criteria blocks.

NOTE: If your administrator sets up a dashboard so you can display the contacts that qualify, you 
can display this dashboard by clicking the final segment count (at the bottom of the screen).

For example, you may have a segment with the two criteria blocks shown in the following list:

 

In this example, the relationship between the criteria are evaluated at the customer level, rather 
than the purchase level (record level). This segment would find the customers who purchased a blue 
hat at any time and customers who purchased any product on December 31, 2004. For example, the 
segment includes customers who purchased a blue hat in February and purchased a black coat on 
December 31, 2004.

To select a field to add as a criteria block

1 Click a subject area near the top of the selection pane and then expand the subfolders to display 
the available facts and dimensions.

2 Click the fact or dimension to use.

Start With Criteria block 1: Product purchased is a blue hat.

Keep Criteria block 2: Purchase date is December 31, 2004.
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3 In the Create/Edit Filter dialog box, add the filter criteria, and click OK.

For more information, read the topic about using column filters in Siebel Analytics User Guide.

To set properties for a criteria block

1 In a criteria block, click Properties.

2 In the Properties dialog box, make changes to any of the following options:

■ In the Label field, enter a custom caption for your criteria.

■ Cache the block for future update counts requests.

Select this option to temporarily cache the results for that criteria block. This option saves 
time when refreshing counts while designing a segment. When a block is cached, updating 
counts refreshes the cache when the cache is expired or does not exist. By default, the 
segment designer does not cache any blocks unless you explicitly check this box.

3 Click OK.

To add filters to a criteria block

1 In a criteria block, click the filter button.

2 In the Create/Edit Filter dialog box, add the filter criteria.

For more information, read the topic �About Using Column Filters� in Siebel Analytics User Guide.

3 When you are finished adding filters for the criteria block, click OK.

To add a filter using an aggregate field

1 Create a new criteria block or click the filter button on an existing block.

2 Select the aggregate field such as Order Revenue from the selection pane.

3 To group by another field, in the Create/Edit filter dialog box, click Add Aggregate By.

4 While the Add Aggregate By dialog box is open, in the selection pane, click a field to group the 
results by.

To embed a nested segment in your segment design

1 Click the My Segments or Shared Segments folder at the bottom of the selection pane.

2 Click a segment to add as a nested segment.

To save a new segment

1 Click the save icon in the upper-right corner of the screen.

2 Select a folder location where the segment is to be saved.

3 Enter a segment name, and click OK.
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To save changes to a segment

1 Click the save icon in the upper-right corner of the screen and click OK.

2 In the Save dialog box, click Yes to confirm replacing the previous version.

To generate lists

1 Save the segment.

2 Click Generate List

To view the cumulative counts within a criteria block

1 Click the filter button on the criteria block.

2 In the Edit Criteria Block dialog box, click Get Counts.

3 The cumulative counts for each criterion in the criteria block appears.

NOTE: The starting count for the selected block is based on the cumulative count for the criteria 
block above your selected block.

4 When you are finished viewing the counts, click Back to Editing, and click OK.

To update counts in a segment

1 In the upper-right of the Edit Segment tab, click Update Counts.

2 In the Update Counts dialog box, select a refresh option.

3 If you are using the Cache option, you can also select Refresh Cache.

Selecting Refresh Cache guarantees that you query against the most current data.

4 Click OK.

Adding Selection Rules
Selection Rules control the items related to the segment that are included in the campaign load and 
list export processes. For example, for a segment of accounts (companies), you can control which 
employee or employees at the company you want to target.

A selection rule consists of several parts:

■ Inclusion and Exclusion criteria - Apply one or more criteria to indicate what items are to be 
included in and excluded from the segment.

■ Ranking rule - If there are multiple items related to each segment member, use the ranking rule 
to indicate how the items should be ranked. For example, if there are multiple employees for an 
account, indicate what field you want to use to rank the employees before selecting a subset. 

■ Record count selector - Indicate whether you want to select one or more items for each segment 
member (the Target Level). For example, you can indicate how many employees from a single 
company should be targeted.
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You can apply selection rules for more than one qualified item if desired. For example, you may have 
a segment targeted at households that own a variety of financial assets (bank account, insurance 
policy, or mortgage). You could use a selection rule for individuals to control which member of the 
household to which to communicate and a second selection rule on assets that controls which assets 
to mention in the text of a personalized letter.

NOTE: Selection rules for any nested segments within another segment definition are ignored. Only 
selection rules for the top-level segment are applied.

To create a selection rule

1 Click on Add Selection Rule.

2 Select the type of Qualified Item to constrain or select.

3 In the Create/Edit Filter dialog box, add the filter criteria.

For details, read the topic about using column filters in Siebel Analytics User Guide. Alternatively, 
you can filter the item with an existing saved segment by clicking the segment from the left 
panel.

4 Click OK.

5 In the criteria block, select Include/Exclude to indicate whether to include or exclude these types 
of items from the results.

6 For additional constraints, repeat the previous step as needed.

7 In the bottom section of the rule, use the option buttons to select whether all items qualify or 
only specific items.

For more information on selecting specific items, read To add a ranking rule to a selection rule.

To add constraints to a selection rule

1 Click on Add Another Constraint.

2 In the Create/Edit Filter dialog box, add the filter criteria.

3 For details, read the topic about using column filters in Siebel Analytics User Guide.

4 Click OK.

5 In the criteria block, select the Include/Exclude link to indicate whether to include or exclude 
these types of items from the results.

To add a ranking rule to a selection rule

1 In the area beneath the constraint criteria boxes, select the option button for a limited number 
of items (for example, 1 Contact only).

The Add Ranking Field link appears.

2 Select the link.
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3 In the dialog box, select a field from the left hand selection pane to use for the ranking, and then 
click OK.

4 In the drop-down list choose either Maximum or Minimum for selecting items in the ranking field.

NOTE: Date fields treat older dates as Minimum and newer dates as Maximum.

5 To modify the formula for the ranking field or add a Case statement, click the Edit Formula icon. 

For more information, read To modify the formula for the Ranking Field.

NOTE: Ranking fields are available from any subject area that relates to both the Qualified Item and 
the main segment's primary Qualified Item (the Target Level).

To modify the formula for the Ranking Field

1 In the Ranking line for the Selection Rule, click the Edit Formula icon.

2 In the dialog box, click the Column Formula tab.

3 To display a glossary of available expressions, click the help link.

4 To convert the values for a field using a Case statement, click the Bins tab.

5 To create a bin for a condition, click Add Bin.

NOTE: By default, bin values are treated alphabetically. In the Bins tab, you may need to treat the 
resulting values as numeric values (to use numeric sorting). For example, if you used Bins to convert 
the Net Worth field to Values 1,2,3...10, you would want to rank numerically to make sure that '10' 
was after '9'. To enable numeric ranking, click the check box for 'Treat result as a numeric value or 
expression'.

6 When done editing, click OK.

As a shortcut, you can add a criteria block from the Edit Segment view directly as a Selection Rule 
constraint. You can only reuse criteria blocks from the top level of the segment criteria and blocks 
that use Keep and Exclude operators.

To reuse criteria from the Edit Segment view as a selection rule constraint

1 Click the Edit Segment tab.

2 Locate the criteria block to which to add selection rules and click its view icon.

The Properties dialog box appears.

3 Check the box for the Qualified Item to constrain.

4 Click OK.

5 Click the Selection Rules tab.

The constraint has been added to the selection rule for the item you checked.
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Saving Result Sets for Marketing Segments
A Saved Result Set is a fixed set of segment members that are recorded at a particular point in time. 
They are saved in the database so that they can be reused in the future without evaluating the 
criteria again.

Saved Result Sets can be useful in the following situations:

■ When you want to freeze the members of a segment at a specific point in time, so that the 
membership does not change.

■ When you have a very complex segment and you want to store the members of a recently 
counted segment to save query time.

■ When you want to save a branch of a segment tree as a separate segment.

Requirements
Before you can save a result set, you must create a result set list format and specify that list format 
in the Advanced Options. For more information on creating a result set list format, read the chapter 
on Designing Marketing List Formats in Siebel Marketing Installation and Administration Guide. For 
more information on specifying which list format to use for your segment, read �Segment Advanced 
Options� on page 45.

To save a result set for a Marketing segment

1 In the Segment Designer, open the segment.

2 Click the Saved Result Sets tab.

3 Click the Save Result Set button.

4 In the Please save your current segment dialog box, verify segment name and location.

5 Click OK to submit the job.

6 To cancel the job, click the Cancel/Exit links.

After the request is complete, the newly created saved result set appears.

To use a segment saved result set as a nested segment

1 In the Segment Designer, open a segment to edit.

2 Find a different saved segment in the Segment Folders in the selection pane and click it to add 
it to the segment design.

3 Click the properties button on the nested segment block.

4 Select Use Saved Result Set.

5 In the Saved Result Sets dialog box, select one of the following:

■ Always use most recent Saved Result Set

■ Choose a specific result set from the list.
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6 Click OK to close the Saved Results Set dialog box.

7 Click OK to close the Properties dialog box.

8 Save your changes.

To set a segment to always use a Saved Result Set

1 In the Segment Designer, open the segment.

2 Click the Advanced Options tab.

3 Select the following check box, and then click OK:

Always use most recent saved result set

NOTE: When you use this segment, the most recent result set determines the segment 
membership.

To save the results set for an entire segment tree

1 Click the Saved Result Sets tab.

2 Click Save Results Set.

3 In the Please save your current segment dialog box, verify segment name and location.

4 Click OK.

5 When prompted, enter a custom label for the segment tree.

Marketing creates a static segment for each tree node. The naming format is:
<Custom Label>-<Node Label>-<Priority>

While Saving a result set for a particular tree node, you have the option of either append to an 
already created static segment (useful for doing analysis over time) or creating a new static 
segment.

To purge a saved result set

1 Click the Saved Result Sets tab.

2 Select a results set and check its box.

3 Click Purge.

Results sets for branches are listed twice: once as part of the tree and once as a static segment. 
Purging one instance purges both.
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Segment Advanced Options
Table 12 shows the options available in the Advanced Options tab for a segment.

Table 12. Segment Advanced Options

Control Name Description

Cache final segment result set 
for list output

When generating multiple lists based on the same segment, you 
can cache the final set of customers during the first list usage so 
that subsequent list uses can access those results for faster 
processing.

Always use most recent Saved 
Result Set

When you use the segment, the most recent result set 
determines the segment membership.

Default to cache criteria blocks 
for future jobs

Controls the default value of the check box named Cache this 
block for future Update Counts.

Campaign Load File format The campaign load file format used for loading the members of 
the segment tree into each campaign.

The campaign load file format controls what information about 
the segment members is loaded into the campaign history in the 
Siebel Marketing transactional database. This information may 
include name, address, and email address.

When you first create a segment, the Campaign Load file format 
is set based on the default setting for the target level. You can 
select a different file format, if required. If you are not certain 
about the effect of changing the file format, contact your 
administrator.

For more information on list formats, read the chapter on 
Designing Marketing List Formats in Siebel Marketing Installation 
and Administration Guide.

List Preview File Format The file that specified the format used for previewing lists.

For more information on list formats, read the chapter on 
Designing Marketing List Formats in Siebel Marketing Installation 
and Administration Guide.

Saved Result Set File Format The file that specified the format used for saved results sets.

For more information on list formats, read the chapter on 
Designing Marketing List Formats in Siebel Marketing Installation 
and Administration Guide.
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Segment Extension Attributes
Segment Extension Attributes are additional columns you add to a segment or a segment tree node. 
These attributes do not affect the segment counts. Instead, they are used to provide a means of 
storing additional data for each customer in a segment. This additional data can be used in list 
generation and in third party tools for further analysis. Your administrator creates the list of columns 
available for use as extension attributes.

Example: You add two extension attributes to a segment. One extension attribute is a column that 
contains the source of a new lead (trade show, internet web page visit, cold call) and the other 
column contains the product the lead is interested in. Based on the source and product information, 
you can track the resulting sales to see if lead source affects product sales.

To add an extension attribute

1 In the Advanced Options tab, click Add Attribute.

The Segment Extension Attributes window appears.

2 Select an attribute.

The new attribute appears in the Advanced Option tab�s Segment Extension Attributes list.

3 In the Value column, enter an alphanumeric value.

About Segment Tree Designer
Using the Segment Tree Designer, you can create a new segment tree or open a saved segment tree 
by selecting it in the selection pane, making changes, and saving the tree under the same or a new 
name. After you create a segment tree, you can save it in one of the folders in the Web Catalog in 
the selection pane. To obtain descriptions for frequently used terms, read Frequently Used Terms for 
Marketing Segmentation on page 34.

The Segment Tree Designer has links to additional Help information on each screen. When you need 
more information, click the Help link in the dialog box or the small help icon next to the item.

Segment Extension Attributes For more information, read the topic on �Segment Extension 
Attributes� below.

Purge List Cache (button) Clicking this button submits a job to purge the cache entries 
associated with pulling a list requalified by any of the target cells 
in this tree. You would click this button prior to pulling a list to 
make sure that the list contains the most recent customers in the 
target cell.

Table 12. Segment Advanced Options

Control Name Description
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Creating and Editing Segment Trees
The Segment Tree Designer creates and edits segment trees. You can select one or more segments 
and split the members into smaller groups (or target cells). As you split a segment into smaller 
groups, the groups are displayed in a tree diagram, and the resulting branch is always the same size 
or smaller than the parent branch.

Use the Split/Sample option to split any segment or tree branch into smaller groups. You can select 
from a set of splitting and sampling methods, including Random selection, Nth selection, Ranked, 
N-tiles, and Values.

NOTE: For more information about adding a filter using an aggregate field, read Adding Criteria 
Blocks to Segments on page 38.

Each segment tree is based on a target level, which indicates what type of customer you plan to 
count in the tree. For example, target levels can include target levels, companies, individuals, or 
households. When deduplication is enforced between target cells in the tree, the deduplication is 
applied at the target level. For example, if the target level for the tree is Companies, then 
deduplication makes sure that each company is a member of only one cell.

As you split and sample from the tree branches, some of the branches are end point branches, 
meaning that they do not have any child splits. These end points are referred to as Target Cells, 
because they are the distinct groups targeted in a marketing program. Each Target Cell displays a 
priority number. The priority is used to apply deduplication between cells that may contain some of 
the same members.

The Segment Tree Designer displays several types of counts such as net counts and gross counts. 
For descriptions, read Frequently Used Terms for Marketing Segmentation on page 34.

Members of the Segment Tree are constrained by the eligible audience. The eligible audience is a set 
of criteria that appear in the top section of the screen. The criteria are applied to the Eligible Audience 
by creating a segment with the criteria and then adding the segment to the Eligible Audience section 
of the Segment Tree. For example, you may have an eligible audience which excludes inactive 
customers or only selects customers in your geographic region. Optionally, your administrator can 
also designate a Global Audience, which is a set of criteria that applies to the segment trees and 
cannot be removed by other users.

After you create a segment tree, you can save it in one of the folders in the Web Catalog.

The Segment Tree Designer has links to additional Help information on each screen. When you need 
more information, click the Help link in the dialog box or the small help icon next to the item.

This section contains the following topics:

■ Creating a Segment Tree in Segment Tree Designer on page 48

■ About Segment Tree Branch Properties on page 49

■ Adding Selection Rules to a Segment Tree on page 50

■ Splitting Segments or Branches on page 51

■ Constraining List Data for a Segment Tree on page 54

■ Adding or Removing Constraints to the Eligible Audience on page 54
Siebel Marketing User Guide Version 7.8, Rev. A 47



Marketing Segments and Segment Trees ■ Creating and Editing Segment Trees
Creating a Segment Tree in Segment Tree Designer
Use the segment tree selection pane to create a new segment tree, select the segments to sample 
in the tree, and select the fields to use for the splitting criteria. After you create a segment tree, you 
can save it in one of the folders in the Web Catalog.

When you begin editing a tree, the selection pane displays the available segments that you can use 
in the tree. To add a segment to the segment tree, open its folder in the selection pane, and click 
the segment name.

As you add splitting and sampling criteria, the selection pane changes to display the available subject 
areas and fields for the target level on which the tree is based.

NOTE: The subject areas that you can display depend on the security settings specified for you by 
your site's Administrator.

To create a new segment tree

1 In the Segment Tree Designer, select a Target Level.

2 In the selection pane, click the names of the segments to add.

3 To save the segment tree, click the save icon in the upper-right corner of the screen.

4 Select the folder location where the segment tree is to be saved.

5 Enter a segment tree name and click OK.

To add a segment to a segment tree

1 In the Segment Tree Designer, select the Edit Segment tab.

2 Click the folder in the selection pane to display the segments.

3 Click the segment name in the selection pane.

This adds the segment to the bottom of the segment tree.

4 Click the save icon in the upper-right corner of the screen and click OK.

5 Click Yes in the dialog box to confirm saving over the previous version.

To generate lists for a node

1 Save the segment tree.

2 Select a node.

3 Click the node�s menu button and choose Generate Lists.

To update counts in a segment tree

1 In the upper-right of the Edit Segment Tree tab, click Update Counts.

The Update Counts window opens.
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2 In the Update Counts dialog box, click the Count Options tab.

3 Indicate which criteria blocks to update:

■ New and changed criteria blocks

■ Selected criteria blocks

■ All criteria blocks

4 If you are using the Cache option, you can also select Refresh Cache.

Selecting Refresh Cache guarantees that you query against the most current data.

5 Click the Count Type tab.

6 Select the counts to be updated�making sure to select at least one type of count�and then click 
OK.

About Segment Tree Branch Properties
Table 13 shows the options available in the properties dialog box for a segment tree branch.

Table 13. Segment Tree Branch Properties

Control Name Description

Label Used to add a custom label for the branch.

NOTE: Custom labels cannot be entered for embedded segment 
nodes.

Include Remainder with 
child cells (check box)

When selected, adds a remainder group when you split or sample the 
branch.

Include overlapping 
members from higher 
priority cells

When selected, disables deduplication for this cell.

Cache this block for future 
Update Counts

Select this option for the following reasons:

■ When selected, this option temporarily caches the members who 
qualified for that branch, which saves when time refreshing 
counts while designing a segment tree.

■ When a split-by-value node is marked for caching and constrains 
a secondary list attribute, this attribute is also cached.

■ The segment tree designer caches the tree nodes by default.

Anticipated response rate 
for statistical significance 
test

Use this to add the assumed response rate for that cell.
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Adding Selection Rules to a Segment Tree
Selection Rules control the items related to the segment tree cells that are included in the campaign 
load and list export processes. For example, for a segment tree of accounts (companies), you can 
control which employee or employees at the company you want to target.

For a Segment Tree, you have several options to apply the Selection Rules:

■ Selection Rules tab. Use this tab to enter explicit Selection Rules that should apply to all cells 
on the Segment Tree.

■ Inherit Selection Rules from the segments. This option inherits any existing selection rules 
from the segment or segments included in the segment tree.

■ Apply constraints from the Segment Tree splitting and sampling criteria. Use this option 
to selectively apply the criteria for specific tree branches as part of the selection rule.

For information on creating selection rules, read Adding Selection Rules.

Rather than create Selection Rules for the entire segment tree, you can inherit the Selection Rules 
from each segment.

To inherit selection rules from a segment

1 Click the view icon for the segment in the tree.

2 Click Properties.

The Properties dialog box appears.

Save Result Set (button) Saves the list of members that qualify for the branch based on the 
most recent updated counts. When you click this button, you are 
prompted for a new segment name. The customers in the target cell 
are extracted and saved to the new segment.

NOTE: The saved segment does not include any of the original 
criteria, it includes only the stored list of members.

Path This displays the Web catalog path of the segment to which an 
embedded segment node refers.

Use Saved Result Set When selected for an embedded segment node, you can select the 
following options:

■ Always use most recent Saved Result Set.

■ Choose a specific result set from the list.

Table 13. Segment Tree Branch Properties

Control Name Description
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3 Check the box for Inherit Selection Rules from the segment and then click OK.

NOTE: The inherited rules do not appear in the Selection Rules view. This occurs because the criteria 
may vary between different segments in the tree, while the Selection Rules view shows only criteria 
that apply to all cells in the tree. You can only inherit selection rules from segments with the same 
target level as the tree.

As a shortcut, you can add the splitting and sampling criteria from the Edit Segment Tree view 
directly as a Selection Rule constraint.

To reuse criteria from the Edit Segment Tree view as a selection rule constraint

1 Click the Edit Segment Tree tab.

2 Locate the split block to be added to the selection rules and click its icon.

The Properties dialog box appears.

3 Check the box for the Qualified Item to constrain, and then click OK.

NOTE: These constraints do not appear in the Selection Rules view. This occurs because the criteria 
may vary between different tree branches, while the Selection Rules view only shows criteria that 
apply to all cells in the tree.

Splitting Segments or Branches
Use the Split/Sample option to split any segment or tree branch into smaller groups. As you split or 
sample, the resulting branch is always the same size or smaller than the parent branch. Table 14 
shows the available sampling methods.

Table 14. Sampling Methods for Splitting Segments

Sampling Method Description

Random selection The Random method selects a purely random subset of members based on 
the percentage or count you add for this method. For random selection, you 
are not required to select a field.

Nth selection The Nth method splits the branch into N number of equally sized groups. 
The selection is based on the sequence with which the records are returned 
from the database. For example, if you select N = 4, the branch would be 
split into 4 equally sized groups representing 25% of the original group. For 
this method, you are not required to select a field.

Ranked The Ranked method sorts the members of the branch by a field you select 
and lets you choose the top or bottom portion of the ranked list. For 
example, if you Rank by Total Customer Revenue, you can select the top 
10% of the customers with the highest revenue.
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Mixing Random Splits with Other Splits
You can create segments that mix random splits with other splits. However, this affects how targets 
are assigned to each split. Random splits exclude targets only when those targets are in immediately 
adjacent random spits. This point is best illustrated by some examples.

Example A: Three Random Splits
1 - Random Split 10%
2 - Random Split 20% (This split excludes targets that are in split 1.)
3 - Random Split 30% (This split excludes targets that are in splits 1 and 2.)
Effect: All three splits contain different targets, no target exists in more than one split.

Example B: Mixed Random and Nth Splits with Possible Recurrence of Targets
1 - Random Split 10%
2 - Nth Split [N=10]
3 - Random Split 20% (This split does not exclude any targets.)
4 - Random Split 30% (This split excludes targets that are in split 3, but does not exclude targets 
that are in other splits.)
Effect: Because Split 4, a random split, follows another random split, it does not contain any targets 
that are in split 3. Because there is a nonrandom split after split 1, targets from split 1 could appear 
in splits 3 and 4.

Example C: Mixed Random and Nth Splits with No Recurrence of Targets in Random Split
1- Nth Split [N=10]
2- Random Split 10%
3- Random Split 20% (This split excludes targets that are in split 2.)
4- Random Split 30% (This split excludes targets that are in splits 2 and 3.)
Effect: Because the random splits are adjacent to each other, splits 3 and 4 exclude any targets that 
are in previously adjacent random splits. However, targets in split 1, an Nth split, may recur in any 
of the random splits.

When random split cells are separated, they are evaluated independently and do not stay mutually 
exclusive.

N-tiles The N-tile method sorts the members by a field you select and then splits 
the list into equal sized groups. For example, you may create quartets or 
deciles based on Total Customer Revenue.

Values Similar to instructions for creating filters in segment criteria blocks. For 
more information about adding a filter using an aggregate field, read Adding 
Criteria Blocks to Segments on page 38.

Table 14. Sampling Methods for Splitting Segments

Sampling Method Description
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To select a field for splitting or sampling criteria

1 Click the action button for a tree branch to split or sample.

2 In the menu, choose Split/Sample.

3 In the Apply Split/Sample dialog box, select a sampling method to use.

NOTE: The contents of the dialog box changes when you select different sampling methods.

The available subject areas and fields appear in the selection pane. The list of subject areas is 
based on the target level for the segment tree.

4 In the revised Apply Split/Sample dialog box, complete the fields.

5 Click the subject area that contains the desired field.

6 Click the folders to expand the subject area.

7 Click the field name.

To create random samples

1 Enter the number of groups to create (1 to N).

2 Select whether to define the group sizes by Percentage or Count.

3 Enter a percentage or count for each group, and click OK.

The sum of the percentages cannot exceed 100%.

To create Nth samples

1 Enter the number of groups to create (N).

2 Click OK.

To create ranked samples

1 Select the field to rank by from a subject area in the selection pane.

2 Enter the number of groups to create (1 to N).

3 Select whether to define the group sizes by Percentage or Count.

4 Enter a percentage or count for each group, and click OK.

The sum of the percentages cannot exceed 100%.

To create N-tile samples

1 Select the field to use for the N-tile from a subject area in the selection pane.

2 Enter the number of groups to create (1 to N).

3 Select whether the top group has the lowest or highest values for the selected field, and click OK.
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Using the Values Sampling Method
Instructions for creating Values samples uses instructions that are similar to creating filters in 
segment criteria block. For more information about adding a filter using an aggregate field, read 
Adding Criteria Blocks to Segments on page 38.

Constraining List Data for a Segment Tree
This option can limit the information in list files to members of the branch. For example, if you have 
a segment tree based on accounts, you may qualify specific contacts for the accounts based on 
criteria for that branch.

Additionally, this option can limit the information in list files to any additional items that you 
constrained on the segment tree branch. The following are scenarios for other types of constraints:

■ Nested Segment Node. You may have a business-to-business company targeting business 
accounts. You split by predefined contact segments containing the decision-making contact at 
each account. You can make sure that you select the correct contact for each account by 
constraining the contact attribute for the nested segment node.

■ Split-by-Value Node. You may have a banking company targeting customers split by checking 
and savings account types. You can make sure that you select the correct account type for each 
customer by constraining the bank account attribute for the split-by-value node.

You can constrain list data for a tree branch only when the following criteria are met:

■ The branch is an embedded segment node in which the target level is different from the target 
level of the segment tree.

■ The branch is a split node created using the values sampling method, and the split-by field is not 
an aggregated measure.

To constrain list data for a segment tree

1 In the Segment Tree Designer, locate the branch on which you want to constrain data.

You can only constrain list data on nested segment tree nodes and split by value nodes.

2 Click the Actions button, and choose Constrain List Data from the menu.

3 In the dialog box, select a qualified item to constrain.

4 In the Constrain List Data dialog box, click OK.

Adding or Removing Constraints to the Eligible Audience
Members of the Segment Tree are constrained by the Eligible Audience. The eligible audience is a set 
of criteria that appear in the top section of the screen. The criteria are applied to the Eligible Audience 
by creating a segment with the constraining criteria and then adding the segment to the Eligible 
Audience section of the Segment Tree. For example, you may have an eligible audience that excludes 
inactive customers or only selects customers in your geographic region.
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Optionally, your administrator can also designate a Global Audience, which is a set of criteria that 
applies to every segment tree and cannot be removed by other users. The Global Audience appears 
as a block that is more lightly shaded than the rest of the tree. For instructions about setting the 
Global Audience, read Siebel Marketing Installation and Administration Guide.

To add or remove constraints to the Eligible Audience

1 Click the actions button on the existing eligible audience block.

2 To add constraints, choose Add Constraint and perform the following steps:

a In the Add additional constraints to the Eligible Audience dialog box, click Browse.

b Select the segment that has the criteria to use to constrain the audience.

3 To remove constraints from the eligible audience, click the delete button on the constraint to be 
removed.

NOTE: If the constraint is the Global Audience, you cannot remove it.

4 Click OK.

Segment Tree Advanced Options
Table 15 shows the options available in the Advanced Options tab for a segment tree.

Table 15. Segment Tree Advanced Options

Control Name Description

Cache final segment result set 
for list output

When generating multiple lists based on the same segment, you 
can cache the final set of customers during the first list usage so 
that subsequent list uses can access those results for faster 
processing.

Automatically create 
remainder cells

If you do not want the tree designer to create remainders 
whenever you split a branch, clear this option.

Default to include overlapping 
members from higher priority 
cells in lower priority cells

The standard behavior for new trees is to always enforce 
deduplication between target cells. When this option is checked, 
deduplication is not enforced for the segment tree. However, you 
can enable deduplication for specific branches using the branch 
properties.

Default to cache tree blocks for 
future jobs

Controls the default value of the check box named Cache this 
block for future Update Counts (in the properties of a newly 
created tree branch).
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Campaign Load File format The campaign load file format used for loading the members of 
the segment tree into each campaign.

The campaign load file format controls what information about 
the segment tree members is loaded into the campaign history in 
the Siebel Marketing transactional database. This information 
may include name, address, and email address.

When you first create a segment, the Campaign Load file format 
is set based on the default setting for the target level. You can 
select a different file format, if required. If you are not certain 
about the effect of changing the file format, contact your 
administrator.

List Preview File Format The file that specified the format used for previewing lists.

Saved Result Set File Format The file that specified the format used for saved results sets.

Statistical Significance 
Parameters

The following variables are used as inputs for the statistical 
significance calculation:

■ Confidence interval

■ Error tolerance, plus or minus

■ Default Response Rate

Purge List Cache (button) Clicking this button submits a job to purge the cache entries 
associated with pulling a list requalified by any of the target cells 
in this tree. You would click this button prior to pulling a list to 
make sure that the list contains the most recent customers in the 
target cell.

Table 15. Segment Tree Advanced Options

Control Name Description
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5 Designing Marketing Programs
In the Programs screen, you can use the Program Flow view or the Program Explorer view to design 
and execute programs using new or existing segments, lists, and campaigns.

This chapter contains the following sections:

■ About Designing Marketing Programs on page 57

■ Process of Designing Marketing Programs on page 57

■ About Multistage Programs on page 58

■ About the Program Execution Workflow on page 59

■ Creating Programs on page 59

■ About Using the Program Flow on page 62

About Designing Marketing Programs
A program is a multistep dialogue in which you can set up a series of communications to your 
customers and prospects. In the Programs screen, you can use the graphical drag-and-drop Program 
Flow view or the Program Explorer view to design and execute multistage, triggered, and recurring 
marketing programs using new or existing campaigns, lists, and segments.

You can establish multiple stages for a marketing program. Each stage can have multiple campaigns, 
lists, segments, and segment trees. Subsequent stages can be based on a customer response or any 
other event. For example, a visit by a sales person to a premium customer may trigger a follow-up 
email to that customer for the selected product.

In the workspace, you can use the right-click menu to manually start Marketing Server tasks. To 
schedule server tasks to be started automatically, use the Schedule calendar.

The graphical Program Flow designer is integrated with the workflow engine and Marketing Server. 
Therefore, when defined, the entire program can be automated from the initial customer 
segmentation through communication, to response collection and analysis. This capability is 
especially useful when programs are set to recur, such as a monthly welcome package campaign to 
new customers.

Process of Designing Marketing 
Programs
To design marketing programs, perform the following tasks:

■ Creating Programs on page 59

■ Adding Stages to Programs on page 63
Siebel Marketing User Guide Version 7.8, Rev. A 57



Designing Marketing Programs ■ About Multistage Programs
■ Using Repeating Stages Within Programs on page 63

■ Assigning Segments to Stages on page 64

■ Adding Campaigns to Stages on page 64

■ Setting Up Waves for Campaign Loads on page 65

■ Adding Imported or Internal Lists to Campaigns on page 67

■ Adding Trees to Stages and Allocating Segment Tree Cells on page 67

■ Creating and Applying Program Templates on page 68

■ Executing Programs on page 69

Related Topics
■ About Multistage Programs on page 58

■ About the Program Execution Workflow on page 59

■ About Using the Program Flow on page 62

■ Process of Loading Customers in Campaigns on page 153

■ Launching Programs and Campaigns on page 163

About Multistage Programs
Siebel Marketing supports both single-stage and multistage marketing programs. In a single-stage 
program, contacts are targeted in a stand-alone campaign, with no follow-up campaigns planned. 
During a multistage program, contacts in the first stage receive follow-up treatment in the program�s 
second and third stages, often based on the contact�s response to the original campaign. Multistage 
programs use stages to mark each phase of the program, campaigns to track separate instances of 
marketing messages, and campaign waves to track each batch of customers that are contacted. The 
following are types of multistage programs:

■ Marketing program with recurring campaign. Scheduled to recur at standard intervals or 
specific times (daily, weekly, monthly, quarterly, yearly). For example, your company sends out 
a welcome kit and free gift to new customers on a monthly basis. Each month, a program stage 
occurs, new customers are identified (based on the segment criteria of account longevity of less 
than a month), and the welcome campaign is launched.

■ Event-triggered marketing program. Provides a follow-up activity based on an action. For 
example, a customer visiting a product catalog may trigger an email offer to that customer based 
on items included in the customer�s cart. If no response to the email is received, a telesales 
campaign launches to offer the customer a special offer on the product.
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■ Response triggered marketing program. Uses response data to drive the next stage of the 
marketing program.

For example, the marketing manager of a bank designs a program implementing the company�s 
goal of increasing the number of bank-affiliated credit card customers. Within the program, he 
creates two campaigns, one offering a card with 10% interest and a $25 annual fee, the other 
offering 14% interest but no annual fee. These offers are sent to 250,000 of the company�s 
customers who do not already have credit card accounts with the bank.

After 30 days, response information is used to:

■ Send a welcome packet of information to each new credit card customer.

■ Offer an 8%, $25 annual fee card to everyone who did not respond.

When using repeating stages, be sure that your segment criteria excludes customers who were 
targeted in any previous wave of the same campaign or stage. This precaution prevents the 
customers from receiving redundant messages.

About the Program Execution Workflow
Multistage programs are programs that can be launched manually or automatically scheduled using 
the calendar. When you use the calendar, it can trigger key events such as loading a campaign (list 
generation) and launching a campaign (sending lists to vendors and sending offers to targeted 
contacts). The Program Schedule drives the process, with activities triggering the execution of each 
program. Each of these key events can be executed manually, using the Program Flow menu or the 
Program Explorer menus.

The Stage Execution workflow process shows how executing a program, loading a campaign, and 
launching a campaign occur in a multistage process.

When the stage is activated, Siebel Marketing applies a predefined allocation of segment counts to 
campaigns. Campaigns are loaded and launched, and if the stage is scheduled to repeat, the next 
occurrence of the stage is scheduled. Each stage of a program is a unique event, and Siebel 
Marketing tracks campaign and response history at the unique campaign wave level (for each run). 
For more information about workflow processes and the Siebel Business Process Designer, read 
Siebel Business Process Designer Administration Guide.

Creating Programs
When you create a new program, you specify an objective, a type (for example, Cross-sell or Win-
back), a status (Active, Completed, or Planned), a revenue goal, and a budget figure.

When you add organizations to a program, any campaign that you add to a program (using the 
program flow or program explorer) inherits the program's organizations. The campaign that you add 
retains any existing organizations and existing lead partner.
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The organizations in the campaign represent the union of the program�s and campaign's 
organizations. After you add the campaign to the program, changes made to the organizations at the 
program are not reflected at the associated campaign level. Segments added to the program do not 
inherit the organizations. For more information, read Creating Campaigns on page 119.

NOTE: You can turn off the teams and organizations inheritance features in Siebel Tools. In the 
appropriate business component, change the User Prop value for the Copy Teams and Copy 
Organizations property from Y to N. For more information, read Using Siebel Tools.

You can attach documents and other files and view program stages and status. In addition, you can 
add team members, activity plans, events, and design the actual program flow, using a graphical 
designer workspace.

To create a program

1 Navigate to the Programs screen.

2 In the Programs list, create a new record.

3 Complete the fields using Table 16 on page 60 as a guide.

4 Save the program.

Table 16. Frequently Used Fields in the Program List

Field Comment

Program Code (Required) The program component of the source code.

Status The default program status is In Planning. Options are Active, Cancelled, 
Completed and Scheduled. The status changes from In Planning to Active, 
and then Completed during program execution. Manual execution of the 
program does not affect this field.

Type Choose a program type from the following list:
Acquisition, Awareness, Cross-Sell, Loyalty, Referral, Retention, Up-Sell, 
Win-Back, Other

Planned Start/
Planned End

(Required) Defaults to the current date and time. Use the select button to 
change the defaults.

Execution Period A period of time during which the program is to be executed.

Approval Status A status field that indicates that the plan has been Approved, Declined, 
Submitted, or Needs Revision.

Approval History Displays the history of approvals for the budget request.

Priority Choose a priority from 1 to 5.

Duration (in days) Calculated as the number of days between the program�s Planned Start and 
Planned End. This value updates when you save the record.
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To add detailed information to programs

1 Click an existing program in the program list (Programs > Program List)

2 Click the Program Details view tab.

3 Complete the fields using Table 17 as a guide.

4 Save the record.

Region Choose the region to which the program is related.

Organization Click the Organization select button, and select the predefined organization 
to be responsible for the program. An organization that you assign to a 
program is inherited by campaigns in that program.

Table 17. Frequently Used Fields in the Programs Details Form

Field Comment

Objective Enter a text description of the objective for this program.

Product Lines Click the Product Lines select button to select product lines that this 
program promotes.

Products Click the Product select button to select products that this program 
promotes.

Lead Partner Choose a partner organization to associate with the program. The Lead 
Partner is limited to the organizations associated to the program.

Summary Enter a summary that describes the program�s goals.

Program Template Indicates the name of the program template (if any) that has been applied 
to this program.

Default Source Code 
Format

Click the Default Source Code Format select button to select a default 
source code format for this program.

Planning Period You associate the planning period with the plan so that you can use it during 
categorization and reporting. For example, you may need to track a 
quarterly or annual planning period.

Budget Request Indicates the budget requested for this program.

Requested Budget Enter a requested budget amount.

Assigned Budget Click the Budget select button to select the program�s currency code, 
exchange date, and budget amount. The budget value is a top-down figure, 
rather than a calculated bottom-up figure.

Forecast Expenses This read-only field displays the sum of the expense data added in the 
Forecast view for campaigns associated with the program.

Table 16. Frequently Used Fields in the Program List

Field Comment
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About Using the Program Flow
The logical flow for both single-stage and multistage programs is designed using the Program Flow 
view. In this view, you graphically define the program�s single-stage or multistage logic by dragging 
and dropping program components such as campaigns, events, lists, segments, and stages into the 
workspace.

You can manually execute the program from the Program Flow view or execute the program by 
scheduling a stage. Before setting up the Program Flow, verify that the following tasks have been 
completed:

■ Define segments and lists and associate them with the campaigns.

■ Define campaigns and associated offers and events.

■ Define segment trees, if required.

The Program Flow view displays the selected program�s details and the interactive workspace with a 
palette of objects representing program elements such as campaigns, internal lists, segments, and 
stages. To set up a program flow, perform the following tasks:

1 Adding Stages to Programs on page 63

2 Using Repeating Stages Within Programs on page 63

3 Assigning Segments to Stages on page 64

4 Adding Campaigns to Stages on page 64

5 Setting Up Waves for Campaign Loads on page 65

6 Adding Imported or Internal Lists to Campaigns on page 67

7 Adding Trees to Stages and Allocating Segment Tree Cells on page 67

8 Creating and Applying Program Templates on page 68

9 Executing Programs on page 69

Actual Expenses Indicates the actual expenses associated with this program.

MDF Requested Indicates the MDF requested for this program.

Net Expense 
(Forecast)

Calculated as Actual Expense less MDF Requested.

Forecast Revenue Indicates the sum of the revenue predictions (based on data added in the 
Goals view) for campaigns associated with the program. 

Actual Revenue Indicates the actual revenue associated with this program.

Table 17. Frequently Used Fields in the Programs Details Form

Field Comment
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Adding Stages to Programs
Use the following procedure to add a stage to a program, using the Program Flow workspace.

To add a stage to a program

1 Navigate to the Programs screen.

2 In the Programs list, click a program.

3 Click the Design view tab.

4 In the Program Flow workspace, select the Stage object from the palette, and drag it onto the 
workspace.

5 To complete stage details, double-click the stage object in the workspace.

6 In the Schedule view tab, in the Details list, add or modify stage details, using Table 18 on 
page 63 as a guide.

NOTE: To display more fields, click the Details menu button, and then choose Columns 
Displayed.

Using Repeating Stages Within Programs
In most multistage programs, each stage occurs only once, separated by a specified number of days 
between stages. In some circumstances, you may want to have a follow-up stage repeat at a 
different frequency than a previous stage. For example, in Stage 1, you send a direct mailing with a 
Web site link to a large audience. In Stage 2, every day you monitor the Web site mentioned in the 
direct mail offer and call any customers who visit the Web site immediately. In this example, Stage 1 
only occurs once, and Stage 2 repeats daily until the end of the campaign.

NOTE: When using a repeating stage, be sure that your segment criteria exclude customers that 
were targeted in a previous wave of the same campaign or the same stage.

To specify a repeating stage

1 Navigate to the Programs screen.

Table 18. Fields in the Stage Detail Form

Field Comment

Objective Enter the program�s objectives.

Stage Code The default is the record identifier for the stage. Change the identifier for 
the stage source code if desired, but make sure the value is unique.

Stage Name Name of the stage. Change the stage name from the default value to 
something more meaningful such as Stage 1: Summer Program.

Summary Enter summary text that describes the stage�s implementation.
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2 In the Programs list, click a multistage program.

3 Click the Schedules view tab.

4 In the Schedules link bar, click Details.

5 In the Stages list, select a stage to repeat.

NOTE: You cannot repeat Stage 1.

Assigning Segments to Stages
You previously defined segments with criteria in the Segment Designer. You can assign these 
segments to the program stage.

To add segments to the program stage

1 Navigate to the Programs screen.

2 In the Programs list, click a program.

3 In the Program Flow workspace, select a Campaign object.

4 In the Objects palette, click and drag the Segment object to the workspace.

5 In the Previously Used Segments dialog box, perform one of the following steps:

a To create a new segment, click Choose a New Segment and select the location of the segment 
to use, and then click OK.

b Select a segment from the list and click OK.

The segment object appears in the workspace.

Repeat Step 5 to add more segments to a stage.

NOTE: When you include stand-alone segments (not part of a segment tree) in a stage, the members 
of the stand-alone segments are not deduplicated against other segments, trees, or lists in the stage.

Adding Campaigns to Stages
If you previously defined and saved campaigns with associated offers using the All Campaigns form, 
you can add them to the program.

To add predefined campaigns with associated offers

1 Navigate to the Programs screen.

2 In the Programs list, click a program.

3 In the Program Flow workspace, select the Stage object.

4 In the Objects palette, select the Campaign object, and drag it from the palette to the workspace.
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5 In the Pick Campaign dialog box, select the campaign, and click OK.

NOTE: If the campaign you want is not listed in the Pick Campaign dialog box, it may be already 
associated with another program. Although offers are reusable, campaigns are not. Use the My 
Campaigns or All Campaigns view to determine which program is using the campaign. Then, 
create a new campaign with a different name and the same offers.

To define a new campaign with offer from the Pick Campaign dialog box

1 Navigate to the Programs screen.

2 In the Programs list, click a program.

3 In the Program Flow workspace, select the Stage object.

4 In the Objects palette, select and drag the Campaign object from the palette to the workspace.

5 In the Pick Campaigns dialog box, create a new record, enter a name and description for the 
campaign, and click Save.

6 In the Pick Campaign dialog box, select the campaign, and click OK.

7 In the workspace, double-click the Campaign object to open the Campaign Offers view.

8 To add an offer, in the Offers list, create a new record.

9 In the Add Offer dialog box, select an offer, and then click OK.

NOTE: To gauge response to the offer, in some marketing programs, a control segment of customers 
may be targeted by a test campaign with no associated offer. For more information, read Testing 
Campaigns That Have Email, Fax, and Wireless Offers on page 143.

Setting Up Waves for Campaign Loads
If your marketing program consists of a one-time campaign and offer�and you are confident that 
your organization can handle the volume of responses�then you probably do not need to define 
multiple waves. Siebel Marketing provides a 100 % fully allocated wave (with a wave code of A and 
a time lag of 0) when a campaign is created.

If you are planning a multistage recurring campaign and anticipate a large distribution list of contacts 
to receive an offer, you may want to take a measured approach to distribution and split fulfillment 
of the offer among a number of waves.

Waves, or set distribution periods, are commonly used to:

■ Test the campaign concept. An initial sampling to gauge campaign response is followed by a 
larger distribution.

■ Examine the campaign mechanics. A measured distribution of the campaign offer provides 
information to guarantee the campaign mechanism works efficiently from order entry, to 
fulfillment, to response tracking.

■ Balance the load on a fulfillment center. In this case, each wave may include 10-15% of the 
list to make sure existing resources can reasonably handle launching a campaign, including 
managing campaign responses.
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In addition to setting up waved distribution periods, you can set a lag time for additional waves that 
reference the stage launch date, and then split the generated list by a percentage of contacts for 
each wave period. You can also split by a List Measure. The measure must be included in the list to 
be available for use in splitting the list.

You can use the List Distribution list to specify the vendor export list format and distribution method 
for each wave. Before creating a second wave, decrease the number in the % field of the first wave, 
which, by default, is 100%. The total percentage of values cannot exceed 100.

To set up multiple waves for a campaign load

1 Navigate to the Campaigns screen.

2 In the Campaigns list, click a campaign name.

3 Click the Design view tab.

4 Click the Wave Settings link bar.

5 In the Waves list, create a new record.

6 Complete the necessary fields, using Table 19 as a guide, and save the wave record.

Table 19. Fields in the Campaign Waves Form

Field Comment

Wave Code Enter a wave code, up to 10 characters. You cannot save the record without a 
wave code. The wave code appears as part of the source code for the campaign 
member if you set up the source code format to include it. The wave code for the 
default wave is A.

Description Describe the characteristics of the wave.

Lag The default is 0. Enter the amount of time the wave is delayed after loading a 
campaign. The maximum lag for the waves cannot be greater than number of 
days between the start date and end date of the campaign.

The wave is launched when the server processes the Launch Campaign request.

This server process can be scheduled or can be manually started using the right-
click menu in the Program Flow workspace.

Lag Unit Choose either Hours or Days. 

% The default percentage is 100 for a single wave. If you are planning multiple 
waves, first reduce the percentage number in the first wave and enter the 
percentage of contacts that are included in the second wave. The total percent 
values cannot exceed 100%.
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Adding Imported or Internal Lists to Campaigns
Imported or internal lists of contacts may be added to the campaign. To check the status of an 
imported list, double-click the list icon in the Program Flow workspace to display the List Contacts 
and Prospects view.

To add a list to the campaign

1 Navigate to the Programs screen.

2 In the Programs list, click the program name.

3 In the Program Flow workspace, select the Campaign object.

4 From the Objects palette, select the List object, and drag it to the workspace.

5 In the Pick Campaign List dialog box, select an imported or internal list, and click OK.

The List object appears in the workspace, linked to the stage and referencing the campaign.

NOTE: To view and edit list details, double-click the List object in the workspace.

Adding Trees to Stages and Allocating Segment Tree 
Cells
You can use one segment tree in each stage of your program. After you associate campaigns and a 
segment tree to a stage of the program, you must allocate each segment tree cell to the campaigns.

Adding a Segment Tree to a Stage
You can use one segment tree in each stage of your program.

To associate a segment tree to a stage

1 Navigate to the Programs screen.

2 In the Programs list, click the program name.

3 If you are not in the Design view > Program Flow link, click the Design view tab, and then click 
Program Flow.

4 In the Program Flow workspace, select a stage.

5 Drag the Segment Tree icon on to the workspace.

6 In the Pick Segment Tree dialog box, click Choose a new Segment Tree.

7 In the second Pick Segment Tree dialog box, from the folders, select the Segment Tree.

8 In the Pick Segment Tree dialog boxes, click Save, and then OK to save the tree in the program 
flow.
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Allocating Segment Tree Cells to a Stage
After you associate campaigns and a segment tree to a stage of the program, you must allocate each 
segment tree cell to the campaigns. If you include stand-alone segments in the stage that are not 
part of the segment tree, the members of the segment are not deduplicated against members of the 
tree or against other stand-alone segments. Only segment tree cells are deduplicated against other 
cells.

To allocate segment tree cells to a stage

1 Navigate to the Programs screen.

2 In the Programs list, click the program name. 

3 If you are not in the Design view > Program Flow link, click the Design view tab, and then click 
Program Flow.

4 In the Program Flow workspace, select a segment tree for allocation, and click Allocate Segment 
Tree.

NOTE: In the segment tree structure, each cell appears with the net counts and the priority used 
for deduplication.

5 In the allocation matrix, perform the following steps:

a If the tree does not match the latest version of the tree that is in the Segment Tree Designer, 
click Refresh Tree.

This action redraws the tree structure (refreshes the stored definition of the tree in the 
database), and clears any allocations. The row across the top right displays the name and 
campaign code for each campaign.

b Select the appropriate check boxes to indicate which cells should be allocated to each campaign.

You can allocate a single cell to more than one campaign, if desired. If you want each cell to 
receive a single campaign, be sure to check only one box per row. The total allocated count 
appears along the bottom of the matrix as you check the boxes.

6 To enforce a capacity limit for each campaign load, then in the Capacity Limit field for the column, 
enter a value. 

A value of 0 (zero) is ignored (no limit).

7 Click Save.

CAUTION: The Design view does not automatically save your changes to the matrix. If you do 
not click Save, the changes are not written to the file.

Creating and Applying Program Templates
You can save any program you create as a reusable program template. The template retains many 
of the planning details from the program such as the program flow, related campaigns, activity plans, 
documents, and other details. After you create a program template, you can apply the template to 
new programs. You can also share the template with other employees in your organization.
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Program templates also include child campaign templates for each of the campaigns in the design. 
For more information about campaign templates, read Creating and Applying Campaign Templates on 
page 126.

To save a program as a program template

1 Navigate to the Programs screen.

2 In the Programs list, click a program to use as a template.

3 In the Program form, click the menu button, and choose Save As Template.

This menu option is active only if your administrator has given you permission to use this action 
(using the Marketing access groups).

4 In the Save As Template dialog box, enter a name, and click OK.

5 To make changes to the new template, navigate to the Marketing Templates screen > Program 
Templates view.

6 Query for the template you created in Step 4 on page 69.

7 In the template list or form, make the necessary changes.

To apply a program template to a program

1 Navigate to the Programs screen.

2 In the Programs list, either create a new program, or select the program name to which to apply 
the template.

3 In the Program form, click the menu button, and choose Apply Template.

4 In the Apply Template dialog box, select the template to apply, and click OK.

5 When asked if you want to continue, click OK.

The Message dialog box, appears, confirming that the template was applied.

NOTE: You cannot apply a program template if your program already has stages in the program 
flow. If your program has existing stages, delete them from the program flow before applying 
the template.

6 In the Message dialog box, click OK.

Executing Programs
You can manually execute a program from the Program Flow link in the Design view. Alternatively, 
you can execute a program by scheduling a stage in the calendar. In the Schedule view, you use the 
calendar link to invoke the workflow process and execute the server tasks.

To execute a program using the Design view

1 Navigate to the Programs screen.
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2 In the Programs list, click the program name.

3 In the Design view, click Program Flow

4 In the Design view, right-click on the campaign.

5 Select Load Campaign.

6 In the Load Campaign Dialog Box, select the time and date, and click OK.

7 In the Design view, right-click on the campaign.

8 Select Launch Campaign.

9 In the Launch Wave dialog box, select the wave or waves to launch, and click OK.
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6 Creating and Using Offers
Offers are a way to present content on product and services to current and potential customers as 
part of a campaign.

This chapter contains the following sections:

■ About Creating and Using Offers on page 71

■ Creating, Modifying, and Associating Products with Offers on page 72

■ About Creating and Editing Offer Templates on page 75

■ Creating Offer Templates and Adding to the Template List on page 76

■ About Email Offers on page 78

■ Previewing Offers on page 90

■ Personalization Items on page 90

■ About Creating Conditional Content on page 94

■ About Fax Offers on page 98

■ Web Offers on page 101

■ Creating Other Offer Types on page 106

■ Associating Literature with Offers on page 111

About Creating and Using Offers
Offers are associated with a campaign, and then presented to contacts and prospects when the 
campaign is launched. Offers can be reused in many campaigns, but the campaign is a one-time 
instance of the offer presented to a customer at a certain point in time.

Offers associated with campaigns are created using the Offers screen. Typically each campaign has 
a single offer, but you can associate multiple offers with one campaign. For example, a single 
campaign may have email and Web offer treatments.

Using the Offers views, you can create, edit, and preview reusable multichannel offers, which can be 
associated with your campaigns.

In addition, you can design personalized HTML and text templates for email and wireless offers. You 
can create emails containing conditional content that is based on contact and prospect attributes. 
Additionally, emails can contain embedded links to items such as Web offers, and Web surveys so 
the marketer can assess and capture campaign responses. Web Offers can contain embedded links 
to Web surveys, events and related URLs, downloads, and response forms.
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Process of Creating and Modifying Offers
To create and modify offers, perform the following tasks:

■ Creating, Modifying, and Associating Products with Offers on page 72

■ Associating Products with Offers on page 75

Creating, Modifying, and Associating 
Products with Offers
You can create reusable offers in the Offers screen, adding details such as the channel to use, 
activation and expiration dates, templates, literature, and so on. For more information about using 
offer templates to create an offer, read Creating Offer Templates and Adding to the Template List on 
page 76.

Use the Offers link bar to navigate directly to an offer type. The types of offers that are available to 
you depend on the features your company is licensed to use. After you create or modify an offer, you 
can associate products with the offer.

Creating and Modifying Offers
You can use the following procedures to create and modify offers. After creating an offer you can 
associate an offer template with it.

To create an offer

1 Navigate to the Offers screen.

2 In the All Offers list, create a record.

3 Complete the fields, using Table 20 on page 73 as a guide.

To modify an offer

1 Navigate to the Offers screen.

2 In the All Offers list, select an offer to change.
Siebel Marketing User Guide Version 7.8, Rev. A72 



Creating and Using Offers ■ Creating, Modifying, and Associating Products with Offers
3 Make the necessary changes, using guidelines in Table 20.

Table 20. Selected Offer Fields

Fields Comment

Offer Code Contains a unique code that identifies the offer. You can 
change this code, but make sure the new value is unique.

Channel Identifies the channel used to distribute the offer.

For example, Email, Fax, or Wireless Message.

Type Designates the purpose of the offer. For example, Cross-
Sell, Retention, or Up-Sell.

Activation Date Identifies the date that the offer becomes active. You can 
associate an inactive offer with a campaign, but when you 
launch the campaign, only active offers are executed.

Expiration Date Use the calendar controls to select the offer�s expiration 
date.

Expired offers should not be associated with campaigns 
because they are not sent out when the campaign is 
launched.

Description Enter a description of the offer.

Subject Text Used for email offers. The text to appear in the subject line 
of the email.

You can include merge fields in the subject line if desired. 
For example: Exciting offer for [Field: M/M] [Field: First 
Name] [Field: Last Name].

Approval Status Indicates if the offer has been submitted, approved, or 
declined.

Approval History Shows the approval history of the offer.

Products Use to indicate which products are being promoted by this 
offer.
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Price List Used to associate a previously defined price list with this 
offer.

A marketer can create promotional prices for specific 
products. When an offer recipient clicks a product item 
hyperlink in an email or Web offer and goes to the product 
detail Web page, the recipient sees the promotional price 
that was defined using Siebel Pricer.

The set of products associated with the selected price list 
can be different from the set of products defined in the 
offer�s product list. When a contact responds to an offer, 
clicks a product link, and goes to the product detail page, 
the contact sees the promotional price that is defined for 
that product only if that product is a part of the price list 
that was selected for this offer. Otherwise, the contact gets 
the default price for the product.

Language For email offers, do not change the value in this field.

Locale Used to locate the correct, language-specific Web page.

Email Marketing Server Used for email offers and Web offers only. Use to select the 
Email Marketing Server when sending an Email Offer. This 
server provides the following:

■ From and Reply-To header values.

■ Connection details for the email sending daemon.

■ SMTP envelope Sender address domain (for bounces).

■ Base URL to use in constructing Response Forms and 
Related URLs.

■ Web Server base URL (for product catalog items, Web 
offers, Web surveys, some response forms, and 
events).

Subscription List Use to select a marketing list of type Subscription List and 
associate this list with this offer. The subscription list may 
already have contacts or prospects or be empty.

Table 20. Selected Offer Fields

Fields Comment
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Associating Products with Offers
You can associate predefined products with the offer. Ideally, you should only select a subset of 
products from the price list associated with an offer, because there is a many-to-one relationship 
between the products and the price list. The products that you associate with the offer determine 
which product catalog page links can be embedded in Email and Web offers.

To associate a product with an offer

1 Navigate to the Offers screen.

2 In the All Offers list, select the offer and click the Products select button.

3 In the Products dialog box, in the Available list, select one or more products, and then click Add 
to copy them to the Selected list.

4 Click OK.

About Creating and Editing Offer 
Templates
All offers must be based on an offer template. A template can be empty or can include text and other 
elements. Offer templates are available in Siebel Marketing, Siebel Web Marketing, and Siebel 
Campaigns. You can create the document that will serve as a template using any HTML tool or text 
editor such as Adobe GoLive, Macromedia Dreamweaver, Microsoft Front Page, or Windows Notepad. 
After creating the source document you upload it to the Offer Templates list. 

After creating a template, you add the file to the template list and associate the template with an 
offer. When you associate a template with an offer, Siebel Marketing creates a copy of the template, 
leaving the master unaffected. This copy has the same name as the original and adds a time stamp 
to provide a history.

Create Activity check box Used for email offer templates. Select this option to set 
activity logging. When the email is sent, an activity is 
created for each recipient of the email, stating that the 
email was sent. The activity record is created through the 
System Activity Object for either the Campaign Recipient 
or Campaign Position business components.

Delivery Profile Used when sending fax offers. This field is only available in 
the fax offers view, not in fax offer records in the All Offers 
view. Profiles are created using the Communications 
Administration screen�s Communications Drivers and 
Profiles view. For more information, read Creating Delivery 
Profiles and Associating with Fax Offers on page 100.

Table 20. Selected Offer Fields

Fields Comment
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Offer templates can be associated with the following offer types:

■ Fax offers. For more information on Fax offers, read Associating Templates with Fax Offers on 
page 99.

■ Email offers. When creating an email offer, you can use the Edit Email view tab to associate a 
template with the offer.

■ Web offers. When creating a Web Offer, you can use the Edit Web Offer view tab to associate a 
template with the offer.

Process of Creating and Editing Offer 
Templates
To create and edit offer templates, perform the following tasks:

■ Creating Offer Templates and Adding to the Template List on page 76

■ Using Merge Fields in Email Offers on page 92

Related Topics
■ About Using Hyperlinks (HREF) in Offer Templates on page 77

■ Personalization Items on page 90

■ Merge Fields Personalization Item on page 90

Creating Offer Templates and Adding to the Template 
List
Offer templates are usually created with a file type of text (TXT) or HTML (HTM or HTML). You create 
the template using third-party HTML tools and text editors, such as Microsoft Front Page and 
Windows Notepad.

After creating the template using a third-party tool, you must add the new template to the Offer 
Templates list so that you can associate it with an offer.

To create an HTML or text offer template

1 Create an HTML template, using third-party HTML or text editor of your choice:

a Using Microsoft Word, Front Page, Notepad, or another editor, create a new file.

b For HTML templates, save the file using an HTM file extension.

CAUTION: Take care when using quotation marks in personalization elements. Some 
applications replace straight quotation marks (") with curly (also called smart) quotation 
marks (��). Curly quotation marks cause errors when used in personalization elements.
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2 If it does not already exist, create a directory of your HTML templates directory and name it 
Images.

In this directory, you store the graphics to be used in the offer. Make sure that you refer to each 
image as follows, replacing image.gif with the name of the embedded image:

<IMG BORDER=0 SRC="http://<server name>/Web Marketing/images/image.gif">

NOTE: You cannot use HTML or embedded images in text email. However, some email readers 
display images that the sender attached to a text email at the end of the text email.

3 Add the template you created to the Offer Templates list.

4 Copy the images you embedded in your offer to the subdirectory you created or the image folder 
you referenced in Step 2.

To add a template to the Offer Templates list

1 Navigate to the Offers screen.

2 In the Offers link bar, click Offer Templates.

3 In the Offer Template list, create a record.

4 Complete the fields to add the offer template to the list:

a In the Name field, enter a name for the template.

b Click the File Name select button and select the template file.

To modify an existing offer template

1 Make the necessary modifications to the template file saved on your local drive, using the same 
text editor used to create the file.

2 Save and close the file.

3 Navigate to the Offers screen > Offer Templates view.

4 In the Offer Template list, select the template record.

5 In the File Name field, click the select button.

6 In the Add Attachment dialog box, click Browse.

7 Select the file, and click Open.

About Using Hyperlinks (HREF) in Offer Templates
Siebel Marketing can perform a special processing task for HTML-based emails and Web offers. A URL 
address entered directly into the body of an HTML template, such as http://
www.mycompanyname.com, is not recognized as a hyperlink by the HTML parser. The generic HTML 
syntax for a hyperlink is:

<a href="target url">highlighted text or picture</a>
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The link includes both the URL and the anchor, which is the text or image that appears in the 
template and links to the URL. Thus, to create a link to the URL http://www.mycompanyname.com 
and display the web site as the text in the message, you must enter the following:

<a href="http://www.mycompanyname.com">MyCompanyName Web Site</a>

Using this method, Web offers, response forms, and product items are replaced differently in HTML 
templates from the way they are replaced in text templates. The following list describes the default 
method for processing hyperlinks:

■ For Web offers, Web surveys, and product links, Siebel Marketing creates the hyperlink so that 
the hyperlinked text is the Web offer name, Web survey name, or product name such as in the 
following reference:

<a href="[Web Offer: 10% discount offer]">10% discount offer</a>

For more information, read Personalization Items on page 90.

■ For Response forms, Siebel Marketing creates the hyperlink so that the hyperlinked text is the 
same as the Response forms description in the Response Types view. The hyperlinked text for a 
response form can be modified in the Response Types view, where, for each response form, a 
description field represents the value used for highlighted text.

These default methods for processing hyperlinks in Siebel Marketing can be modified. You can put 
an asterisk (*) before the tag to tell the application that you are manually defining the hyperlink 
format in the HTML body. The asterisk tells the application not to create the hyperlink.

For example, instead of inserting [Web Offer: Great Discount], the marketing manager can enter the 
following:

<a href="[*Web Offer: Great Discount]">Whatever I want to highlight be it text or 
picture</a>

In this case, Siebel Marketing replaces the Web Offer with the proper URL but does not create the 
HREF syntax. You can then create a Web offer link, product item link, and response form link with 
any text or picture you desire.

About Email Offers
Email offers are available in Siebel Marketing. Using the Email Offers view, a marketer can design 
and distribute a personalized email offer to target recipients of a campaign. An email offer can be 
associated with a price list for various products. If the recipient clicks on a product link in an email 
offer, the product detail page displays the promotional price for that product rather than the list price.

The Email Offers view includes the Offer Details, Edit Email, Delivery Profile, Attachments, and 
Advanced tabs.

■ Offer Details. This form contains additional fields that you can use if the email offer requires 
approvals from your company�s marketing and legal departments. It provides a unique identifier 
for the offer in the Offer Code field. Use this form to specify the email offer�s Subject Text, the 
Email Marketing Server (Reply-To and From headers, Email Marketing Daemon configurations, 
and Web Server URLs) to be used to distribute the offer, and Personalization Format to use with 
this offer.
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■ Edit Email. Use this form to edit the template content as well as select Personalization Items 
such as Product Catalog Item. Category elements can be inserted into the template in the HTML 
Editor.

■ Delivery Profile. This read-only list provides a list of the Email Marketing Server parameters for 
the Email Marketing Server that is associated with the offer.

■ Attachments. Includes literature items with your email offer. These items are delivered as 
attachments to the email when the campaign is launched.

■ Advanced. Contains the Related Web Offers, Related Web Surveys, Related Events, and Related 
URLs lists. Use these lists to specify the Web offers, Web surveys, events, and URLs that you plan 
to include as hyperlinks in the email offer. Adding these elements embeds them as a 
Personalization Element. Web Surveys are created using Siebel SmartScript. For more 
information, read Siebel SmartScript Administration Guide.

Whenever an offer recipient clicks a Web offer, Product Catalog Item, or Related URL link in an 
email offer, the click is captured as a response. The available response types are Clicked On Web 
Offer, Clicked On Web Survey, Clicked On Product URL, and Clicked on URL.

NOTE: Siebel Events views are not currently included in the Siebel Web Marketing application. 
Therefore, if you embed a related event in an email offer, related events must be directed to the 
Web Server on which Siebel Events is installed. To accomplish this, the Web Server field must 
contain the location of the Web Marketing Web Server and the location of the Events server. For 
more information read the Web Server field in Table 20 on page 73.

Process of Working with Email Offers
To set up Email Offers, perform the following:

■ Creating Email Offers on page 80

■ Associating Templates with Email Offers on page 83

■ Editing Offers on page 84

■ Adding Attachments to Email Offers on page 87

■ Adding Response Forms to Email Offers on page 87

Related Topics
■ About Merge Fields in Email Offers on page 93

■ Adding Response Forms to Email Offers on page 87

■ About Creating Conditional Content on page 94

■ If-Then-Else Personalization Element on page 94

■ Named Blocks Personalization Element on page 96

■ Creating, Modifying, and Associating Products with Offers on page 72
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Creating Email Offers
Siebel Marketing has multiple forms of email offers available for use in campaigns. The following 
topics cover these offers.

■ Creating Email Confirmation Offers on page 81

■ Creating Email Welcome Offers on page 82

■ Including Forward to a Friend in Your Email Offers on page 82

■ Creating a text email from an HTML template on page 83

To create an email offer

1 Navigate to the Offers screen.

2 Click Email Offers.

3 In the Email Offers list, create a new record.

4 Complete the fields, using Table 20 on page 73 as a guide.

Email offers have their own specific channel types available. Table 21 describes these email-specific 
channels. You must always create an offer using the Email channel. Use the other channels when 
implementing a double-opt in or subscription confirmation process. When you create offers using 
these other channels, they must be associated with the same campaign as the original Email channel 
offer.

Table 21. Channel Types for Email Offers

Email Channel Description

Email The Email channel is for standard email offers that do not use a 
subscription list.

Email-Confirm In The Email-Confirm In channel produces a confirmation opt-in offer that is 
delivered to users. The confirm-in offer is triggered by a user responding 
to the "Confirm Subscribe to List" Response Form. When this response 
form is clicked, this confirmation is delivered to the user with an additional 
link asking to confirm opt-in status to the email program.

For more information, read Creating Email Confirmation Offers on page 81.
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Creating Email Confirmation Offers
Email confirmation offers are used to respond to customers who have clicked on a �confirm subscribe 
to list� response form or a �confirm unsubscribe to list� response form in a previous message. These 
offers are sometimes called double opt in or double opt out offers because from the recipients� point 
of view they must take two actions to opt in or out. The first act is to click on a response form in an 
initial email, the second is to respond to the confirmation email. If you do not require your customers 
to go through two steps to opt in, you can send an Email-Welcome offer instead of an Email-Confirm 
In offer. For more information, read Creating Email Welcome Offers on page 82.

Siebel Marketing sends out an Email-Confirm In or an Email-Confirm Out message to only those 
contacts who have clicked those response forms. If your list includes contacts for whom there is no 
record of the �confirm subscribe to list� or �confirm unsubscribe to list� events, Siebel Marketing 
skips over them and does not send a confirmation offer.

To create an email confirmation offer

1 Navigate to the Offers > Email Offers screen.

2 Create a new email offer.

3 Set the Channel field to either Email-Confirm In or Email-Confirm Out.

4 Associate a subscription list to the offer.

5 Associate an offer template to the offer.

6 In the edit email view, include a response form for Subscribe to List within the body of the 
message.

7 Save the offer.

Email-Confirm Out The Email-Confirm Out channel produces a confirmation opt-out offer that 
is delivered to users. The confirm-out offer is triggered by a user 
responding to the "Confirm Unsubscribe List" Response Form. When this 
response form is clicked, this confirmation is delivered to the user with an 
additional link asking to confirm opt-out status to the email program.

For more information, read Creating Email Confirmation Offers on page 81.

Email-Welcome The Email-Welcome channel produces a standard welcome message to the 
email program. This message is triggered by a user recording a 
subscription record in the database. This message is triggered by a user 
responding to the "Subscribe to List" response form.

This message does not ask for confirmation, thus it is not a replacement 
for the Email-Confirm In channel. Use the Welcome channel when you do 
not want to have a double opt-in method as is used by the Email-Confirm 
In channel.

For more information, read Creating Email Welcome Offers on page 82.

Table 21. Channel Types for Email Offers

Email Channel Description
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8 Navigate to the Campaigns view.

9 Associate the offer to the appropriate email confirmation campaign.

Creating Email Welcome Offers
If you do not require your customers to use a double opt-in confirmation to accept the offer, then 
after the customer has clicked on the �subscribe to list" response form, you should follow up with an 
Email-Welcome offer. Siebel Marketing sends out an Email-Welcome message to only those contacts 
who have clicked the �subscribe to list" response form. If your list includes contacts for whom there 
is no record of the �confirm subscribe to list� event, Siebel Marketing skips over them and does not 
send the Email-Welcome offer.

To create a welcome message

1 Navigate to the Offers > Email Offers screen.

2 Create a new email offer.

3 Set the Channel field to either Email-Welcome.

4 (Optional) Associate a subscription list to the offer.

5 Associate an offer template to the offer.

6 Save the offer.

7 Navigate to the Campaigns view.

8 Associate the offer to the appropriate email confirmation campaign.

Including Forward to a Friend in Your Email Offers
Siebel Email Marketing can include a Forward to a Friend link in email offers. This provides a means 
for your contacts and prospects to forward a version of the message to others and optionally to add 
a personalized note as well.

To include Forward to A Friend in an offer

1 Navigate to the Offers > Email Offers screen.

2 In the Offers list, click an email offer.

3 Select a template to edit.

4 In the primary personalization menu, choose Response Forms.

5 In the secondary menu, choose [Response: Forward to a Friend].

6 Identify the location to insert the Forward to a Friend link.

7 Click Insert.

To include the personalized note in the forwarded message, a special merge field must be included 
within the body of the offer. This merge field inserts the personalized note in forwarded messages 
but is ignored in standard deliveries.
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To insert a personalized note merge field

1 While editing the template, in the primary personalization menu, choose Merge Fields.

2 In the secondary menu, choose [Field: Forwarder Message].

3 Identify the location to insert the Forwarded message, typically this is at the top of the message.

4 Click Insert.

Creating a text email from an HTML template
You can create a text version of your HTML offers. By creating the text version, you can streamline 
your production efforts. This creates a text template from the HTML template. You may need to 
adjust the formatting prior to delivery.

To create a text email from an HTML template

1 Navigate to the Offers > Email Offers screen.

2 In the Offers list, click an email offer.

3 In the list between the Offers list and the Editor, create an additional template for the offer.

4 In the Template Name field, choose a text offer template and click Ok.

5 Return to the HTML template within the offer.

6 Click Save Text Template.

7 To view the results, select the text template in the list above the Editor.

The text content appears in the Editor.

Associating Templates with Email Offers
This section describes how to associate a template with an email offer. To edit the offer template, 
read About Creating and Editing Offer Templates on page 75.

To associate an offer template with an email offer 

1 Navigate to the Offers screen > Email Offers view.

2 In the Email Offers list, select the offer.

3 In the Edit Email tab, create a new record.

4 In the Edit Email list, complete the necessary fields.
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a Siebel Marketing populates the Sequence field. Change the sequence if you are adding multiple 
templates with rich and plain format. The sequence field includes email attachments. Therefore, 
when you add your first template, you may get a sequence number other than 1.

For example, if you have two templates (one HTML and one text) associated with the email 
offer, adjust the sequence so that you associate the plain format (text) first and the rich 
format (HTML) last. This change satisfies the Multipart MIME standard. The Multipart MIME 
standard defines a way to send both the text and HTML content together within the body of 
a single email message. The email program displays only the part that it has been configured 
to display.

b In the Template Name field, click the select button.

You can associate one text template and one HTML template with the offer.

c In the Pick Offer Template dialog box, select the template record, and click OK.

5 Save the record to associate the template with the offer.

Editing Offers
After you add a template to an offer, you can edit it in the following ways:

■ Edit a template in the Offers screen. Make changes to your offer using the HTML editor or a 
text editor. In the Edit Email view, select a template to modify. The template appears for editing 
at the bottom of the page.

If you created your template as an HTML file, you can use the HTML editor to render the HTML 
source (tags and text) and to modify the rendered HTML. If you created your template as a text 
file, a text editor displays the offer contents for editing. Preview it to verify the offer�s syntax, 
including merge fields and embeddable objects.

■ Modify a template using a third-party HTML editor. If you need to make edits that are not 
possible in the HTML editor, you can modify the template using a third-party HTML editor. 
Examples of third-party editors are Adobe GoLive and Macromedia Dreamweaver. For more 
information, read Editing a Template Using a Third-party Default HTML Editor on page 86.

To edit an email offer

1 Navigate to the Offers screen.

2 Click an email offer.

3 In the Edit Email tab, select a template to change.

One of the following editors starts:

■ Text editor. You use this tool to make simple changes to the text. The text editor starts by 
default, if the selected template is a text (.txt) file.

■ HTML Editor. You can use this tool to make more complex changes than you can make in a 
text editor. The HTML editor starts by default, if the selected template is an HTML file (HTM 
or HTML file extension). For more detail, read Using the HTML Editor on page 85.
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4 If using the HTML editor, check that the Personalization Items toolbar is displayed.

a Right-click anywhere in the toolbar area.

b In the menu, check the Personalization Items option. If it is not checked, check it.

5 To imbed a personalization item (such as a response form or related URL):

a Locate the position in the offer text where the personalization item is to appear.

b In the Personalization Items toolbar, choose a personalization item from the primary menu. such 
as Events, Merge Fields, Product Catalog Items, Related URLs, Response Forms, Web Offers, or 
Web Surveys. For more information, read Personalization Items on page 90.

The available elements for the selected category appear in the secondary menu.

c In the secondary menu, choose a personalization item and click Insert.

6 When you finish making changes, click Save Template.

7 To preview your changes and verify that the template still performs correctly, click Verify & 
Preview.

Repeat Step 3 through Step 7 to continue editing the template.

Using the HTML Editor
You can use HTML editor to make changes to your HTML template. To make more complex changes 
than allowed in the HTML editor, read �Editing a Template Using a Third-party Default HTML Editor� on 
page 86.

The HTML editor supports the following features:

■ Alignment options: left, center, and right

■ Alt-tag support

■ Bold, italic, and underline

■ Bulleted List

■ Clip art support

■ Copy, cut, and paste

■ Fonts (typeface, size, style)

■ Find and replace

■ Graphic support

■ HTML formatting characters such as: NBSP (non-breaking space)

■ HTML source view

■ Hyperlinks

■ If-Then-Else conditional statements

■ Image map support

■ Indents
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■ MS Office document integration

■ Numbered Lists

■ Personalization support (events, merge fields, response types, web surveys)

■ Spelling checker

■ Styles

■ Tables

■ Undo and redo

■ Upload content to web servers

To make changes using the HTML editor, you enter your changes directly in the workspace. In 
addition, you can use the editing toolbar in the Template Contents workspace for formatting text. 
Most of the buttons on the toolbar are the same buttons that appear in standard text editing 
software. Table 22 summarizes some of the typically used tasks and how to accomplish them.

Editing a Template Using a Third-party Default HTML Editor
If you prefer to use a third-party HTML editor over the HTML editor, you can do so using the following 
procedure.

To edit a template file using your default HTML editor

1 Navigate to the Offers screen and, from the Offers link bar, select the type of offer.

2 In the Offers list, select an offer, and click the Edit Email or Edit Web Offer tab.

3 For email offers, select the HTML template in list between the Offers form and the Editor.

Table 22. HTML Editor Commands

To do this ... Right click in the workspace and choose ...

Copy selected text or graphics Copy

Cut selected text or graphics Cut

Insert a graphic Picture

Insert a hyperlink Hyperlink

Insert HTML Insert HTML

Paste plain text only, removing any embedded 
HTML tags or other formatting

Paste text

Paste the most recently copied text or graphics Paste

Remove unnecessary HTML tags Clean HTML

Switch view to show a preview of the page View as WYSWIWYG (default)

Switch view to show text with HTML tags View as HTML
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4 In the HTML Editor toolbar, click the View Source icon.

5 Copy all the text in the workspace to your third-party HTML editor.

6 In the third-party HTML editor, make changes to the template.

7 Paste the changed template source text back into the HTML editor.

8 In the Edit Email list, associate the HTML file to an offer.

Adding Attachments to Email Offers
Use the following procedure to add literature items as email offer attachments. Be aware that some 
Internet Service Providers limit the size of emails and email attachments that they deliver to their 
subscribers.

To add an attachment

1 Navigate to the Offers screen > Email Offers view.

2 In the Email Offers list, click the offer name.

3 Click the Attachments view tab.

4 In the Attachments list, create a new record.

5 Click the Name select button, select a literature file to attach, and click OK.

6 In the Attachments Label field, enter an attachments label for each file.

Adding Response Forms to Email Offers
You can include a variety of response forms in an email offer. Whenever a customer receives the 
email offer and clicks on the hyperlink for a response form, responses are created for the campaign.

Response types are fields in a response record. A response record may be generated by the email 
recipient clicking the response form link or by completing a form on the Web page to which he or she 
has been directed.

Table 23 on page 88 contains a list of response forms that are unique to email offers and a brief 
description of each.

To add a response form to an email offer

1 Navigate to Offers screen > Email Offers.

2 In the Email Offers list, click an email offer name.

3 Click the Edit Email view tab.

4 Click a template to edit.

The template appears in the workspace.
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5 In the Personalization Items tool bar drop-down list, choose Response Forms using Table 23 on 
page 88 as a guide.

6 In the adjacent drop-down list, choose a response type.

7 Position the cursor at the desired location in the content, and click Insert.

8 When you are finished editing, click Save Template.

Table 23. Response Forms and Descriptions

Response Form  Description

Confirm Subscribe To 
List

Use this in an initial email offer to activate a double opt-in process. When 
the recipient clicks the embedded link, Siebel Marketing sends an email 
confirm-in offer with a �subscribe to list� response form.

Confirm Unsubscribe 
from List

Use this in an initial email offer to activate a double opt-out process. When 
the recipient clicks the embedded link, Siebel Marketing sends an email 
confirm-out offer with an �unsubscribe to list� response form.

Forward to friend Navigates customers to a page where they can add the email address of 
friends and from where your company can forward the message.

Customers can also provide a text message to be sent with the email offer. 
When they submit this form, Siebel Marketing generates a Forward to 
Friend response type record and sends a copy of the email to any email 
addresses that the customer provided. It then regenerates the Response 
Form links in the email for the new recipient's email address.

One Click Unsub Sets the Do Not Email check box on the contact profile and displays a 
confirmation message to the customer that states that they have been 
unsubscribed from all email offers.

Read Receipt Detects that the email message has been opened by the customer. The 
customer is not aware of this hidden event.

This link is used only in HTML to embed a 1 x 1 pixel image in the email 
offer at the location where a response form is placed. If the recipient of 
the email offer opens the email, Siebel Marketing retrieves this image from 
the Email Marketing Server and updates the Message Open Timestamp in 
the campaign history table (S_CAMP_CON). The following list describes 
some ways a read receipt can be blocked:

■ Newer email applications have preferences options that can prevent 
the display of embedded images.

■ Ports used to make the request for the image may be blocked at the 
recipient's firewall.

■ If you place the read receipt image in the HTML part of a multipart 
MIME email message and the recipient sets up their email application 
to read text emails only, the Read Receipt image request does not 
occur.
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Creating Activities for Contacts and Prospects
Siebel Marketing can create an activity for each contact and prospect in your mailing. If you enable 
this option, then Siebel Marketing uses the Email Marketing - Update Status workflow to create the 
new activities. The workflow is called after each wave batch sent. You can customize the workflow if 
needed. Table 24 lists the workflow fields and the values used.

Requested call back Navigates customers to a Web page where they can provide contact 
information and from where your company can arrange a follow-up phone 
call.

Requested More Info Navigates customers to a Web page where they can provide contact 
information and from where your company can send more information 
such as brochures or other collateral.

Requested 
Unsubscribe

Navigates customers to a Web page where they can enter communication 
preferences by channel. For more information, read Setting Up and Using 
Web Marketing on page 207.

Subscribe to List Navigates customers to a Web page where a confirmation message 
displays stating that they have been subscribed to the list. This response 
associates the contact or prospect ID of the respondent with a subscription 
list associated with the offer.

Unsubscribe from List Navigates customers to a Web page where a confirmation message 
displays stating that they have been unsubscribed. Siebel Marketing 
generates an Unsubscribe from List response type record and removes 
their contact or prospect record from the subscription list associated with 
the offer.

Table 24. Workflow Field Values

Workflow Field Value

Account Id accountId for the contact or prospect

Campaign Id campaignId

Description offerName

Done current date

Opportunity Id opportunityId

Status Done

Type Email - Outbound

Table 23. Response Forms and Descriptions

Response Form  Description
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To create activities for contacts and prospects for an email offer

1 While creating the Email offer, click the Advanced tab.

2 Check the Create Activity check box.

Previewing Offers
You can preview what an offer looks like when received by a contact or prospect in the following 
ways:

■ Click Verify and Preview in the appropriate Edit Template view. Clicking this button 
previews the selected template and tests the behavior of conditional content to various merge 
field values. For more information, read the section in this chapter that applies to the template 
you are using.

■ Use the Test Offer feature. This feature is one way to confirming configurations for email, fax, 
and wireless offers. For example, when you use this feature to test email offers you confirm 
configurations such as Email Marketing Server configuration and proper template setup for use 
in multipart MIME. For more information, read Testing Campaigns That Have Email, Fax, and 
Wireless Offers on page 143.

Personalization Items
Personalization items are categories of supported embeddable object types. Depending on which 
item type you select, the Personalization Elements list contains the available elements for that item.

The available personalization items are:

■ Events

■ Merge Fields

■ Product Catalog Items

■ Related URLs

■ Response Forms

■ Web Offers

■ Web Surveys

Merge Fields Personalization Item
Use merge fields to customize offers by contact or prospect. Contacts or prospects can have multiple 
fields associated with them, each field defining some attribute of a contact or prospect (for example, 
the person's last name, their first name, or their account number). For each unique contact or 
prospect, the value of these fields may differ. You insert the merge field personalization element in 
the text and then the value of the Contact or Prospect field is populated into the text where you 
inserted the merge field personalization item.
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The following simple example shows two prospects with the first names of Sally and Fred, how the 
personalization item appears in the offer before and then after the contact or prospect field is 
populated.

Before population in the offer text:

Hello [Field: First Name]!

When Sally receives the offer, she gets the following:

Hello Sally!

When Fred receives the offer, he gets the following:

Hello Fred!

In some contact or prospect records, a value might not exist for a non-numeric merge field. For 
example, the database record from which the value comes is a NULL entry. When the contact or 
prospect field is populated, the merge field may default to one of the following values:

■ Empty string. The value is an empty string (a string containing no characters).

■ Unspecified. The value is the word Unspecified.

For Web offers, surveys, events, and URLs to be available as personalization elements Web Offers, 
Web Surveys, Events, and Related URLs categories, you must add the records to the Web Offers, 
Web Surveys Related Events, or Related URLs lists. For more information, read About Associating Web 
Offers, Web Surveys, Events, and URLs with Offers on page 104.

You can insert any field from the Personalization Elements drop-down menu by selecting and 
inserting it into the body of the email message. For related information, read About Using Hyperlinks 
(HREF) in Offer Templates on page 77.

For example you may want to personalize the offer with the contact�s name, such as: Exciting Offer 
for [Field: First Name] [Field: Last Name].

Using the Merge Fields category, you would select the personalization element [Field: First Name] 
and insert it into the desired location in the message. You would repeat this procedure to add a last 
name. Typically, the tags for personalization elements are enclosed in brackets ([ and ]).

During run time, the target values are substituted for these personalization elements. The response 
forms, product links, Web offer links, and Web survey links are encoded so that they become URL 
links containing the destination address, with campaign, offer, and recipient codes included. Thus, 
the URL in any text-based email can become long. The following list contains guidelines for setting 
up personalization elements:

■ The Merge Fields list is driven by your configuration. If you are using the advanced approach, 
merge fields can be extended using fields from the segmentation module. For more information, 
read Using Merge Fields in Email Offers on page 92.

■ The list of Merge Fields includes a calculated field called Current Date. This merge field is 
replaced by the Campaign Send Date when the campaign is launched.

■ The Product Catalog Items are limited to those defined for the Product catalog page for the 
products associated with the offer.
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■ The list of Web offers is limited to those defined for this offer in the Related Web Offers list view 
tab.

■ The list of Web surveys is limited to those defined for this offer in the Related Web Surveys view 
tab.

■ The list of related events is limited to those events defined for this offer in the Related Events 
link bar. When you add a related event, you only display events with active dates and that have 
a status code of Executing or In Progress.

■ Use related URLs to embed hyperlinks to offers and generic Internet Web pages in an offer. When 
a Contact or Prospect clicks this link, Siebel Marketing records a Campaign Response.

■ Typically, response forms are Web forms that a contact or prospect can use to respond to an offer 
through the Web. The response forms for an email offer are Confirm Subscribe to List, Confirm 
Unsubscribe from List, Forward to Friend, One Click Unsub, Read Receipt, Request Call Back, 
Request More Info, Request Unsubscribe, Subscribe to List, and Unsubscribe from List.

Using Merge Fields in Email Offers
Your application can be configured to use email merge fields in the following ways:

■ Basic. Provides a static set of merge fields based on the campaign recipient business component. 
These merge fields are available when your organization has not licensed or deployed the 
marketing segmentation module.

■ Advanced. Provides a flexible set of merge fields based on data from any data source or table 
within the application. The merge fields in this case are controlled by the Personalization Format 
(Email Server list format) that you select for the email offer.

For instructions on configuring the Basic or Advanced modes for email personalization, read 
�Configuring Basic and Advanced Email Personalization� in the Siebel Marketing Installation and 
Administration Guide.

In the Basic configuration, each category has a number of personalization elements. For example, 
the Merge Fields category has the following personalization elements (depending on the 
personalization format used):

■ [Field: M/M]

■ [Field: First Name]

■ [Field: Middle Name]

■ [Field: Last Name]

■ [Field: Account]

■ [Field: Account Location]

■ [Field: Job Title]

■ [Field: Work Phone #]

■ [Field: Home Phone #]

■ [Field: Cellular Phone #]
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■ [Field: Fax Phone #]

■ [Field: Email Address]

■ [Field: Current Date]

■ [Field: Source Code]

In the Offers screen, in the Advanced view tab, you need to select the appropriate personalization 
format for the email offer in the email offer form. When you create an email offer, the values for the 
Email Marketing Server and Personalization Format are set based on settings established by your 
administrator.

The default value for Personalization Format field is "Default Merge Fields". If the field value is not a 
path name, the available merge fields come from the Campaign Recipient business component user 
property. Otherwise, the columns in the report identified by the path are displayed in the Merge 
Fields picklist. You can change the default value for this field by using the Email Personalization 
Format server parameter for your object manager. 

To select a Personalization Format (merge fields) for an email offer

1 Navigate to the Offers screen.

2 In the Offers list, click the name of the email offer.

3 In the Email Offer form, click the Personalization Format select button.

4 In the dialog box, select the appropriate format from the folders that appear.

For more information about creating Email Server formats, read Siebel Marketing Installation and 
Administration Guide.

5 In the Edit Email form, from the Personalization Items drop-down list, choose Merge Fields.

The merge fields should appear in the Personalization Elements list.

About Merge Fields in Email Offers
You can use merge fields in the body of a text or HTML email offer, in the same way that they are 
used within the text or HTML of other offer types. Additionally, merge fields may be used in the 
following areas related to email offers:

■ Subject Text field of the email offer. The text to appear in the subject line of the email.

■ From Address parameter value. A parameter of the Email Marketing Server in User Delivery 
Profiles.

■ Reply To Address parameter value. A parameter of the Email Marketing Server in User 
Delivery Profiles.
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About Creating Conditional Content
There are two personalization elements that can be used to generate conditional content within an 
email offer. Each of these is made up of the following personalization elements:

■ If-Then-Else. Determines if a block of text or HTML should be removed from an outgoing email 
by verifying if a Merge field value is defined. The merge field is defined if it is NOT an empty 
string or, for numeric merge fields, if it is not a value of 0 (zero). For more information, read If-
Then-Else Personalization Element on page 94.

■ If the merge field is defined, the block of text or HTML remains in the outgoing email.

■ If the merge field is not defined, the block of text or HTML is removed from the outgoing 
email.

■ Named Blocks. Used to decide whether or not to insert a block of text or HTML into an outgoing 
email by comparing one string to another. One string is compared to another to determine if the 
block of text or HTML is inserted. For more information, read Named Blocks Personalization 
Element on page 96.

■ If the two strings are identical, the block is inserted.

■ If the two strings are not identical, the block is not inserted.

The components of these personalization elements must be placed in the correct locations in the text 
or HTML email offer or an error occurs.

If-Then-Else Personalization Element
Table 25 shows a list of If-Then-Else personalization element components.

Table 25. If-Then-Else Personalization Element Components

Personalization Element Description

$(else) The Else component is used after a $(if) or $(elseif) component. 
When an analysis of a preceding $(if) or $(elseif) component 
results in the preceding block of text or HTML being removed from 
the outgoing email, the $(else) component's block of text or HTML 
is not removed from the outgoing email. If the preceding $(if) or 
$(elseif) component does not remove its block of text or HTML, the 
$(else) component removes its block of text or HTML.

$(elseif [Field: FieldName]) The Else-If component is the same as the If component, except that 
it is used after the start of the If-Then-Else personalization 
element.
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The following is a simple example of the use of an If-Then-Else personalization element. If the first 
name is defined, the contact's or prospect's first and last name appears. If the first name is not 
defined, only the last name appears:

$(if [Field: First Name])
Dear [Field: First Name] [Field: Last Name],
$(else)
Dear Mr. or Mrs. [Field: Last Name],
$(endif)

Nesting If-Then-Else personalization elements (placing one within another) is an acceptable practice. 
The following is an example of nesting these elements:

$(if [Field: First Name])
$(if [Field: Last Name])

Dear [Field: First Name] [Field: Last Name],
$(else)

Dear [Field: First Name],
$(endif)

$(elseif [Field: Last Name])
Dear Mr. or Mrs. [Field: Last Name],
$(else)
To Whom It May Concern:
$(endif)

Use of indentation indicates the nesting of one If-Then-Else personalization element within another. 
Indentation is not necessary, but makes it easier to read. Also, in this example, each component is 
on its own line. This use of separate lines is also not necessary, but it makes reading the offer easier.

After the Email Marketing Server makes the decision about what text or HTML to remove, the If-
Then-Else personalization element components are also removed (including their trailing line 
breaks).

To insert if-then statements

1 Navigate to the Offers screen.

2 In the Offers List, click an email offer.

3 Select a template to edit.

$(endif) The End-If component closes the current If-Then-Else 
personalization element.

$(if [Field: FieldName]) The If component is required to start an If-Then-Else 
personalization element. It determines if the merge field named 
[FieldName] has a value. If there is a value for [FieldName], the 
text between this If-Then-Else component and the next If-Then-
Else component is not removed from the email.

Table 25. If-Then-Else Personalization Element Components

Personalization Element Description
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4 If the If-Then-Else toolbar is not displayed, right-click in the toolbar area and select it.

5 In the primary menu, choose If.

6 In the secondary menu, choose a merge field to be personalized.

7 In the tertiary menu, choose a conditional operator.

8 Enter the value of the merge field to be personalized.

9 Select a location in the template to insert the personalized If statement.

10 Click Insert Rule.

11 Place the conditional content between $(if) and $(endif) tags.

12 (Optional) Add $(elseif) conditions if more than one iteration of the content should appear.

13 Place default content after the $(endif) tag.

Named Blocks Personalization Element
Table 26 shows a list of Named Blocks personalization element components.

NOTE: The string comparison is case sensitive.

The following is a simple example of the use of a Named Blocks personalization element:

<P>The temperature of your favorite drink is $(InsertBlock "[Field: Favorite 
Drink]").</P>
$(DefineBlock "Coffee")
<B>hot</B>
$(EndBlock)

$(DefineBlock "Iced Tea")
<B>cold</B>
$(EndBlock)

Table 26. Named Blocks Personalization Element Components

Personalization Element Description

$(DefineBlock "MatchString") Define Block component. Starts a block of text or HTML that is 
inserted in place of an Insert Block component when MatchString 
is identical to the MatchString of the Insert Block component.

$(EndBlock) End Block component. Ends a block of text or HTML started with 
the Define Block component.

$(InsertBlock "MatchString") Insert Block component. A block of text or HTML is inserted at the 
location this component is placed when MatchString is identical 
to the MatchString of a Define Block component. This comparison 
is case sensitive.
Siebel Marketing User Guide Version 7.8, Rev. A96 



Creating and Using Offers ■ About Creating Conditional Content
$(DefineBlock "Water")
<B>cool</B>
$(EndBlock)

In this example, the merge field named Favorite Drink is the value Coffee. After the merge fields are 
populated, the following sentence appears:

The temperature of your favorite drink is hot.

The HTML source reads:

<P>The temperature of your favorite drink is <B>hot</B>.</P>

If there is no match for an Insert Block component match string, then the Insert Block component 
is not replaced by any text or HTML. After the Email Marketing Server resolves all matches, the 
remaining Named Block personalization element components are removed (including their trailing 
line breaks and any text or HTML between Define Blocks and End Blocks).

NOTE: The Define Block and End Block components may be placed within the HTML HEADER tags. 
This placement can make the email offer more readable.

To insert named blocks

1 Navigate to the Offers screen.

2 In the Offers List, click an email offer.

3 Select a template to edit.

4 If the If-Then-Else toolbar is not displayed, right-click in the toolbar area and select it.

5 In the primary menu, choose Insert Block.

6 In the secondary menu, choose a merge field.

7 In the secondary menu, choose a merge field to be personalized.

8 Select a location in the template to insert the block.

9 Click Insert Rule.

This inserts the block to be personalized. You need to define the values that have personalized 
content.

To set values for personalized content

1 In the primary menu, choose Create Block.

2 Enter the value of the personalized element to be linked to this block.

3 Click in the workspace after previously inserted Insert Block statement.

4 Click Insert Rule.

5 Place conditional content between $(DefineBlock "merge field") and $(EndBlock) statements.
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About Applying Localization Rules to Offers
Each offer record contains a locale value. The locale is used to locate and display the localized landing 
page for response forms. When you create an email offer record, the locale value defaults to the 
value set in your profile. You can change the value to match your business needs. When you launch 
the campaign, the locale assigned to the email offer is used for all recipients.

The default character set for emails is UTF-8. This is the value set in the Charset attribute for the 
email's Content-Type header. To change the Charset attribute, select an Email Marketing Server 
profile with the correct Charset attribute or request a Administrator to make the changes necessary 
to the Email Marketing Server profile that you use.

NOTE: Internally, templates are maintained using the UTF-8 character set. Therefore, the character 
set should be able to represent characters for any written language.

The character set for the template you upload should be the default character set configured for the 
operating system you are using (the current code page on Windows or UTF-8 on UNIX). On UNIX 
platforms, an environment variable (SIEBEL_FILE_ENCODING) can be assigned to a character set to 
use in place of UTF-8 when reading templates. If the original template file contains a BOM (Byte 
Order Mark), the character set of the template file can be detected. This detection is useful when the 
character set differs from the platform default character set.

CAUTION: Be careful when using a character set for outgoing email that differs from the platform 
default character set or UTF-8. If the Email Marketing Server character set is not compatible with the 
character set of the original template file that is read from disk, the resulting email text may be 
unreadable.

About Fax Offers
Fax offers are available in Siebel Marketing and Siebel Campaigns. Using the Fax Offer view, a 
marketer can create personalized faxes for targeted distribution during a campaign.

The Fax Offer view contains the following view tabs:

■ Offer Details. This form contains additional fields that you can use to specify a predefined 
communications Delivery Profile for fax distribution, an Activity check box that may be used to 
track the offer as an activity and approval check boxes and fields if the fax offer requires approval 
from your company�s marketing and legal departments. The Offer Details form also displays a 
unique identifier for the offer in the Offer Code field.

■ Edit Fax. Use this form to choose an offer template and specify the personalization elements 
that are included in your fax design.

■ Delivery Profile. This read-only list displays parameters of the Siebel Communications profile 
chosen for the fax offer. For more information on setting up a delivery profile for a fax offer, read 
Siebel Communications Server Administration Guide. For more information on testing and 
distributing fax campaigns, read Testing Campaigns That Have Email, Fax, and Wireless Offers on 
page 143.

■ Literature. This list shows the company and product information associated with the media 
offer. You can add additional items to this list if desired. For more information, read Associating 
Literature with Offers on page 111.
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■ Related Events. Displays events related to fax offers.

Process of Working with Fax Offers
To set up fax offers, perform the following topics:

■ Associating Templates with Fax Offers on page 99

■ Creating Delivery Profiles and Associating with Fax Offers on page 100

Related Topics
■ Creating, Modifying, and Associating Products with Offers on page 72

■ Delivery Profiles for Fax Offers on page 99

Associating Templates with Fax Offers
This section describes how to associate a template with a fax offer. To edit the template, read About 
Creating and Editing Offer Templates on page 75.

To associate an offer template with a fax offer

1 Navigate to the Offers screen > Fax Offers view.

2 In the Fax Offers list, select the fax offer, and click the Edit Fax view tab.

3 In the Edit Fax form, create a new record.

4 Click the Template Name select button.

5 In the Pick Offer Template dialog box, select the predefined template for the fax offer, and click 
OK.

Only offer templates that you add to the Offer Templates list are available for selection. For more 
information, read About Creating and Editing Offer Templates on page 75.

6 Save the record.

The template contents appear on the right side of the view, and Edit Template and Verify & 
Preview buttons become available.

Delivery Profiles for Fax Offers
Delivery Profiles are available in Siebel Marketing. They are required for fax offers. Delivery Profiles 
are created using the Communication Administration screen�s Communications Drivers and Profiles 
view. Fax offers are distributed using the fax communications driver provided with your fax 
application.
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Siebel Communications Server does not interface directly with fax servers. Most popular fax servers 
provide email gateways that connect themselves to an email server such as Microsoft Exchange 
Server or an SMTP server. The host email server recognizes messages with specially formatted email 
addresses and directs those messages to the fax server.

Siebel Communications Server interfaces indirectly with this type of fax server through the host 
email server. Except for the email address format, it makes no difference to Siebel Communications 
Server whether it is sending an email or a fax. Before fax offers can be sent out, you must select 
one of the defined profiles.

Default parameter values are set for each communications driver within the Communication 
Administration screen�s Communications Drivers and Profiles view. You can create customized 
communications profiles for each of these driver types that override the default values for that driver. 
For example, a profile might specify customized From and Reply-To email addresses.

For more information about communications drivers and profiles, read Siebel Communications 
Server Administration Guide.

For more information about using delivery profiles, read Creating Delivery Profiles and Associating with 
Fax Offers on page 100. 

Creating Delivery Profiles and Associating with Fax 
Offers
Use this section to select a communications driver and create a profile for fax offers and then 
associate that profile with a fax offer.

To create a delivery profile for fax offers

1 Navigate to the Administration-Communications > Communications Drivers and Profiles view.

2 In the Communications Drivers list, select a driver, and click the Profiles view tab.

3 In the Profiles list, create a new record:

a In the Name field, enter a name for the new profile.

b In the Organization field, accept the default organization, or click the select button to select 
another organization.

c In the Responsibilities field, click the select button, and in the Responsibilities list, select the 
responsibility associated with profile access.

The Responsibilities field is used in conjunction with Siebel eMail Response. It does not apply 
to outbound email campaigns.

4 Save the profile, and click the Driver Parameters view tab.

5 Edit the parameters for the profile, and save the record.
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To associate a delivery profile with a fax offer

1 Navigate to the Offers screen.

2 From the Offers link bar, select Fax Offer.

3 In the Offer Details form, select the offer record.

4 In the Delivery Profile field, select the delivery profile for the offer.

Web Offers
Web offers are targeted HTML offers that can be displayed on the Siebel Web Marketing microsite. 
Web offers are available in Siebel Marketing and Siebel Web Marketing.

Using the Web Offers view tabs, you can specify a template containing content for the Web Offer, 
edit the template and add personalization elements, identify links to related Web offers, surveys, 
related events and related URLs and attach relevant product information that can be downloaded by 
the Web site visitor. Table 27 shows the view tabs available in the Web Offers view.

Table 27. Web Offers View Tabs

View Tab Name Description

Offer Details This form contains additional fields that you can use if the Web Offer requires 
approvals from your company�s marketing and legal departments. It also 
provides a unique identifier for the offer in the Offer Code field.

NOTE: If you select the Inbound Active Flag check box, the Web Offer 
appears to eligible users in the Web Marketing home page. The Featured 
Offers applet checks this flag before displaying a Web offer to an eligible 
contact or prospect.

Edit Web Offer Use this form to attach templates containing the content of the Web offer. To 
be selected here, templates must first be added to the Offer Templates list. 
For more information, read About Creating and Editing Offer Templates on 
page 75.

■ Use the HTML editor to edit the template content as well as select 
personalization items and insert items into the template.

■ Click the Verify & Preview button to verify the template edits and display 
the finished Web offer as it appears on the Web page.

Downloads Use this list to provide a list of literature related to the offer that is available 
for download by the Web site visitor.

Advanced Contains the Related Web Surveys, Related Events, and Related URLs link 
bars. Use these lists to specify Web surveys, related events, and related URLs 
that you can embed in your Web offer, using the Edit Web Offer 
personalization elements controls. For more information, read About 
Associating Web Offers, Web Surveys, Events, and URLs with Offers on 
page 104.
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The following topics detail how to create a basic Web offer:

■ Associating Templates with Web Offers on page 102

■ Adding Attachments to Web Offers Downloads List on page 102

Related Topic
Creating, Modifying, and Associating Products with Offers on page 72

Associating Templates with Web Offers
This section describes how to associate a template with a Web offer. To edit the offer template, read 
About Creating and Editing Offer Templates on page 75. Templates must first be added to the Offer 
Templates list to be available for selection in the Edit Web Offer view tab. For more information, read 
About Creating and Editing Offer Templates on page 75.

To associate an offer template with a web offer

1 Navigate to the Offers screen > Web Offers view.

2 In the Web Offers list, select the offer, and click the Edit Web Offer view tab.

3 Create a new record.

4 Click the Template Name select button.

5 In the Pick Offer Template dialog box, select the template, and click OK.

To be available for selection, templates must first be added to the Offer Templates list. For more 
information, read Creating Offer Templates and Adding to the Template List on page 76.

6 Save the record to associate the template with the offer.

Adding Attachments to Web Offers Downloads List
The Web Offer Downloads list displays literature and other files that can be downloaded with the 
offer. Literature items must be included in the literature list to be available for selection in this view.

The Downloads list shows files that can be included in the selected Web offer for download. Any 
literature other than offer templates can be included in an offer as a download. 

The fields in this view are shown in Table 28.

Table 28. Fields in the Web Offer Downloads View

Field Comment

Comments Populated from the literature table.

Description Populated from the literature table.
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Files added here are not yet available for downloading. In this view, you select a set of files to be 
able to include as downloads from your Web offer. These files then appear in the Personalization 
Elements list of embeddable objects in the HTML Editor tool bar when you choose Downloads from 
the Personalization Items list.

You can select any file from that list and copy it into the template file and that file becomes available 
for downloading. These files are displayed in the Embedded Object list as [Download:Literature 
Item Name].

When the Siebel Marketing software encodes this tag, it uses the Literature Item Name as the 
hyperlink text. The marketer can override this default behavior by using the wildcard (*) functionality 
and manually defining the HREF link, as described in About Using Hyperlinks (HREF) in Offer 
Templates on page 77.

To attach literature in the Downloads view

1 Navigate to the Offers screen > Web Offers view.

2 In the Web Offers list, select the offer, and click the Downloads view tab.

3 In the Downloads list, select the literature to make available for downloading from the Web offer:

a Click the menu button and create a new record.

b In the Downloads form, click the Name select button.

c In the Pick Literature Item list, select the item, and click OK.

File Name Populated from the literature table.

File Type Populated with the file extension.

Modified Populated with the file modification date.

Name Click the Name select button to select a literature item.

Release Date Populated with the date that the literature item was released.

Size (In Bytes) Populated with the file size in kilobytes.

Table 28. Fields in the Web Offer Downloads View

Field Comment
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About Associating Web Offers, Web 
Surveys, Events, and URLs with Offers
Through Siebel Marketing and Siebel Web Marketing, you can associate Web offers, Web surveys, 
Events, and Related URLs with offers. Table 29 shows which offer elements can be used with each 
channel.

You can, however, relate the same Web offer to more than one email offer. For example you may 
have a Web Offer and want to associate that Web offer with multiple email offers. In this case, each 
of these email offers has a link to that same Web offer.

Related Web Offers, Related Web Surveys, Related 
Events, and Related URLs links
In the Advanced tab link bar, use the Related Web Offers, Related Web Surveys, Related Events, and 
Related URLs links to add each offer element to the appropriate offer. After you add an element to 
the list, it is available as a personalization element in the appropriate Offer. For example, after you 
add a Web offer on the Related Web Offers link bar, you can navigate to an Edit view and select Web 
Offers in the Personalization Items tool bar. Your newly added Web offer appears in the list of 
elements.

When the Web site visitor clicks a Web survey link on the Offers or Information views, a survey wizard 
appears that steps the visitor through a series of questions about the product. You can use Web 
Surveys to capture customer feedback or qualify leads. Using the Web Survey designer, you can 
design a survey once, reuse questions and answers across multiple surveys, and deploy the survey 
on the Web and in the Call Center. The hyperlink takes the customer to a predefined Web survey 
page.

NOTE: Web Surveys are created using Siebel SmartScript. For more information, read Siebel 
SmartScript Administration Guide.

The Related Web Surveys list contains a list of Web surveys related to this campaign that can be 
included in Web Offer page as URL hyperlinks. To display the SmartScript Administration screen's 
Scripts list where you can select and modify the survey, click the survey name in the Related Web 
Surveys list.

Table 29. Available Channels for Offer Elements

Related Offer Element Available Channels

Downloads Web offers

Related Events All offer channels

Related URLS Email offers, Web offers

Related Web Offers Email offers, Web Offers

Related Web Surveys Email offers, Web offers
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The following list contains descriptions of how links to offer elements appear in an offer:

■ Web offer link. The following is an example of how a link to a Web offer appears in an offer. The 
hyperlink is the image (banner_midsize.gif). When you click the link, the Web offer (Introducing 
Diet Vanilla Cake) appears.

<a href="[*Web Offer: Introducing Diet Vanilla Cake]"><img src="banner_midsize.gif" 
border=0 width="149" height="43"></a>

■ Event link. The following is an example of how a link to an Event appears in an offer. The 
hyperlink is Click Here. When you click the words Click Here, the specific Event appears.

<a href="[*Web Offer: Introducing Diet Vanilla Cake]">Click here</a>

■ Web survey link. The following is an example of how a link to a Survey appears in an offer. The 
hyperlink is the image (customer_survey.gif). When you click the image, the specific survey 
appears.

<a href="[*Web Survey: Diet Vanilla Cake Survey]"><img src="images/
customer_survey.gif" border=0 width="156" height="23"></a>

■ Related URLs link. The following is an example of how a link to a related URL appears in an 
offer. The hyperlink is Click Here. When you click the words Click Here, the specific URL appears, 
showing any specified data elements.

<a href="[*Related URL: DVC URL]">Click here</a>

■ Products link. The following is an example of how a link to a Product URL appears in an offer. 
The hyperlink is the image (order_now.gif). When you click the image, the specific product page 
appears.

<a href="[*Product: Diet Vanilla Cake]"><img src="images/order_now.gif" border=0 
width="81" height="23"></a>

Associating Web Offers, Web Surveys, Events, and URLs 
with Offers
Use the following procedure to associate Web offers, Web surveys, Events, and Related URLs with 
offers.

To associate Web offers, Web surveys, Events, and Related URLs with offers

1 Navigate to the Offers screen.

2 In the Offers link bar, choose the offer type to associate with an offer element.

3 In the selected offers list, click the offer name.

4 Click the Advanced view tab for the Web offer or offer element to associate with the selected 
offer.
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5 In the selected list, create a new record.

NOTE: Related URLs must start with http:// or the Web server address is inserted. If you have 
more than one URL, separate each one with a semicolon (;) and no spaces.

6 In the add dialog box, select the Web offer or offer element, and click OK.

Creating Other Offer Types
You can create other offer types, such as direct mail, media offers, phone, and wireless, depending 
on the application you use:

■ Contact Call Offers on page 106

■ Direct Mail Offers on page 107

■ Media Offers on page 107

■ Phone Offers and Direct Sales Offers on page 108

■ Wireless Offers on page 109

Contact Call Offers
Contact call offers are available in Siebel Pharma Marketing and Siebel Pharma Campaigns only. 
Contact call offers are executed through the Siebel Pharma sales application. Use the Contact Call 
offer view to define specific product messages to be delivered as part of pharma call detailing. The 
contact call offer view consists of the following view tabs:

■ More Info. This form contains fields that you use if the contact call offer requires approvals from 
your marketing and legal departments. It also provides a unique identifier for the offer in the 
offer code field.

■ Response Templates. Use this list to create potential responses to the product message created 
as part of the contact call offer. For instructions on how to create response templates, read 
Associating a Response Template to a Contact Call Offer on page 107.

For instructions on executing contact call offers, read the topic on Recording Marketing Responses in 
Contact Calls in Siebel Life Sciences Guide.

To create a Contact Call offer

1 Navigate to the Offers screen.

2 In the Offers list, create a new offer.

3 From the Channel drop-down list, choose Contact Call.

4 In the Offers list, complete the remaining fields.

For more information about creating offers, read Creating, Modifying, and Associating Products 
with Offers on page 72.

5 Click the Contact Call offer name.
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6 In the More Info tab, complete the fields.

Associating a Response Template to a Contact Call Offer
Response templates associated with a contact call offer determines the choice of responses that can 
be recorded as part of call reporting in Siebel Pharma.

To associate a response template to a contact call offer

1 Navigate to Offers screen.

2 From the Offers link bar, select Contact Call Offers.

3 Click the offer name.

4 In the Response Template list, create a new record.

Direct Mail Offers
Direct mail offers are available in the Siebel Marketing application. For instructions about how to 
create a direct mail offer, read Creating, Modifying, and Associating Products with Offers on page 72. 

Using the Direct Mail Offer view, you can associate Literature documents with an Offer. Siebel 
Marketing does not provide a mechanism to print direct mail offers but can pass output lists to 
vendors for execution.

You can generate output or distribution list of contacts during the campaign launch. The customer 
information is arranged according to a predefined list format, and the list can be delivered to the 
appropriate vendors through a predefined method (for example, FTP or email). For more information 
about list output and vendors, read About Previewing and Generating Lists on page 160.

The Direct Mail Offer contains the following view tabs:

■ Offer Details. This form contains additional fields that you can use if the Direct Mail Offer 
requires approvals from your company�s marketing and legal departments. It also provides a 
unique identifier for the offer in the Offer Code field.

■ Literature. This list shows the company and product information associated with the offer. To 
add literature to the list, read Associating Literature with Offers on page 111.

■ Related Events. Displays events related to direct mail offers.

Media Offers
Media offers are available in Siebel Marketing and Siebel Campaigns. For instructions about how to 
create a media offer, read Creating, Modifying, and Associating Products with Offers. 

Use the Media Offers view to define indirect offers. Types of media offers available in the standard 
product are Billboard, Print Ad, Press Release, Radio, TV, Seminar, and Trade Show. When you define 
indirect offers, you know the general characteristics of your audience but not its exact composition.
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The Media Offers view contains the Offer Details, Literature and Related Events view tabs.

■ Offer Details. This form contains additional fields that you can use if the media offer requires 
approvals from your company�s marketing and legal departments. It also provides a unique 
identifier for the offer in the Offer Code field. You can specify the type of media to use to 
distribute the offer using the Type field.

■ Literature. This shows the company and product information associated with the media offer. 
You can add additional items to this list if desired. For example, if the media offer type is press 
release, you can associate the press release content with the offer for later referral. For more 
information, read Associating Literature with Offers on page 111.

■ Related Events. This indicates if the media offer is being used to promote a specific event or 
set of events.

Phone Offers and Direct Sales Offers
Phone offers and Direct Sales Offers are available in Siebel Marketing and Siebel Campaigns.

Use the Phone Offers view or Direct Sales Offers view to define telemarketing offers to be executed 
using Siebel Call Center or another application. Table 30 shows the view tabs in the Phone Offers 
view.

Table 30. Phone Offers View Tabs

View Tab Name Description

Offer Details This form contains more fields that you can use if 
the phone offer requires approvals from your 
company�s marketing and legal departments. It 
also provides a unique identifier for the offer in the 
Offer Code field.

Literature This list shows the company and product 
information associated with the phone offer. You 
can add additional items to this list if desired. For 
more information, read Associating Literature with 
Offers on page 111.

Related Events Displays events relating to phone offers.

Advanced This form associates an Offer Group with the 
phone offer.

This tab is not available in the Direct Sales Offers 
view.
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Creating Call Guides for Phone Offers
A call guide is a read-only note field visible to call center agents as they launch campaigns. The 
information in the Call Guide field is useful to agents as they prepare for inbound and outbound 
telephone calls and when they talk to clients. You create the call guide in the Offers screen.

The Call Guide field is intended to display more detailed information about the campaign, answer 
common questions, and provide offer options. The following example shows what a Call Guide field 
may contain:

Call Guide Example 
Through the end of December, we are offering a special bonus to our current customers 

upgrading a Basic service agreement to Premium. For $149, we upgrade your service package 

as well as provide a coupon book worth $1,000 toward the purchase of our Signature brand 

of products.

If the customer agrees, the call center agent can click the Script button, and start the call script.

NOTE: A call script is written using Siebel SmartScript. You associate a script with a campaign. For 
more information, read Using SmartScripts with Campaigns on page 125. For more information about 
creating SmartScripts, read Siebel SmartScript Administration Guide.

To create a call guide

1 Navigate to the Campaigns screen.

2 In the Campaigns list, select a campaign.

3 Click the campaign name.

4 Click the Design view tab.

5 In the Call Guide text field, enter the information to use for the offer.

Wireless Offers
Use the Wireless Offers view to create text messages that can be delivered through SMS as part of 
a campaign. Wireless offers can be sent to any contacts who are associated with the campaign and 
who also are associated with mobile device addresses. Wireless offers cannot be sent to prospects.

To create a wireless offer

1 Navigate to the Offers screen.

2 In the Offers list, create a new offer.

3 From the Channel drop-down list, choose Wireless Message.

4 In the Offers list, complete the remaining fields.

For more information about creating offers, read Creating, Modifying, and Associating Products 
with Offers on page 72.
Siebel Marketing User Guide Version 7.8, Rev. A 109



Creating and Using Offers ■ Creating Other Offer Types
5 Click the wireless offer name.

6 In the Edit Wireless Message view tab, in the Personalization Elements list, verify that the merge 
fields appear.

7 Click Edit Message to add the text of the message.

8 You can insert the merge field tag where you want the merge field to be located in the body of 
the message by performing the following steps:

a In the Personalization list, copy a merge field tag to insert in the message.

b In the Message Contents workspace, paste the tag in the message contents box.

9 Click Save Message to save the message text.

Monitoring the Status of Wireless Offers
The Status field in the Campaign Contact views provides the status of different types of offers that 
have been presented to campaign contacts and prospects. After wireless offers are sent to campaign 
contacts, the application can track whether or not the wireless offer was successfully delivered. Some 
additional configuration is required to enable such tracking of wireless offer.

Two workflow policies exist to track the status of wireless offers: Campaign Offer Message Tracking 
- Delivered and Campaign Offer Message Tracking - Failed. When the wireless carrier sends a 
message back to the application with information about the success of delivery, the Status field for 
that Campaign Contact is updated from Sent to either Delivered or Failure, based on whether or not 
the wireless message was successful.

To set up wireless offer tracking

1 Verify that the Communications Management and Workflow Management server components 
have been successfully started.

2 Create a new Response Group to receive confirmation messages from wireless carriers about 
whether the wireless message was successfully delivered or not:

a Navigate to Administration - Communication > All Response Groups.

b Create a new Response Group with the Service Name set to Workflow Process Manager and 
Method Name set to RunProcess.

c Click the Input Arguments tab and create a new record with Name set to ProcessName and Value 
set to Inbound Wireless Messaging Activity Dispatch.

d Click the Profiles tab and create a new record for each Wireless Profile that is being used to send 
out Wireless Offers to Campaign Contacts.

e In the Response Groups list, pull down the menu and choose Submit Response Group 
Changes.

3 Activate the Inbound Wireless Messaging Activity Dispatch Workflow Process:

a Navigate to Administration - Business Process > Workflow Deployment.

b In the Active Workflow Processes list, query for the Inbound Wireless Messaging Activity 
Dispatch record.
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c If the record does not exist, query for it in the Repository Workflow Processes list, then click 
Activate.

d Verify that the Status for this record is Active. 

If it is not active, click Revise, then click Activate for the new record.

4 Create a database trigger based on the Campaign Offer Message Tracking - Delivered and 
Campaign Offer Message Tracking - Failed Workflow Policies.

a Start the Generate Triggers task. 

For example, run the following command, substituting your database username and 
password:

start task for comp gentrig with PrivUser=[database username], 
PrivUserPass=[database password], EXEC=true.

b Verify that the trigger gets successfully created by looking for a status of Completed when you 
run the following command:

list task for comp gentrig

c Verify that the trigger was successfully created by reading the trigger.sql file. 

At the top of this file you should find a generate trigger statement on the S_CM_MSG_TRACK 
table.

5 Start the Workflow Monitor task for the 'Marketing' Workflow Policy Group by running the 
following command:

start task for comp Workmon with GroupName='Marketing'

6 Verify that the task was successful by looking for a status of Sleeping for ... when you run the 
following command:

list task for comp Workmon

If you change the Workflow Policy in the application, you need to remove the trigger and create a 
new one. You can do this by executing the following commands, for example:

start task for comp gentrig with PrivUser=[database username], 
PrivUserPass=[database password], EXEC=true, remove=true

start task for comp gentrig with PrivUser=[database username], 
PrivUserPass=[database password], EXEC=true

Associating Literature with Offers
Literature about the products or services offered during a campaign can be associated with an offer 
using the Literature view tab in the Direct Mail, Media, Phone, and Fax Offer views. To add 
attachments to email offers, read Editing Offers on page 84.

You can associate literature items, such as white papers, presentations, brochures, advertising 
material, and product specifications with your offer to create a specialized library of information. You 
can use this library when reviewing details of offers that are being reused in current campaigns.
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In addition, a call center agent can view the literature while launching the campaign. The agent can 
also include literature items with faxes, email messages, or correspondence sent to a contact. 
Literature items are then included when you create a new correspondence record for a contact.

Before you can select literature to associate with an offer, you must add the literature items to the 
Literature screen�s All Literature Across Organizations list. For more information about adding 
literature that you can associate with your offers, read the chapter about literature in Applications 
Administration Guide.

Use the following procedure to associate specific literature items with your offers.

To associate a literature item with an offer

1 Navigate to the Offers screen.

2 From the Offers link bar, select the appropriate offer type.

3 Click the offer name.

4 In the Literature list, create a new record.

5 In the Literature form, click the Name select button.

6 In the Pick Literature Item dialog box, select the literature, and click OK.
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Marketing Campaigns
The processes and other topics in this chapter show you how to design marketing campaigns that 
meet your business needs.

This chapter contains the following sections:

■ About Siebel Campaigns on page 113

■ Process of Planning and Designing Marketing Campaigns on page 114

■ Process of Setting Up Campaigns on page 118

■ Process of Setting Up Teams and Groups on page 127

■ Process of Setting Up Campaign Execution Options on page 129

■ Process of Setting Up Campaign Quotas on page 135

■ Process of Setting Up Campaign Assignment Skills on page 139

■ Using Siebel Marketing with Siebel Events Management on page 141

■ Testing Campaigns on page 142

■ About Using Response Management on page 143

■ Reviewing and Adding Campaign Elements in Campaign Explorer on page 153

■ Process of Loading Customers in Campaigns on page 153

About Siebel Campaigns
The Siebel Campaigns module is available to users with a license for Siebel Marketing or Siebel 
Campaigns.

A campaign is the initiative in which you convey a marketing message to one or more groups of 
people. Typically, campaigns deliver a promotional offer to retain current customers or to acquire 
new customers across channels of communication. For example, you may launch a phone campaign 
that invites contacts to sign up for a special promotion or deliver a direct mail campaign that provides 
a sample of a new product and a coupon offer to existing customers.

The goal of a marketing campaign is to create an opportunity that ultimately results in a sale, brand 
recognition, or some other type of response. Marketers use both direct and indirect campaigns to 
achieve these objectives.

■ Direct campaigns target individuals using multichannel approaches such as email and telephone. 
Contacts for the campaign are derived by applying segmentation criteria against a database of 
customer information and generating a list or by purchasing or renting a list of prospects. 
Multiple campaigns can use the same segment criteria.
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■ Indirect campaigns target indeterminate groups of people whose general characteristics you may 
know, but whose exact composition you do not know. Examples of indirect campaigns are those 
that use television, radio, print ads, or other forms of media for delivery of the message. An 
indirect campaign is associated with a marketing program�s stage rather than with a specific 
segment or list.

The Siebel Campaigns module is used by Siebel Business Applications such as Call Center and Sales. 
The campaigns are the same as the campaigns that result from a campaign in the marketing 
application. Campaigns contain contacts and prospects, offers, activities, and other campaign 
execution elements.

Using Siebel Campaigns you can distribute your company�s offer using television, radio, billboards, 
direct mail, fax, email, the Web, wireless, and phone.

The campaign creation process begins with an administrator, who creates the offers and associates 
the offers with a campaign. The administrator then adds the literature, contacts and prospects, call 
summary, and call guide. The administrator also determines which script, if any, is associated with 
the campaign and who is on the campaign team. A campaign manager may associate quotas and 
incentive awards with the campaign to track progress and reward performance.

The administrator can monitor the status of campaigns using the Campaign Explorer view to display 
the Contacts, Activities, Offers, and Literature for each campaign, and by using Campaign and 
Response Charts.

Process of Planning and Designing 
Marketing Campaigns
Siebel Marketing�s program and campaign organizational tools manage activities, documentation, 
milestones, and schedules for your marketing campaigns including:

1 Creating Activity Templates on page 115

2 Associating Activity Plans with Programs and Campaigns on page 116

3 Associating Documents with Programs and Campaigns on page 118

4 Viewing Timelines on page 117

About Creating and Using Activity Plans
Siebel Marketing�s Activity Plans views associate predefined planning and milestone activities and 
tasks with a template (activity plan). Then, you can assign the templates to your marketing programs 
and campaigns. This assignment creates one or more activities that are associated with a campaign 
or a program.

NOTE: Activities are not created for contacts loaded into a campaign.

Activity Plans may be designed to help you plan the marketing program or campaign, or launch it. 
Before you link an activity plan to your campaign, you need to create activity templates or customize 
existing templates to reflect your business process and needs. Use templates to define a generic set 
of activities that may be reused.
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For example, a marketing department production manager may design an activity plan template 
called Direct Mail that contains regularly scheduled campaign activities such as meetings with 
creative or budgetary staff and start tasks. Using the Campaign Activity Plans view the manager can 
associate the activity plan template to the current campaign and then assign resources, define 
priorities and status and so on to each predefined task, adding comments where necessary.

The activity plan record is flagged to indicate how the activity plan is to be used. If the activity is 
designated as a planning task, none of its activities are copied to the campaign record when it is 
created. If the activity plan is designed for the execution of the program or campaign, select the 
Recurring check box, and the set of activities are recreated and associated with each occurrence.

If your marketing program or campaign has a mixture of planning and start activities, create two 
plans�one for planning and one for execution tasks�and assign them both to the program or 
campaign.

Creating Activity Templates
Use Activity Plan Templates to create and manage activities for programs and campaigns. You define 
templates using the Application Administration screen�s Activity Templates and Activity Template 
Details views.

A campaign�s activity plan template may include information on the type of activity, duration and 
status, a list of activities associated with the program or campaign (preparation, telephone calls, 
milestones, tasks), and so on.

To create an activity plan template

1 Navigate to the Administration - Data screen > Activity Templates view.

2 In the Activity Plan Templates list, create a new record.

3 In the Template form, complete the fields and save the record.

a Enter a name for the template.

b In the Type drop-down list, choose Program Container for a marketing program template, and 
Campaign as an activity template for campaigns.

c Enter a template description.

d In the Auto Trigger field, select the check box if the activity should be associated with the 
occurrence level.

e Select the Public check box if the activity plan may be used by others not on your team.

To create activities for the template

1 Navigate to the Administration - Data screen > Activity Templates view.

2 In the Activity Plan Templates list, select a template.

3 Click the Activity Template Details view tab.

4 In the Activity Template Details list, create a new record.
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5 Complete the necessary fields for each activity assigned to the template.

6 From the Type drop-down list, choose an activity type.

NOTE: Repeat Step 2 through Step 6 to add activities to the template.

7 Save the activity.

Associating Activity Plans with Programs and 
Campaigns
Use the Campaigns or Programs screen�s Activity Plans view to associate a template containing 
predefined activities with a program or campaign. An Activity Plan Template�s type must be set to 
Program Container for marketing programs or Campaign for marketing campaigns to be available for 
selection.

The Activity Plans view has the following elements:

■ The Campaign or Program form, which provides details of the selected campaign or program.

■ The Templates list, which can contain one or many activity plan templates.

■ The Activities list, which displays activities associated with the selected template.

To associate an activity plan and activities with a campaign or program

1 Navigate to the Campaigns or Programs screen.

2 In the Campaigns or Programs list, click the campaign name or program name.

3 Click the Plan view tab.

4 In the Plan link bar, click Activity Plans.

5 In the Activity Plans list, create a new record.

In the new row, the Recurring field contains a check mark.

6 Complete the necessary fields:

a From the Template drop-down list, select a predefined template.

b Edit the existing description if desired, or enter a description of the plan.

c Select Suppress Calendar to populate the check box if you do not want these activities added to 
your calendar view.

d Clear Recurring if the activity should be not be written to the campaign record for every 
occurrence of the campaign or program.

When you clear the Recurring check box, you indicate that this set of planning tasks is only 
performed once across all occurrences. By default, each new activity plan is set to Recurring 
when you assign it to a campaign or activity.

A list of activities appears in the Activities list. Note that the dates are populated by using the 
Lead Time column relative to the time that the activity template was associated.
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7 To change the times or dates of any of the activities, click the Schedule view tab for the campaign

8 In the Schedule link bar, click Activity List.

Viewing Timelines
Timelines are available for programs, campaigns, event plans, and events. Timelines provide 
calendar views of scheduled, active, and completed marketing tactics in a Gantt chart format. The 
chart is divided into weeks and months. Start field and End field values determine the placement of 
the timeline bars. Timelines help you determine that scheduling is appropriate and on track for 
planned marketing efforts. Timeline bars are color-coded to help you identify the status of programs 
and campaigns. You can place the cursor over a timeline bar to display more details. Table 31 shows 
the Timeline types that appear in the link bar of the Marketing Calendar screen

NOTE: If you cannot view color indicators, refer to Siebel Business Applications Accessibility Guide 
for assistance.

To view timelines

1 Navigate to the Marketing Calendar screen.

2 In the Marketing Calendar link bar, click a timelines type.

The various timeline types and their corresponding color indicators are shown in the following 
table.

Table 31. Marketing Calendar Timeline Types

Timeline Type Description

Tactics timeline Shows active, completed, and planned marketing tactics including 
campaigns, events, event plans, and programs. You can click the name of 
any tactic displayed in one of the timelines to be navigated to the details 
for that tactic. The path displays the appropriate screen (campaign, event, 
event plan, or program) according to the tactic type.

The Programs 
timeline

Shows active, completed, and planned programs. To display the child 
campaigns and related events, double-click on the folder icon next to a 
program in the chart.

The Campaigns 
timeline

Shows active, completed, and planned campaigns.

Events timeline Shows active, completed, and planned event plans and events.

Timeline Type Color Indicator

Active Green

Canceled Red

Completed Blue
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Associating Documents with Programs and Campaigns
Most marketing teams generate documents such as proposals, white papers, press releases, and 
artwork used in advertising. These documents can be attached to programs and campaigns for future 
reference.

To attach documents to programs and campaigns

1 Navigate to the Campaigns or Programs screen.

2 In the Programs or Campaigns list, click a program or campaign.

3 In the Plan link bar, click Documents.

4 Click the Attachments view tab.

5 To add a URL, in the Attachments list, perform the following steps:

a Click New URL.

b In the URL field, enter the URL, and click Add.

6 To attach a file, in the Attachments list, perform the following steps:

a Click New File.

b In the Choose File dialog box, select the file, and click Open.

7 In the Comments field, add information that identifies the file�s contents.

8 (Optional) If you want changes to the original file to be included in the attached file, select the 
Update File check box to set this preference.

To access the attached document
■ In the Documents list, click the Attachment Name to view document details.

Process of Setting Up Campaigns
You use campaigns in Siebel Marketing and Siebel Campaigns. Prior to launching a campaign, you 
need to perform some or all of the following tasks:

■ Marketing Segments and Segment Trees on page 33.

■ Chapter 6, �Creating and Using Offers.�

■ Creating Campaigns on page 119.

Planned Yellow

Scheduled Orange

Timeline Type Color Indicator
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■ Campaign Elements That Can Be Associated with Campaigns on page 122.

■ Associating Offers with Campaigns on page 123.

■ Using SmartScripts with Campaigns on page 125.

■ Process of Setting Up Teams and Groups on page 127.

■ Using Assignment Manager with Campaign Contacts on page 134.

■ Process of Setting Up Campaign Quotas on page 135.

■ Process of Setting Up Campaign Assignment Skills on page 139.

■ Associating Lists of Prospects or Contacts with Campaigns on page 154.

■ Adding Contacts and Prospects to Campaigns Individually on page 156.

■ Using Waves with Campaigns on page 159.

■ About Previewing and Generating Lists on page 160.

■ Determining Campaign Activities and Milestones. For more information, read the chapter about 
activities in Applications Administration Guide.

■ Preparing Literature Items. For more information, read the chapter about literature in 
Applications Administration Guide.

Creating Campaigns
Use this procedure to create a campaign in the Campaigns screen.

To create a new campaign

1 Navigate to the Campaign Management screen.

2 In the Campaigns list, add a new record.

3 In the Campaigns form, complete the fields.

Some fields are described in Table 32 on page 119. To display all fields in the Campaigns form, 
click the Show more button.

4 Complete the necessary fields for the campaign record, using Table 32 as a guide.

Table 32. Frequently Used Fields for a Campaign Record

Field Comments

Approval Status If the value is Revised, the campaign is still being revised.

Assigned Budget The amount of money approved to spend for the campaign.

Budget Request If the campaign has been submitted as part of a Budget Request, the 
Budget Request ID appears.
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Campaign Code Populated by Siebel Marketing. You can enter a source code for the 
campaign, or use the default record ID for the code.

The source code for this campaign is available for use as part of the 
source code format for the program. The value must be unique.

Division The internal division responsible for the campaign.

DNIS The telephone number associated with the campaign. This number 
must be set up separately in Siebel CTI (Computer Telephony 
Integration). The DNIS field for a campaign is used in CTI to query for 
this campaign and drive a screen pop to this campaign. For more 
information, read Siebel Communications Server Administration Guide.

Enter only numerals in this field. Do not use hyphens, spaces, 
parentheses, periods, or any characters other than numbers.

Execution Period The predefined time period during which the campaign is active.

Language The language in which the call script and offer was created. If no 
language is specified, the selected SmartScript runs in the default 
language for the application. If the script does not have a translation 
for the language selected, you get an error when you try to run the 
script.

Lead Partner If a lead partner was assigned at the program level and the campaign 
associated with that program does not have a lead partner, the 
campaign inherits the lead partner from the program. The choice of 
Lead Partner is limited to the organizations associated with the 
campaign.

You can change the value, selecting from any of the partners associated 
with a campaign or campaign. This lead partner is copied to any 
campaigns created from this campaign and to responses or 
opportunities that result from this campaign.

Name The name of the campaign.

You can have two campaigns with the same name but the campaign 
code for each campaign must be unique.

Organization The predefined organization that is responsible for the campaign. You 
can choose more than one organization.

You can also associate Partner Organizations with the campaign. 
Partner organizations are created and administered through Partner 
Administration. For more information, read Siebel Partner Relationship 
Management Administration Guide.

Table 32. Frequently Used Fields for a Campaign Record

Field Comments
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Planned Start/
Planned End

The planned start date defaults to the date you created the campaign. 
The planned end date defaults to 30 days later.

These dates do not affect launching campaigns. A campaign launches 
even if the planned end date has passed.

Priority The priority level for the campaign. This value can be used to refine 
contact frequency rules in segmentation criteria. For example, to 
exclude customers that have been targeted by a Priority 1 campaign in 
the last 30 days.

Product Lines You can associate product lines to the campaign to help categorize the 
campaigns.

Products You can associate products to the campaign to help categorize the 
campaigns.

Program This field populates when the campaign is associated with a specific 
marketing program.

Purpose In the Plan view tab. The purpose of a campaign, for example: �To cross 
sell products to existing customers.�

Region Choose from the list the region in which the campaign is active.

SmartScript Select a call script, if needed, to guide the agent�s interaction with the 
customer. To appear in the list, scripts must be set up in advance using 
Siebel SmartScript. For instructions, read Siebel SmartScript 
Administration Guide.

The call script starts when an agent clicks the Script button in the 
Campaign Contacts or Prospects view.

You can use the Call Guide as an alternative to a SmartScript call script.

If more than one script is associated with a campaign, the script flagged 
as primary runs when the agent clicks the Script button.

Stage This field is populated with stage information when the campaign is 
associated with a specific program�s stage.

Table 32. Frequently Used Fields for a Campaign Record

Field Comments
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Campaign Elements That Can Be Associated with 
Campaigns
Table 33 contains descriptions of many elements in the Campaign view tabs that can be associated 
with a campaign.

Status By default, campaign status is Planned (start and end dates in the 
future). Status values may be changed at any time. During automatic 
program execution, the status changes to active when a campaign is 
loaded. At the conclusion of the program, the campaign�s status 
changes to completed. If the program is executed manually, the status 
does not automatically change.

To change the status, use the status drop-down list to choose Active 
(start date in the past and end date in future) or Completed (start and 
end date in the past).

Type Choose from the list the type of campaign you are creating. Options 
include Acquire, Retain, Win-Back, Cross-Sell, and Up-Sell.

Table 33. Campaign Elements That Can Be Associated with a Campaign

Plan and Design 
Element Location and Description

Activity List On the Schedule link bar. Team members can create and assign activities 
related to the campaign.

Activity Plans On the Plan link bar. Templates of activities can be associated with a 
campaign.   For more information, read About Creating and Using Activity 
Plans on page 114.

Documents On the Plan link bar. Any team member can associate documents as 
attachments to the campaign.

Execution Options On the Design link bar. The campaign execution options specify the default 
values for these settings each time the campaign is loaded.

Expenses On the Plan link bar. Each campaign can have a forecast that predicts the 
financial performance of the plan. The actual results versus the forecast can 
be tracked for each campaign.

Lead Partner Field in the Campaign Details form view. Anytime a Campaign Plan is loaded, 
the Lead Partner is added to the associated campaign. The lead partner 
must be one of the organizations associated with the campaign.

Table 32. Frequently Used Fields for a Campaign Record

Field Comments
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Associating Offers with Campaigns
Before you implement a marketing program, you should associate one or more offers with the 
campaign, depending on your marketing strategy. The Offers list provides information about each 
offer, including the name and description, the offer type, and the source code assigned to this 
particular offer, and any associated product and price list.

When you load a campaign, Siebel Marketing creates a campaign record, and copies valid offers to 
the campaign. Any views showing the offers for each campaign have built-in visibility to prevent 
invalid offers from appearing to end users. A valid offer is as an offer with a current date that falls 
between its defined activation and expiration dates. If activation and expiration dates are not defined 
for the offer, the offer is valid by default. When you load and launch a campaign, Siebel Marketing 
copies the campaign offers to the wave history.

NOTE: If you plan to change offers during the campaign (after launching one or more waves), you 
should not disassociate the previous offer. Instead you should mark the previous offer as expired 
(using the expiration date), and associate the new active offer. This method continues to capture and 
report on responses from the previous version of the offer.

To associate offers with a campaign

1 Navigate to the Campaign Management screen.

2 In the Campaigns list, click the campaign name.

3 Click the Design view tab.

4 In the Offers list, create a new record.

5 In the Add Offer dialog box, select a predefined offer, and click OK.

Offers On the Design link bar. Each time the campaign is loaded or launched the 
associated offers is copied to the campaign. For more information, read 
Associating Offers with Campaigns on page 123.

Organizations Field in the Campaign Details form view. These are the organizations that 
have visibility to the campaign under All Campaigns. When the campaign is 
loaded, each organization is included on the associated campaign.

Related Events On the Design link bar. After you launch a campaign that has an associated 
related event, campaign contacts are added to the campaign as invited 
attendees. For more information, read Associating Related Events with 
Campaigns on page 125.

Team Members Field in the Campaign Details form view. These are the employee positions 
that have visibility to the campaign under the My Campaigns option. When 
the campaign is loaded, each team member is included on the associated 
campaign.

Table 33. Campaign Elements That Can Be Associated with a Campaign

Plan and Design 
Element Location and Description
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To associate a segment with a campaign

1 In the Marketing Module, create a segment.

2 Navigate to the Campaigns screen > Campaign List view.

3 Click the campaign Name.

4 Click the Design tab.

5 In the Design link bar, click Segments/Lists.

6 Click Add Segment to associate the segment.

If the segment has never been used in a campaign previously, click Choose a new segment, and 
select the segment from the folder location where you saved it.

7 To associate more segments, repeat Step 6.

8 After the desired segments are associated, click the menu on the upper campaign form, and 
choose Load Campaign to associate the members of the segment to the campaign.

9 Pick a time and date for the load request, and click OK.

Table 34 describes how prospects and contacts can be used in segments associated with campaigns.

Table 34. Scenarios for Using Segments in Campaigns

Scenario Data Source
Integration 
Object Comments

Segment 
contains only 
contacts

Siebel OLAP or 
Siebel OLTP

Marketing 
Contact

Fully supported. Contacts exist in the Siebel 
transactional database, so data is inserted 
only into the S_CAMP_CON table.

Segment 
contains only 
contacts

Non-Siebel 
database

Marketing 
Contact

Fully supported. New contacts and accounts 
(if mapped) are created in the Siebel 
transactional database.

Segment 
contains only 
prospects

Siebel OLAP or 
Siebel OLTP

Marketing 
Person

Fully supported. Prospects exist in the 
Siebel transactional database, so data is 
inserted only into S_CAMP_CON.

Segment 
contains only 
prospects

Non-Siebel 
database

Marketing 
Prospect

Fully supported. New prospects are created 
in the Siebel transactional database.

Make sure that the Campaign Load List 
Format for the segment is configured to load 
data into the Marketing Prospect integration 
object.
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Associating Related Events with Campaigns
Events can be associated with a campaign so that you can invite contacts and prospects to an event. 
For more information about related events, read Using Siebel Marketing with Siebel Events 
Management on page 141.

To associate events with a campaign

1 Navigate to the Campaign Management screen.

2 In the Campaign list, click the campaign name.

3 Click the Design view tab.

4 In the Offers link bar, click Related Events.

5 Create a new record, and click the Name select button.

6 In the Pick Event dialog box, select a predefined event, and click OK.

Using SmartScripts with Campaigns
A SmartScript is a script that the salesperson or call center agent uses to interact with the customer. 
It can be associated with any campaign.

If a SmartScript is associated with a business component and is run for a campaign, then that 
business component�s name must be the same as the value in the Enable Follow-up Actions field for 
the campaign. For example, if the Enable Follow-up Actions field is set to Create Responses, then the 
script�s business component must be Response. If the Enable Follow-up Actions field is set to Create 
Opportunities, then the script's business component must be Opportunity.

A script based on the Opportunity business component can be run only when the value in Enable 
Follow-up Actions is either Create Opportunities or All. A script based on the Response business 
component can be run only when the value in Enable Follow-up Actions is either Create Responses 
or All.

Segment 
contains contacts 
and prospects

Siebel OLAP or 
Siebel OLTP

Marketing 
Person

Fully supported. Contacts and prospects 
exist in the Siebel transactional database, 
so data is inserted only into S_CAMP_CON 
and S_DD_USER_KEY tables.

Segment 
contains contacts 
and prospects

Non-Siebel 
database

N/A Currently not supported.

Table 34. Scenarios for Using Segments in Campaigns

Scenario Data Source
Integration 
Object Comments
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To set up a SmartScript

1 Navigate to the Campaign Management screen.

2 Select a campaign.

3 In the SmartScript field, click the select button.

The Smart Scripts dialog box appears.

4 Select the script from the list of available scripts, and click Add.

NOTE: To add the remaining scripts used in this campaign, repeat Step 3 and Step 4.

5 In the SmartScript dialog box, select the check box of the primary script, and click OK.

Creating and Applying Campaign Templates
Using templates can save you time and effort. For example, many mailed campaigns use the same 
patterns of offers, such as an initial contact offer, a follow-up offer, and a thank-you or welcome offer. 
Email campaigns have a repeated patterns as well, starting with an initial offer, followed by 
confirmations for people opting in and opting out, followed by a welcome offer for new customers. 
By creating and using templates, you can save yourself time and effort and make your campaigns 
more consistent.

You can save any campaign as a reusable campaign template. The template retains many of the 
planning details from the campaign such as the goals, expenses, offers, documents, segments, lists, 
and activity plans. After you create a campaign template, you can reapply the template to any new 
campaigns. You can also share the template with other employees in your organization.

To save a campaign as a campaign template

1 Navigate to the Campaigns screen.

2 In the Campaigns list, select a campaign to use as a template.

3 In the Campaign form, click the menu button, and choose Save as Template.

This menu option is active only if your administrator has given you permission to use this action 
(using the Marketing access groups).

4 In the Save As Template dialog box, enter a name, and click OK.

To make changes to the new template

1 Navigate to the Marketing Templates screen > Campaign Templates view.

2 Query for the template you created in Step 4 of the previous procedure.

3 In the template list or form, make the necessary changes.

To apply a campaign template to a campaign

1 Navigate to the Campaigns screen.
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2 In the Campaigns list, create a new campaign, or select a campaign to which to apply the 
template.

3 In the Campaign form, click the menu button, and choose Apply Template.

4 In the Apply Template dialog box, select a template to apply, and click OK.

5 When asked if you want to continue, click OK.

The Message dialog box, appears, confirming that the template was applied.

6 In the Message dialog box, click OK.

Process of Setting Up Teams and Groups
Many organizations assign groups of agents to particular campaigns based on skill or territory.

The most direct way to provide access to the campaign is by assigning positions to a team. However, 
if you have a large call center where agents are organized by predefined groups of agents, you can 
set up assignments once and then assign the group to each campaign. Setting up campaign groups 
lets you add the key positions to a campaign group, without having to remember individual 
employees.

Some call centers do not have predefined groups, or the groups change often. In this case you can 
assign positions directly to the campaign team. Every employee position in the team has access to 
the campaign. To work with campaign teams and groups, perform the following tasks:

■ Assigning Teams to Campaigns on page 127. (Used by Siebel Marketing and Siebel Campaigns)

■ Setting Up Campaign Groups on page 128. (Used by Siebel Campaigns)

■ Associating Groups with Campaigns on page 128. (Used by Siebel Campaigns)

Assigning Teams to Campaigns
Campaign teams are used by Siebel Marketing and Siebel Campaigns. Campaign teams are set up 
by assigning individual employees to a team that is associated with the campaign. Each employee 
position on the campaign team has access to the campaign in the Campaigns screen.

If you are working with partners in developing the campaign, you can also include a partner as a 
team member by adding that partner�s position. The partner may then view the campaign in the 
Partner Portal, in the Campaign Management screen.

To assign a team to a campaign

1 Navigate to the Campaign Management screen.

2 In the Campaigns list, click the campaign name.
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3 In the Team field, click the select button.

The creator of the campaign is assigned as the primary member of the Campaign Team. This 
position may be removed from the team only after you select a different member of the team to 
be the Primary.

4 In the Team Members dialog box, select employees from the Available list, and click Add.

To select multiple consecutive employees, hold down SHIFT as you select each name. To select 
multiple nonconsecutive employees, hold down CTRL as you select names.

5 Click the Primary field to select the primary team member, and click OK.

The default primary team member is the position that created the campaign.

Setting Up Campaign Groups
Campaign groups are positions within your company, not individual employees. After you add a group 
to a campaign, anyone occupying a position listed in the group has access to the campaign. 
Campaign groups are used by Siebel Campaigns and can be associated with a campaign in Siebel 
Marketing.

To create a campaign group and add group members

1 Navigate to the Campaign Management screen.

2 In the Campaigns link bar, click Campaigns Groups.

3 In the Campaign Groups list, add a new record.

4 Enter a name and description for the group.

5 In the Campaign Groups list, select the group.

6 In the Positions list, add a new record.

7 In the Add Positions dialog box, select the positions for the group, and click OK.

Associating Groups with Campaigns
After you have created the campaign group, you can associate the group with your campaign. 
Campaign groups are used by Siebel Campaigns.

To add a group to a campaign

1 Navigate to the Campaign Management screen.

2 In the Campaigns link bar, click Campaigns Groups.

3 In the Groups list, create a new record.

4 Enter a name and description for the group.
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5 In the Campaigns link bar, click Campaigns List.

6 Select the campaign.

7 In the Group field, click the select view button.

8 In the Add Groups dialog box, select the group from the available list, and click Add.

9 Click OK.

Process of Setting Up Campaign 
Execution Options
Campaign execution options are available in Siebel Marketing and Siebel Campaigns. Use the 
campaign execution options to specify campaign contact ownership and control the user�s ability to 
edit campaign contacts and prospects. You specify the ownership type and complete the default 
owners (organization and position). In addition, you can apply assignment rule groups (optional) that 
perform owner assignment.

Campaign contact ownership is a feature to control team members visibility into the campaign 
contacts. Team members accessing the Campaign Contacts view can display only those campaign 
contacts and prospects that they own.

You create these assignment rules in the Assignment Rules view in the Assignment Administration 
screen. For more information, read Siebel Assignment Manager Administration Guide. You select a 
rule group for a campaign in the Campaigns screen.

To establish execution options and apply Assignment Manager rules to campaign contacts, perform 
the following tasks:

■ Setting Up Execution Options for Campaigns on page 129

■ Using Assignment Manager with Campaign Contacts on page 134.

Setting Up Execution Options for Campaigns
You can select the default execution options for each campaign when you set up the campaign. After 
the campaign is loaded, you can modify the execution options for the associated campaign at any 
time.

To assign contact ownership, make sure that you select the appropriate Campaign Contact Ownership 
value, your default owners, the Contact editing flags, and an Assignment Manager rule group.

To set execution options for the campaign

1 Navigate to the Campaigns screen.

2 In the Campaigns list, click a campaign name.

3 Click the Design view tab.
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4 In the Design link bar, click Execution Options or Execution Options - Advanced and complete the 
fields.

NOTE: Some fields exist only in the Execution Options - Advanced link.

Execution options fields are described in the following tables:

■ Assignment options (Table 35 on page 130)

■ Collaboration options (Table 36 on page 131)

■ Delivery options (Table 37 on page 132)

■ Load Options (Table 38 on page 133)

Table 35 describes the actions executed by each Execution option field.

Table 35. Execution Options - Assignment Option Fields

Field Action

Assignment Rule 
Group

Required if you select Yes - Assignment Manager in the Campaign Member 
Ownership field. Use if you want Assignment Manager to assign the 
organization owner and position owner to contacts and prospects in the 
campaign. Select a rule group to apply to contacts in the campaign.

Campaign Member 
Ownership

Controls assignment of position owner and organization owner during the 
load process. Values are:

■ No. You do not want to assign ownership. When you select this option, 
the Organization Owner and Position Owner fields are left empty on the 
campaign contacts and prospect records.

■ Yes - Manually. When you select this option, the load process populates 
the Default Position Owner and Default Organization Owner to the 
Campaign History table (S_CAMP_CON) for the contacts and prospects 
in the load. After the load process, you can manually assign organization 
and position owners on the campaign contacts and prospect records.

■ Yes - Assignment Manager. You want Assignment Manager to assign 
ownership based on Assignment Manager rule groups. The load process 
invokes the Assignment Manager engine at the end of the process to 
assign the campaign members based on the rules in the selected 
Assignment Rule Group.

Default Organization 
Owner

(Optional) Default value that is populated into the Default Organization 
Owner field during the load process when assignment is enabled (Yes - 
Assignment Manager or Yes - Manually).

The list of organizations is restricted to the organizations associated with 
the campaign. After the value is populated, it may be updated if the 
assignment engine reassigns names. For more information, read Siebel 
Assignment Manager Administration Guide.
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Table 36 describes the collaboration options for each Execution option field.

Default Position 
Owner

(Optional) Default value that is populated into the Default Position Owner 
fields during the load process when assignment is enabled (Yes - 
Assignment Manager or Yes - Manually).

The list of positions is restricted to the Default Organization Owner 
organizations associated with the campaign. After the value is populated, it 
may be updated if the assignment engine reassigns names. For more 
information, read Siebel Assignment Manager Administration Guide.

Lock Campaign 
Team Assignment

Campaign managers sometimes create assignment rules that assign 
additional positions to the campaign team. This lock flag excludes this 
campaign from the rules, so that new team members would not be assigned.

Table 36. Execution Options - Collaboration Options

Field Action

Enable Contact 
Editing

Default is on (True). When this option is checked, users on the campaign 
team or group have the ability to add an delete contacts from the campaign 
list.

Enable Contact 
Editing

Default is on (True). Clear the check box to prevent anyone from changing 
the owner fields and adding and deleting contacts. This flag controls the 
ability to edit the following fields on the campaign contact or prospect 
record:

■ Contact Last Name

■ Done Flag

■ Organization Owner

■ Prospect Last Name

■ Position Owner

In addition, when this value is True, the New and Delete buttons are 
available.

Enable Partner 
Editing of Contacts

Default is on (True). Clear the check box to prevent partners from editing 
the fields and using the buttons controlled by the Enable Contact Editing 
check box.

Enable Partner 
Editing of Contacts

When this option is checked, partners associated to the campaign (as 
organizations) have the ability to add an delete contacts from the campaign 
list.

Table 35. Execution Options - Assignment Option Fields

Field Action
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Table 37 describes the delivery options for each Execution option field.

Enable Followup 
Actions

This value controls which buttons (Create Oppty, Create Order, Create 
Response, Script) are active in the Campaign agent views (Campaign 
Members). The following list describes the values:

■ Create Opportunities. The Create Response and Create Oppty buttons 
are active.

■ Create Orders. The Create Response and Create Order buttons are 
active.

■ Create Responses. The Create Responses button is active.

■ All. All buttons are active.

Enforce Approvals When this option is active, the campaign cannot be launched unless the 
Approval Status for the campaign and its associated offers is Approved. You 
receive an error if you try to launch a campaign and the conditions are not 
met.

Control Campaign This flag denotes that this campaign is meant to be used as a control group 
for a test and control program. Control campaigns are hidden from the 
outbound call center agent views (Campaign Members - Outbound), 
because control groups should not receive offer messages. Control 
Campaigns do appear in the Inbound version the Campaign Members view, 
because you want to be able to capture unsolicited responses.

Enable Contact 
Editing

 When this option is checked, users on the campaign team or group are able 
to add an delete contacts from the campaign list.

Table 37. Execution Options - Delivery Options

Field Action

Route Contacts This flag controls whether campaign contacts should be routed to mobile 
clients. By default all routing rules for campaign contacts are disabled.

Use Pregenerated 
Files

When this option is checked, the launch option uses the most recent list 
export file for the wave being launched.

To generate an email list file or a list export file for other channels, use the 
Campaign > Export > List Distribution view

Route Prospects This flag controls whether campaign prospects should be routed to mobile 
clients. By default all routing rules for campaign prospects are disabled.

Table 36. Execution Options - Collaboration Options

Field Action
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Table 38 describes the load options for each Execution option field.

Table 38. Execution Options - Load Options

Field Action

Load Behavior Controls what happens to the previous wave or load when the user opts to 
load the campaign again. The following is a list of choices:

■ Overwrite Campaign History. Purges entire existing campaign history 
and creates a new load.

■ Create New Wave. Creates an additional load or wave for the latest load.

■ Add to Existing Wave. Finds the most recent good wave (not purged or 
suspended) and adds the campaign load members to the existing wave.

Allow Repeated 
Contacts with Load

Controls whether a specific contact or prospect ID can appear more than 
once in the same load in the campaign.

The unique index in S_CAMP_CON (campaign members or contacts table) is 
based on Campaign ID, Load Number, Contact/Prospect ID, and Token 
Number. By default the application always populates a value of 1 in the 
column, so that uniqueness is driven by the contact and campaign. However, 
if you turn off this option, the token number becomes a running number so 
there is no uniqueness enforced at the table level. This scenario is typical in 
certain industries such as Life Sciences where there is a many-to-many 
relationship between contacts and accounts. For example, in the 
pharmaceutical industry, doctors are affiliated with multiple hospitals and 
the pharmaceutical companies send offers to all of their active addresses in 
the same campaign.

Source Code Format The source code format to be used to generate source codes for the 
campaign. If the format is associated to the program level too, the value 
should be carried over when a campaign is created on the program flow.

Generate Source 
Codes during Load

Generates source codes for waves that have not been launched at the 
completion of the campaign load. If the option is disabled, you need to 
manually generate the source codes using the Generate Source Codes menu 
option in the campaign screen.

Capacity Limit per 
Load

If this value is set to a value greater than 0 (zero), the campaign load stops 
inserting campaign members as soon as the capacity is reached. For 
example, you could limit the campaign size to no more than 1000 people per 
load.

Max Errors This setting controls when the campaign load (EAI) process should abort.   
The load process tabulates the number of rejected records that were not 
inserted due to errors (bad data and so on). After the Max Errors value is 
passed, the campaign load process aborts. When this value is 0 (zero), all 
inserts and updates for the batch are backed out.
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Using Assignment Manager with Campaign Contacts
After setting execution options, you can load and launch the campaign. If you chose to automatically 
assign an owner and associate an assignment rule group with the campaign, Assignment Manager 
runs against the contacts in S_CAMP_CON at the end of the campaign loading process.

Before launching a campaign, you can add or delete campaign contacts and prospects or change the 
organization and position owners associated with a contact or prospect.

When this editing process is complete, you can run assignment manager against the campaign 
contacts and prospects to make sure ownership and visibility are correct. 

To run Assignment Manager

1 Click the Run Assignment Manager button in the Execution Options view tab.

2 Select a campaign.

Assignment Manager runs using the campaign history table (S_CAMP_CON) for that campaign�s 
contacts and prospects. For example, partners or employees may add new contacts to the 
campaign during the review process. Because these new leads may not have the correct owner, 
you can rerun Assignment Manager to assign these new records.

NOTE: You cannot run Assignment Manager until the campaign has successfully loaded.

To automatically assign owners to campaign contacts

1 Navigate to the Campaigns screen.

2 Click the campaign name.

3 Click the Design view tab.

4 In the Design link bar, click Execution Options.

5 Verify that the values in the following fields are correct:

■ Default Organization Owner

■ Default Position Owner

■ Assignment Rule Group

6 Load and Launch the campaign.

When the Campaign is loaded, Assignment Manager assigns owners to the campaign contacts.

7 To run Assignment Manager again, click the Run Assignment Manager button and select a 
campaign to load and launch.

8 Click Run Assignment Manager.

The Run Assignment Manager button is only available if you choose Yes - Assignment Manager 
in the Campaign Contact Ownership field.

9 In the Pick Campaign dialog box, select a campaign, and click OK.
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Process of Setting Up Campaign Quotas
Quotas are used by Siebel Marketing and Siebel Campaigns and may be set up for a campaign as an 
incentive for agents to meet target goals. A quota is a goal, such as a monetary goal for generating 
a certain amount of revenue for a campaign, or it may be a nonmonetary goal such as making a 
certain number of calls within a time period.

To develop a quota plan with measurable objectives and rewards for success, use the following 
process and the quota view tabs to define details. For more information, read Siebel Incentive 
Compensation Administration Guide. To set up campaign quotas, perform the following tasks:

1 Creating Campaign Quota Plans on page 135

2 Defining Quotas for the Plan on page 136 

3 Assigning Awards to the Campaign Quota Objective on page 137

4 Assigning Campaign Quota Plan Participants on page 138

Creating Campaign Quota Plans
Use the following procedure to set up quota plan for your campaign. Then, using the procedures that 
follow, define the details of the quota plan.

To create a quota plan

1 Navigate to the Campaign Management screen.

2 Click the campaign name.

3 Click the Design view tab.

4 In the Design link bar, click Quotas.

5 In the Quotas list, create a new record.

6 Complete the fields for the quota plan.

Some fields are described in Table 39.

Table 39. Quota Plan Fields

Field Comment

Active Flag Set to True when you create the quota.

Description Description of the quota plan.

End Populated when the Period field is completed. 

Internal Division Name The name of the internal division associated with this quota.

Period (Required) The time period for which the quota is active.
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Defining Quotas for the Plan
After you define the quota plan, add quota objectives that participants must meet to receive 
incentives. Prior to adding new quotas, add the appropriate Quotas, Awards, and Plan Participants.

To add quota objectives to the quota plan

1 Navigate to the Campaign Management screen.

2 Click the campaign name.

3 Click the Design tab.

4 In the Design link bar, click Quotas.

5 In the Quotas list, click the plan name.

The quota plan details appear in the Plan form, and quota objectives appear in the Quotas list.

6 In the Quotas list, create a new record.

7 In the Add Quota Objectives dialog box, select an objective, and click OK.

Repeat Step 6 and Step 7 to add additional quota objectives to the quota plan.

To edit quota objective values 

1 Navigate to the Campaign Management screen.

2 In the Campaign list, click the campaign name.

3 Click the Design tab.

4 In the Design link bar, click Quotas.

5 In the Quotas list, click the plan name.

The quota plan details appear in the form, and quota objectives appear in the Quotas list.

Plan Name (Required) Enter a relevant name for the Quota Plan.

Start Populated when the Period field is completed. 

Table 39. Quota Plan Fields

Field Comment
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6 Select the quota objective record and change values in the appropriate fields.

Information about some fields in the quota objective record is described in the following table.

The next time you select the quota record, your modifications appear.

Assigning Awards to the Campaign Quota Objective
Quota plan participants may receive awards for meeting campaign objective goals. A number of 
awards for different performance achievements may be set up using the Awards view tab list. These 
awards can then be assigned to quota objectives.

To assign predefined awards to a quota objective

1 Navigate to the Campaign Management screen.

2 In the Campaigns list, select the campaign.

3 Click the campaign name.

4 Click the Design tab.

5 In the Design link bar, click Quotas.

6 In the Quotas list, click the plan name.

The quota plan details are displayed in the form, and quota objectives appear in the Quotas list.

7 Click the Award select button and, in the Pick Quota Incentive dialog box, select the award for 
meeting the quota.

After you click OK, the selection appears in the Award field.

8 In the Target Quantity field, click the calculator button, and use the calculator to enter the 
number of units that represents the quota target.

To create new awards

1 Navigate to the Campaign Management screen.

2 Click the campaign name.

3 Click the Design tab.

Field Comment

Description Contains a detailed summary of the quota objective. You can edit this 
field.

Measure (Read only) Values are Revenue and Units. You typically add a Target 
Amount quota for a revenue measure and a Target Quantity quota for a 
units measure.

Quota Type (Read only) Values are Amount and Quantity.
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4 In the Design link bar, click Quotas.

5 In the Quotas list, click the plan name.

The quota plan details are displayed in the form, and quota objectives appear in the Quotas list.

6 In the Administration - Sales Quota link bar, click Awards.

7 In the Awards list, create a new record.

8 Complete the necessary fields for the award.

Some fields are described in the following table.

Assigning Campaign Quota Plan Participants
Assign eligible participants to your quota plan using the Participants view tab.

To add participants to the campaign quota plan

1 Navigate to the Campaign Management screen.

2 Click the campaign name.

3 Click the Design tab.

4 In the Design link bar, click Quotas.

5 In the Quotas list, click the plan name.

Quota objectives appear in the Quotas list.

6 Click the Quota Plan Participants view tab.

7 In the Participants list, create a new record.

Field Comment

Amount In the field, click the arrow, and use the calculator controls to enter the 
dollar amount for the award. If the type is cash, then this value is the 
amount of cash given with the award.

Award Date In the field, click the arrow, and use the calendar controls to specify the 
date the reward is given.

Description Enter a description of the award.

Name Enter a reference name for the award.

Type Select the award type from the drop-down list. Options are Dinner, 
Cash, Trip, and Other. Your administrator may change these values to 
reflect your company�s requirements.
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8 In the Participants list, create a new record, and complete the fields.

This field updates if you change the participant�s start or end date. You can also edit the Prorate 
field directly. For each plan participant, quotas are calculated by multiplying the prorate by the 
target amount or quantity.

For example:

Prorate=((Participant�s End Date � Participant�s Start Date) + 1) / ((Period End Date � Period 
Start Date) + 1)

Repeat this procedure to add other participants.

Process of Setting Up Campaign 
Assignment Skills
Campaign assignment skills are set up only in Siebel Campaigns. Setting up campaign assignment 
skills is a way to identify which employees have certain skills and define the attributes of each skill.

Assignment Manager uses assignment skill rules to assign telesales agents to a campaign. 
Assignment skills are categories, such as Product or Language. Campaign Skill Items are subsets of 
campaign skills. For example, a skill item for the product campaign skill may be 486 Laptop or 
Pentium Desktop. A skill item for the language campaign skill may be French or English.

When associating skills with a campaign, first define the assignment skill, and then assign properties 
to the skill using the Campaign Skill Item list. Fields in the Campaign Skill Item list vary according 
to the skill. Repeat these procedures to add as many skills as needed to the campaign.

To set up assignment skills for a campaign, perform the following tasks:

1 Associating Assignment Skills with Campaigns on page 139

2 (Optional) Defining Campaign Skill Items on page 140

3 (Optional) Deleting Assignment Skills and Campaign Skill Items on page 140

Associating Assignment Skills with Campaigns
Use the following procedure to define and associate assignment skills required for your campaign.

To associate multiple assignment skills with a campaign

1 Navigate to the Campaign Management screen.

2 In the Campaigns list, click the campaign name.

3 Click the Design tab.

4 In the Design link bar, click Assignment Skills.

5 In the Assignment Skills list, create a new record.

6 Complete the fields, typing comments that describe the skill and how it is used in the campaign.
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Defining Campaign Skill Items
Use the following procedure to define items for each campaign skill associated with your campaign.

To associate skill items with a skill

1 Navigate to the Campaign Management screen.

2 In the Campaigns list, click the campaign name.

3 Click the Design tab.

4 In the Design link bar, click Assignment Skills.

5 In the Assignment Skills list, select a skill.

6 Scroll down to the Campaign Skill Item list, and create a new record.

7 In the Campaign Skill Item list, complete the fields defining the properties for each skill item.

Deleting Assignment Skills and Campaign Skill Items
You can delete assignment skills and campaign skill items. When you delete an assignment skill, its 
campaign skill items are deleted.

To delete an assignment skill and its campaign skill items

1 Navigate to the Campaign Management screen.

2 Click the campaign name.

3 Click the Design tab.

4 In the Design link bar, click Assignment Skills.

5 In the Assignment Skills list, select the skill, and delete the record.

You have deleted the assignment skill and the campaign skill items that were associated with it.

To delete a campaign skill item

1 Navigate to the Campaign Management screen.

2 Click the campaign name.

3 Click the Design tab.

4 In the Design link bar, click Assignment Skills.

5 In the Assignment Skills list, select the skill.

6 Scroll down to the Campaign Skill Item list, and select an item to delete from the assignment 
skill.

7 Delete the skill record.
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Using Siebel Marketing with Siebel 
Events Management
Sales and marketing professionals can use the Siebel Events Management module to create, 
coordinate, and manage events across the enterprise, resulting in improved client interaction and 
expansion of the marketing message.

Siebel Events Manager is integrated with Siebel Marketing, so you can create complex, multistage 
event marketing programs. Marketing administrators can use the Program Flow view to associate 
events with marketing campaigns. Upon execution of the campaign, attendees are invited to the 
event and populated in the event attendee list. Siebel Marketing tracks responses when the 
attendees decide to accept the invitation and begin the registration process. As a result, event 
managers can track each attendee through the life of the event, from invitation, to confirmation, and 
to attendance.

Customers who have purchased the required license options for both Siebel Marketing and Siebel 
Events Management, can invite contacts or prospects to an event through an email marketing 
campaign. Sending this kind of invitation involves creating a target segment or list of invites, 
associating a related event to a campaign and email offer, and launching the campaign to send out 
email invitations with an embedded Event Web site URL. During execution, campaigns that have a 
related event automatically add the campaign contacts or prospects to the event as attendees, with 
a Registration Status of Invited.

Unlike contacts, prospects are not required to log in to the events Web site to register for an event. 
Therefore, this method for inviting prospects may be particularly useful in the case where third-party 
prospect lists are imported and not promoted to contacts. Invited prospects appear in the Events 
screen, Attendees subview.

Promoting an Event Using a Campaign
This task assumes that you have already created an Event and Offer. In most cases, you would invite 
contacts or prospects using an Email Offer. Siebel Marketing also supports other types of offers, such 
as Direct Mail, Fax, or SMS. However, the automatic embedding of the Siebel Events Web site URL 
only works with an Email Offer. 

To promote an event using a campaign

1 Creating a campaign and adding a Related Event.

For more information, read Creating Campaigns on page 119 and Associating Related Events with 
Campaigns on page 125.

2 Launch the campaign.

For more information, read Launching Programs and Campaigns on page 163.

3 To display the invited contacts or prospects after the campaign launch, navigate to the Event 
screen > Attendees view.
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Promoting an Event Using a Program
This task assumes that you have already created the events, campaigns and offers and that these 
entities are associated (such as associating an offer to a campaign and an event to a campaign). In 
most cases, users invite contacts or prospects using an Email Offer. Siebel Marketing also supports 
other types of offers, such as Direct Mail, Fax, or SMS. However, the automatic embedding of the 
Siebel Events Web site URL only works with an Email Offer. 

To promote an event using a program

1 Create a program.

For more information, read Creating Programs on page 59.

2 Navigate to the Programs screen, and click the program name.

3 In the Program Flow workspace, select the campaign used to promote the event.

4 In the Objects palette, click and drag the event icon onto the program flow workspace.

5 Select the event from the Pick Event dialog box.

6 Launch or schedule the program as you normally would.

For more information, read Executing Programs on page 69.

7 After each campaign launch, display the invited contacts/prospects by navigating to the Event 
screen > Attendees view.

Testing Campaigns
You can test outbound email, wireless, and fax campaigns in Siebel Marketing and Siebel Campaigns 
before actually sending them to target recipients. You can preview the offer delivery distribution and 
then launch the email campaign using the Send functionality.

When you use the test offer feature, a sample of the offer is sent to a designated team member, 
based on his or her position. Because the test functionality references a position rather than a 
person, if the individual holding the position changes, the test offer is sent to the person actually 
holding the position.

To test campaigns and offers, read the following topics:

■ Scenario for Testing Campaigns on page 142

■ Testing Campaigns That Have Email, Fax, and Wireless Offers on page 143

Scenario for Testing Campaigns
The marketing manager of a telecommunications company plans to roll out a campaign that targets 
mobile communications customers whose service agreements expire in the next quarter. The 
campaign features an email containing information on the latest wireless communications offers. The 
business goal is to retain the accounts of those customers by offering incentives for signing a new 
service agreement.
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The marketing manager uses Test Offer to view the content and format of the email before it is sent 
to targeted customers.

Testing Campaigns That Have Email, Fax, and Wireless 
Offers
Test Offer sends samples of email, fax, or wireless offers associated with a particular campaign to 
designated team members, based on positions. Before testing email offers, make sure you complete 
the following tasks:

■ Make sure the offer is active. The date in the Activation Date field for the email offer must 
have arrived, and the date in the Expiration Date field must be current or in the future for the 
Test Offer command to be enabled.

■ Associate the offer with a campaign. Associate the offer with an active campaign. For more 
information, read Associating Offers with Campaigns on page 123.

To test email, fax, and wireless campaign offers

1 Navigate to the Campaign Management screen.

2 In the Campaigns list, click the campaign name.

3 In the Campaign form, perform the following steps:

a Click the Team select button.

b In the Team Members dialog box, select an employee from the Available list, click Add, and then 
click OK.

4 Click the Design view tab.

5 In the Design link bar, click Offers.

6 In the Offers list, select an email offer.

7 Click the menu button, and choose Test Offer.

8 For email offers, choose a merge field from the Available Merge Fields list.

9 For fax and wireless offers, choose from the list of available team members in the Campaign 
Team dialog box.

10 Verify the email offer has been sent to the specified email address.

About Using Response Management
Siebel Marketing and Siebel Campaigns use Response Management. Whenever prospects or contacts 
respond to an offer through any channel (by inbound email, the Web, a call center, or sales 
representative), their responses may be captured in detail using the Responses screen. Using 
Response views, you can determine which contacts to pursue as opportunities.
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Campaign media can be different from response media. Recipients of an Internet campaign can 
respond through a call center, and recipients of a direct mail offer may respond by going to a Web 
offer URL. A Web site can capture response details, while phone calls or direct mail responses must 
be recorded manually.

NOTE: In Siebel Marketing, inbound emails are not automatically captured as responses. You must 
configure your email response product to support inbound email processing. For Siebel Email 
Response set-up instructions, read Siebel Email Response Administration Guide.

There are several response types and each response type has several parameters that store details 
about a given response. You can modify an automatically captured response if you have permission. 
Responses are tracked for an offer and for a campaign.

To use Response Management, you may perform some or all the following optional tasks:

■ Adding Response Information to Prospect or Contact Records on page 144

■ Using Automatic Source Code and Offer Code Lookups on page 145

■ Adding Products to Responses on page 146

■ Adding Orders to Responses on page 146

■ Adding Opportunities to Responses on page 147

■ Adding Attachments to Responses on page 147

■ Response Type Definitions on page 148

■ Promoting Responses to Opportunities on page 152

■ Creating Automatic Responses from Opportunities and Orders on page 152

Adding Response Information to Prospect or Contact 
Records
The All Responses list displays responses to selected campaigns and offers. Use this view to add 
response information to existing prospect or contact records, to promote a contact to an opportunity, 
to specify the response type and channel, and to score the response. Use an optional Details form 
to enter more information about the response.

To add response information to prospect or contact records

1 Navigate to the Responses screen.

2 In the Responses list, create a new record.
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3 In the Responses list or form, complete the fields, using the following table as a guide.

Using Automatic Source Code and Offer Code Lookups
Behind each Responses view is an automatic business service that looks up and decodes information 
based on any source codes or offer codes added in a response.

Source Code Lookups
To perform a source code lookup, enter the campaign contact�s source code into the Source Code 
field on the response form and leave the field. You do not have to save the record to perform the 
lookup. As soon as you click or step off the field, the lookup service determines whether the 
campaign is recognized and whether the contact name can be uniquely determined. If the source 
code is recognized, the correct campaign name is defaulted. If the contact name can be uniquely 
determined within a campaign, the contact name is also defaulted. The source code value is stored 
in the campaign history table (S_CAMP_CON) for each contact record.

Fields Comment

Last Name Select the Last Name for a prospect or contact.

Some fields are populated based on this selection. These include:

■ The first name of the respondent.

■ The account associated with the respondent. If no account is 
associated, use the Account select button to choose one.

■ The account address (city, state, country, telephone number, and so 
on), that are associated with the respondent are automatically filled 
in the form.

Lead Partner Choose a partner organization to associate with the response. If a lead 
partner was assigned at the program level or campaign level, that 
partner appears in this field. If you do choose to change the Lead 
Partner value, the drop-down list shows only those partners associated 
with the campaign source.

Response Method (Optional) The method used to capture the response.

Offer Name (Required) Only offers associated with the selected campaign appear in 
the list.

Score Enter a numeric value that represents a score for the response.

Source Code In Siebel Marketing and Siebel Campaigns, source codes are assigned 
to each campaign contact according to the source code format 
associated with the program stage. If the source code is included in offer 
materials, then it can be accessed by the recipients in their responses.

Offer Code Each offer has a unique offer code. If the offer code is included in the 
offer materials, then it can be accessed by the recipients in their 
responses.
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Offer Code Lookups
To perform an offer code lookup, enter the offer code in the response form. When you save the 
record, if the lookup service recognizes the offer code, it defaults the correct offer name.

NOTE: If the source code or the offer code is not recognized by the application or if the two codes 
conflict, neither values is saved and the response record is not committed to the database.

If your deployment does not require source code lookups, you can disable the Response Lookup 
business service in Siebel Tools.

Adding Products to Responses
This view tab displays a list of products associated with the response, for example, products for which 
a respondent requested information using a product link in an email or Web offer.

To add products to a response

1 Navigate to the Responses screen > Responses view.

2 In the Responses list, click the description.

3 Click the Products view tab.

4 In the Products list, create a new record.

5 In the Add Products dialog box, select the product from the list, and click Add.

The list contains products that have been associated with the offer.

Adding Orders to Responses
This view tab displays a list of the respondent�s product orders. An order record contains information 
on the order status, the order number, type, account associated with the order, the date, priority, 
and description of the order.

To add orders to a response

1 Navigate to the Responses screen > Responses view.

2 In the Responses list, click the description.

3 Click the Orders view tab.

4 In the Orders list, create a new record.

5 In the Add Orders dialog box, select the order from the list, and click Add.
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Adding Opportunities to Responses
This view tab displays a list of opportunities associated with the response.

To add opportunities to a response

1 Navigate to the Responses screen > Responses view.

2 In the Responses list, click the description.

3 Click the Opportunities view tab.

4 In the Opportunities list, create a new record.

5 In the Add Opportunities dialog box, select the opportunity from the list, and click Add.

Adding Attachments to Responses
This view tab displays a list of documents and other items that are associated with the response 
record.

To add attachments to a response

1 Navigate to the Responses screen.

2 In the Responses list, click the description.

3 Click the Attachments view tab.

4 To add a URL, in the Attachments list, perform the following steps:

a Click New URL.

b In the URL field, enter the URL, and click Add.

5 To attach a file, in the Attachments list, perform the following steps:

a Click New File.

b In the Choose File dialog box, select the file, and click Open.
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Response Type Definitions
The information captured and stored in the Response Details view depends on the response type that 
you select in the Response Type field of the response record. For each response type value, Table 40 
identifies some of the field names in which information is captured and describes the captured 
information.

NOTE: A Response is not automatically created when you click a Related Events link in an email or 
Web offer. Siebel Marketing and Siebel Campaigns do not provide responses for Clicked on Related 
Event.

.

Table 40. Response Type Field Values in the Response Details Form

Response Type Field Name Captured Information and Description

Accepted 
Invitation

Summary Indicates user accepted invitation.

Attended Description Contains Attendee Status and Event Name. Indicates that 
the contact or prospect attended the event.

Cancelled Description Contains Attendee Status and Event Name. Indicates that 
the contact or prospect canceled.

Clicked on event 
URL

Description Contains Event Name. Indicated that the contact or 
prospect clicked on the URL in the invitation email.

Clicked on 
Product URL

Summary Name of the product. The list of product URLs the 
respondent clicked appears in the Responses screen, 
Products view.

Clicked on Web 
Offer

Summary Name of the Web offer that the offer recipient clicked. 

Completed Web 
Survey

Summary Name of the Web survey that the offer recipient clicked.

Confirm 
Subscribe to List

Summary Indicates that the user's request to subscribe has been 
processed. An email is sent to confirm this status.

Confirm 
Unsubscribe to 
List

Summary Indicates that the user's request to unsubscribe has been 
processed. An email is sent to confirm this status.

Confirmed Description Contains Attendee Status and Event Name. Indicates that 
the contact or prospect confirmed his or her attendance.

Declined 
Engagement

Description Indicates that the user declined participation in the topic.

Declined 
Invitation

Summary Indicates that the user declined the invitation.
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Downloaded Info/
File(s)

Downloaded File Name of the downloaded file.

Subject Subject of the file.

Summary Optional comment.

Email 
Bounceback

Subject Subject of the file

Summary Optional comment

Email Reply Subject Subject of the file.

Summary Optional comment.

Forward to a 
Friend

Comment Allows user to include personal note to friend who is 
receiving the forwarded message.

Email Address Input area for Email address of friend who is receiving the 
message.

First Name Input area for First Name of the friend who is receiving the 
message

Last Name Input area for Last Name of the friend who is receiving the 
message.

Gave Referral Summary Indicates user provided a referral.

Invited Description Contains Attendee Status and Event Name. Indicates that 
the contact or prospect was invited.

No Interest Summary Indicates the user was not interested in topic.

No-Show Description Contains Attendee Status and Event Name. Indicates that 
the contact or prospect did not arrive at the event.

One Click Unsub Summary Indicates that the user's request to unsubscribe has been 
processed.

Pending Description Contains Attendee Status and Event Name. Indicates that 
the contact or prospect is currently in the process of 
registering.

Read Receipt Not applicable An optional response type that requires additional 
configuration to support automatic creation.

Marketers can embed an HTML tag in HTML emails that 
Siebel Marketing can use to count each time the email is 
opened (read). The read receipt tag contains an image 
request. When that image is requested it is interpreted as 
an opened email.

Rejected

Table 40. Response Type Field Values in the Response Details Form

Response Type Field Name Captured Information and Description
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Requested 
Unsubscribe 
Response

Subject Can store the subject line of an inbound email or be edited 
manually.

Summary Contents of the email. Applies only to campaign 
responses.

Time of Day 
(Subscribe by 
phone)

Indicates the respondent�s preference for a time if the 
respondent wishes to subscribe by telephone. Choices are 
Morning, Afternoon, and Evening.

Requested call 
back

Phone # Respondent�s phone number.

Priority Priority level of the callback request. Choices are Urgent, 
High, Medium, and Low.

Summary Stores the comments for a Web-generated response or can 
be edited manually.

Time of day Indicates the respondent�s preference for the time of 
callback. Choices are Morning, Afternoon, and Evening.

Topic Can store the subject line of an inbound email or be edited 
manually. The list of products for which the respondent 
requested a callback appears in the Responses screen, 
Products list.

Requested 
Further 
Engagement

Description Indicates that the user has requested further discussion

Requested more 
info

Comments Stores the comments for a Web-generated response. 
Other comments may be entered manually.

Requested more 
info

Email Email address, if the delivery method is email.

Requested more 
info

Fax Fax number, if the delivery method is fax.

Requested more 
info

Phone Phone number, if the delivery method is phone.

Requested more 
info

Ship Method The preferred method of delivery�direct mail, email, fax, 
or phone�that the customer has specified be used for 
delivery of information.

Requested more 
info

Street Address, 
City, State, ZIP, 
Country

The address to which the information is mailed if the 
preferred delivery method is direct mail.

The list of products for which the respondent requested 
information appears in the Responses screen, Products 
list.

Table 40. Response Type Field Values in the Response Details Form

Response Type Field Name Captured Information and Description
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Requested more 
info

Topic Can store the subject line of an inbound email or be edited 
manually.

Requested 
Unsubscribe

Email, Fax, 
Phone, Direct Mail

The choices are subscribe and unsubscribe.

Respondent 
Interested

Description Indicates that the responder has shown interest in topic.

Respondent 
Purchased

Not applicable This response is not created automatically. You must use 
Siebel Business Process Designer to capture responses of 
this type.

The orders for this purchase are displayed in the 
Responses screen�s Orders view.

Respondent 
unreachable

Summary Optional comment.

Response created 
opportunity

Summary The list of opportunities can be accessed by selecting the 
Responses Opportunities view.

Submitted Source 
Code

Subscribe to List Summary Indicates that the user's request to subscribe has been 
processed.

Unclassified 
Response

Not applicable The response does not fall into one of the main response 
type categories or is a campaign response that requires 
manual processing.

Subject Subject of the email. Applies only to campaign responses.

Summary Contents of the email. Applies only to campaign 
responses.

Unsubscribe to 
List

Summary Indicates that the user's request to unsubscribe has been 
processed.

Waitlisted Description Contains Attendee Status and Event Name. Indicates that 
the contact or prospect has been waitlisted due to 
exceeded capacity.

Walk-in Description Contains Attendee Status and Event Name. Indicates that 
the contact or prospect arrived at the event without 
registration.

Table 40. Response Type Field Values in the Response Details Form

Response Type Field Name Captured Information and Description
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Promoting Responses to Opportunities
If the customer is interested in the product offered by the campaign, you can promote the response 
to an opportunity. If the customer is an existing contact, the account is associated with the 
opportunity. If the customer is a prospect, the customer is promoted to a contact, and then 
associated with an account.

To promote a response to an opportunity

1 Navigate to the Responses screen.

2 In the Responses list, click the Description name.

3 In the Response form, click Create Opportunity button.

The Opportunity form appears, with the response information in the form, and the contact 
information in the Campaign Leads Contacts list.

Creating Automatic Responses from Opportunities and 
Orders
When you create an opportunity in the All Contacts/Prospects view using the Create Opty button, 
Siebel Marketing and Siebel Campaigns create a response record using the Create Auto Response 
business service.

For opportunities, the response is created for each contact added to an opportunity after a campaign 
is associated as an opportunity source. To create the response, associate a campaign with the 
opportunity using the Source field MVG (multivalue group) and then add a contact to the opportunity. 
All responses default to a type of Created Opportunity.

For orders, the response is created whenever a campaign is associated with a sales order. To create 
the response, you associate a campaign with the Sales Order using the Campaign field. All responses 
default to a Type of Respondent Purchased.

Associating an Opportunity with a Campaign
To associate an opportunity to a campaign, you use the Source field on the Opportunity form to select 
the campaign name. Each opportunity can be associated with multiple sources, if appropriate, but 
only one can be designated as the primary source.

When this association is made, the opportunity appears under the Campaign Track Results tab in the 
Opportunities view with the Sourced from Marketing flag checked.

Associating an Order with a Campaign
To associate an order with a campaign, you use the Campaign field on the order form to select the 
campaign name.
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Reviewing and Adding Campaign 
Elements in Campaign Explorer
You can use the Campaign Explorer view in Siebel Marketing and Siebel Campaigns to review 
subcampaigns, contacts, activities, and offers for each campaign. The left pane of this view contains 
an explorer, and the right pane shows the details of the selected campaign.

You can use the detail list to add folder items. For example, to add an activity, you select the Activity 
folder in the left pane, and the Activities list appears on the right. Then, from the list, you add a new 
activity record.

To review campaign elements

1 Navigate to the Campaign Management screen > Explorer view.

2 In the Campaign Explorer, expand the folders for each campaign to display subfolders of 
campaign elements.

3 Click a folder to display detail of the subcampaign, contacts, activities, and offers in the list on 
the right.

To add items to folders

1 Navigate to the Campaign Management screen > Explorer view.

2 In the Campaign Explorer, expand the campaign item to show its folders.

3 Click the folder.

4 In the details list, add a new record and complete the fields.

Process of Loading Customers in 
Campaigns
When you load a campaign, the campaign members are added to the campaign history by loading 
segments and lists (as well as any names added manually using the user interface). For more 
information about segments, read Marketing Segments and Segment Trees on page 33.

The following types of lists are used by Siebel Marketing and Siebel Campaigns:

■ External lists. You can import purchased or rented lists into your application using List 
Management. When you use List Management with Siebel Data Quality you can scrub lists for 
duplicates during the import process. For more information, read Process of Importing and 
Managing External Lists on page 180.

■ Internal lists. You can also use List Management to maintain lists created from records that 
already exist in your contacts or prospects databases. For more information, read Process of 
Creating and Managing Internal Lists and Subscription Lists on page 193.
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■ D&B lists. D&B lists are generated from D&B libraries of companies based on criteria you define. 
The D&B module provides a library of incorporated businesses that you can market to. Using the 
D&B screen you can create a list of D&B contacts to use in your campaign. For more information, 
read the chapter about D&B in Applications Administration Guide. Reviewing and Adding 
Campaign Elements in Campaign Explorer. For more information on integrating List Management 
with D&B, read Integrating List Management with D&B on page 205.

NOTE: When a campaign has both segments and lists, the segments load before the lists.

To load customers in a campaign, you perform the following tasks:

1 Associating Lists of Prospects or Contacts with Campaigns on page 154

2 Adding Contacts and Prospects to Campaigns Individually on page 156

3 Viewing Campaign Contacts and Prospects on page 157

4 Loading Campaigns on page 157

Associating Lists of Prospects or Contacts with 
Campaigns
This topic discusses associating an imported (or purchased) list and an internal list of prospects or 
contacts with a campaign.

When you associate a purchased list with a campaign, you import the list, and then associate the list 
with a campaign. Prospects are only visible in the Campaign Contacts list if you successfully import 
the purchased list before associating it with a campaign. If contacts or prospects are added to a list 
after you associate that list with a campaign, you need to suspend the wave that did not include the 
new customers and load the campaign again.

CAUTION: If you associate an empty list (a list prepared for import but not yet imported) with a 
campaign and then import the list, the prospects are not associated with the campaign and are not 
visible in the Campaign Prospects list.

After you associate a list with a campaign, the Contact/Prospect List does not immediately display 
data. You must load the campaign before the members are added to the campaign history. The list 
is populated after the Marketing Campaign Load workflow process runs, and you may need to refresh 
the browser view to display the newly associated names. For more information, read Siebel 
Marketing Installation and Administration Guide.

Use the following procedure to associate available imported or internal lists of contacts and prospects 
with your campaigns. Before you associate a list with a campaign, make sure that the Siebel Server, 
the Object Manager component, and Workflow Process Manager component are running.

NOTE: You can only associate active campaign lists with a campaign.

To associate a list of prospects or contacts with a campaign

1 Navigate to the Campaign Management screen.

2 In the Campaign list, click the campaign name.
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3 Select the Design view tab.

4 In the Design link bar, click Segments\Lists.

5 Click the Add List button.

6 In the Add Lists dialog box, select a list, and click OK.

NOTE: When you associate a campaign list with a campaign, contacts in that list are associated 
with the campaign. If you change the campaign list to be inactive or if you delete it, the contacts 
still appear in the Contacts/Prospects list for that campaign.

Troubleshooting the Contact/Prospect List
The Contact/Prospect list may not show contacts or prospects that have been recently associated 
with the list. To resolve the problem, look for it in Table 41.

Table 41. Contact/Prospect List Troubleshooting

Symptom Diagnostic Steps and Cause Solution

The newly 
associated contacts 
or prospects do not 
appear in the 
Contact/Prospect 
List

Marketing Campaign load is not 
yet complete or the browser 
display has not yet been 
refreshed.

Wait for the Marketing Campaign Load 
workflow process to complete and then 
refresh the browser.
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Adding Contacts and Prospects to Campaigns 
Individually
In addition to loading a campaign from segments, lists, or both, you can add individual contacts and 
prospects to a campaign. The ability to add or delete contacts and prospects can be controlled in the 
Execution Options view by using two flags (Enable Contact Editing and Enable Partner Editing of 
Contacts). If these flags are checked, the New and Delete buttons are available. The buttons are 
available in Siebel Campaigns in the Campaign Administration views, but not the other Campaign 
views. For more information, read Process of Setting Up Campaign Execution Options on page 129.

After you add a list of contacts and prospects to a campaign and then load the campaign, these 
contacts and prospects appear in the All Contacts/Prospects view and in the All Contacts/Prospects 
across Organizations view.

You can also add contacts and prospects one at a time. For more information, read Chapter 9, �List 
Management.�

To add a contact or prospect to a campaign

1 Navigate to the Campaign Management screen.

After waiting for the 
Marketing Campaign 
Load workflow 
process to complete 
and after refreshing 
the browser, the 
newly associated 
prospects or 
contacts do not 
appear in the 
Contact/Prospect 
List

None of the campaign waves 
have been launched.

Launch one or more waves, or launch the 
campaign.

None of the customers in the 
campaign meet the search 
specification for the view.

Modify the search specification. Consider 
the following possibilities:

■ Campaigns that are Launched or 
Completed

■ Campaign Wave that is launched

■ The campaign contact record that is 
assigned to the position of the user

■ The campaign contact records that is 
not Marked for Deletion

■ Control Campaign flag = N

■ Contact and Prospect Do Not Call 
Flag = N

The campaign contacts and 
prospects have been assigned to 
a different organization and/or 
position.

In the Campaign Management > Design 
> Execution Options view, check the 
values for Campaign Member Ownership, 
Default Organization Owner, and Default 
Position Owner.

Table 41. Contact/Prospect List Troubleshooting

Symptom Diagnostic Steps and Cause Solution
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2 In the Campaigns list, click the campaign name.

3 Click the Execute view tab.

4 In the Execute link bar, click All Contacts/Prospects.

The list of available contacts or prospects appears, with information on the selected contact or 
prospect record displayed in the Contact or Prospect Details form.

5 To add a contact, click Pick Contacts.

6 To add a prospect, click Pick Prospects

7 In the Pick dialog box, perform one of the following actions:

a Select one or more existing records, and click OK.

b Click New to create a new contact or prospect, then enter the information, and click OK.

8 In the Contacts and Prospects Detail form, complete the fields.

Viewing Campaign Contacts and Prospects
If you have access to the campaign, you can view the assigned contacts and prospects using one of 
the following procedures.

To view marketing contacts and prospects

1 Navigate to the Campaigns screen > Campaigns List view.

2 In the Campaigns list, click the campaign name.

3 In the Execute link bar, click All Contacts/Prospects.

The Contacts/Prospects list appears, showing only the assigned contacts and prospects for that 
campaign.

Loading Campaigns
After you associate your lists, segments, and segment tree cells with your campaign, you can load 
the campaign. Campaigns can be loaded from the Campaign form in any of the Campaign 
Management views or from the Campaigns list.

To load a campaign from the Campaigns screen

1 Navigate to the Campaigns screen.

2 From the Campaigns list, click the campaign name.

3 In the Campaign or Campaign Details form, click the menu button, and choose Load Campaign.

NOTE: The Load Campaign option is active only if your administrator has given you this privilege 
using the Marketing access groups.
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4 In the Load Campaign dialog box, assign the date and time for the load to start, and then click 
OK.

5 Click the Execute view tab to review the load status.

6 In the Execute link bar, perform the following steps:

a To display the history of each wave that has been loaded, click Execution Status.

b To display details of the load process, click System Tasks.

7 Click Refresh to update the load status.

About Reviewing Contacts and Prospects in Active 
Campaigns
Sales people and contact center employees can use the Campaign Members dashboard to review the 
contacts and prospects in active campaigns. The Campaign Member views display a queue of active 
campaign contacts/prospects and a campaign summary, contact and prospect summary.

Campaign Members screen displays the active campaign members according to several levels of 
visibility. Table 42 shows the levels of visibility available.

The Campaign agent views only display campaign members (contacts and prospects) that are in 
active campaigns and for which campaign waves have been launched to the contact center. Any 
waves that have not been launched by a member of the campaign team or administrator do not 
appear.

Table 42. Levels of Visibility in the Campaign Members Screen

Level of Visibility Description

My Campaign Members Displays campaign contacts/prospects that are specifically 
assigned to the employee's position.

All Campaign Members - Outbound Displays campaign contacts/prospects in active, launched 
campaign waves and the campaign members that are 
assigned to the employee's organization. This view does 
not display any members of control campaigns.

All Campaign Members - Inbound Displays campaign contacts/prospects in active, launched 
campaign waves and the campaign members that are 
assigned to the employee's organization. This view 
includes members of control campaigns.
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Using Waves with Campaigns
When you create a campaign, a default wave record is also created. The default record allocates 
100% of the contacts in wave A. If the campaign is part of a marketing program, you set up the 
waves in the Programs screen. For more information, read Setting Up Waves for Campaign Loads on 
page 65.

For stand-alone campaigns, you create waves in the Campaign screen. The delay between waves can 
be defined as hours or days.

To set up multiple waves for a stand-alone campaign

1 Navigate to the Campaigns screen.

2 Click a campaign.

3 Click the Design view tab.

4 In the link bar, click Wave Settings.

5 Add new wave records, using Table 43 as a guide, and save the wave record.

Table 43. Fields in the Campaign Waves Form

Field Comment

Wave Code Enter a wave code, up to 10 characters. You cannot save the record without a 
wave code. The wave code appears as part of the source code for the campaign 
member if you set up the source code format to include it. The wave code for the 
default wave is A.

Description Describe the characteristics of the wave.

Lag The default is 0. Enter the amount of time the wave is delayed after loading a 
campaign. The maximum lag for the waves cannot be greater than number of 
days between the start date and end date of the campaign.

The wave is launched when the server processes the Launch Campaign request.

This server process can be scheduled or can be manually started using the right-
click menu in the Program Flow workspace.

Lag Unit Choose either Hours or Days.

% The default percentage is 100 for a single wave. If you are planning multiple 
waves, first reduce the percentage number in the first wave and enter the 
percentage of contacts that are included in the second wave. The total percent 
values cannot exceed 100%.
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About Previewing and Generating Lists
You can create output lists of contacts for export to a fulfillment partner or another application. Direct 
mail vendors often require specific formatting of campaign lists. When a campaign is ready for 
launching, the target list may be exported according to a flexible list format and distributed using 
FTP or email. You can define, manage, and preview the list format without the intervention of an 
administrator. Default formats can be assigned for each vendor.

You can preview a sample of the list to determine if the output file layout is what you want and then 
generate the actual distribution list that is sent to vendors.

After a list has been generated, the records in it do not change even when the contacts and prospects 
who meet the segmentation criteria change. If you modify the members of the campaign, you should 
regenerate the list files using the latest data.

Lists can be generated manually using the List Distribution view in the Campaign screen or scheduled 
as part of a scheduled launch of a program stage or stand-alone campaign.

Previewing Lists
Prior to launching a campaign, you should check that the list generation works properly. To do this, 
preview the list and inspect how the list data appears in the fields. The preview uses the first 500 
rows of contact data, and these 500 contacts may or may not be in your final generated lists. They 
are used only to model how the list format looks with actual data.

To generate this preview file, your Export List Format should be built so that it exports data from 
same data source where the campaign load data is also extracted. Typically, this is the Siebel Data 
Warehouse or another data mart or data warehouse where the segment members are extracted 
during campaign load.

To generate a preview list

1 Verify that an export list format exists and meets the requirements stated in this section.

2 Navigate to the Campaigns screen, and in the Campaign list, click the campaign name.

3 Click the Execute view tab, and in the Execute link bar, click List Distribution.

4 Select either List Export or Email Personalization as the type of list format.

5 If you selected Email Personalization, select an Email offer in the Offer field.

6 If you select List Export, then create a new record in the Vendor list.

a Using the Vendor select button, select a vendor.

b Using the Export List Format select button, select one or more export list formats. Be sure to 
select an appropriate list format type for the type of channel (direct mail, email, and so on).

NOTE: Select the list format that you created in Step 1 from the folders.

7 Click Generate Output Lists to generate the preview file.

8 In the dialog box, select one or more waves, and then click OK.
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a Give the server a few minutes to process the job, and then click the Refresh button in the 
Generated Lists applet. 

b (Optional) To monitor the job, click System Tasks in the Execute link bar.

When the file is created, it appears in the Generated Lists list. If the list format has splits set up in 
the formatting, multiple files appear in the list. Refer the Content Description column to view details 
about the file contents. Drill on the list name to open it, or save it to your computer.

Manually Generating Campaign Lists
The following procedure explains how to manually generate a list for a campaign.

To generate a list for a campaign

1 Navigate to the Campaigns screen, and in the Campaign list, click the campaign name.

2 Click the Execute view tab, and in the Execute link bar, click List Distribution.

3 Click New to create a new list distribution entry.

4 Select a vendor.

If the vendor has a default list format, that format name appears in the Export List Format field.

5 Click the Export List Format select button.

6 In the Pick Export List Format dialog box, select your list format from the folders.

7 Click Generate Output Lists to generate the file.

8 Give the server a few seconds or minutes to process, and then click the Refresh button in the 
Generated Lists applet. 

If desired, use the System Tasks view under Execute tab to monitor the job.

When the file is created, it appears in the Generated Lists list. If the list format has splits set up 
in the formatting, multiple files appear in the list. Refer the Content Description column to view 
details about the file contents. You can click the list name to open it, or save it to your computer.
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8 Launching Programs and 
Campaigns
You can create output lists of contacts for export to a fulfillment partner or another application. Direct 
mail vendors often require specific formatting of campaign lists. When a campaign is ready for 
launching, the target list may be exported according to a flexible list format and distributed using 
FTP or email. You can define, manage, and preview the list format without the intervention of an 
administrator.

This chapter contains the following sections:

■ About Launching Programs and Campaigns on page 163

■ Process of Launching Campaigns on page 164

■ Process of Using the Schedule Calendar View on page 167

■ Displaying Campaign Charts in Siebel Campaigns on page 170

■ Process of Displaying Response Charts in Siebel Campaigns on page 175

About Launching Programs and 
Campaigns
When you launch a campaign, the Server Request Broker starts the Marketing Campaign Launch 
workflow process. This process sends contact list files to specified vendors, most commonly using 
FTP (file transfer protocol), and email offers are sent to targeted recipients.

You can launch a marketing program in the following ways:

■ Launch a campaign manually. You can launch a campaign using the campaign form menu in 
any of the campaign views or by right-clicking on the campaign object in the program flow. For 
more information about manual execution, read Launching Campaigns Manually on page 164.

■ Launch a program stage automatically. You can schedule a stage of a program to launch 
automatically (including all the campaigns in the stage) from the Program screen. In the 
Schedule view tab, click the Calendar link. For more information about automatic execution, read 
Process of Using the Schedule Calendar View on page 167.

■ Launch a campaign automatically. You can schedule a campaign to launch automatically from 
the Campaign screen. In the Schedule view tab, click the Calendar link. For more information 
read, Process of Using the Schedule Calendar View on page 167.

You launch email campaigns through the Siebel Email Marketing Server. Export list files, wireless 
offers, and faxes are distributed through the Siebel Communication Server. Make sure that your 
Email Marketing Server and Communication Server are online so that the launch completes 
successfully.
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When you launch a campaign, you must know which campaign wave or waves you want to launch, 
especially if your campaign is a recurring campaign. In most cases, the wave you want is the most 
recent wave. However, when you launch the campaign, make sure that you select the correct wave 
from the Launch Waves dialog box.

NOTE: On the Marketing Server component, a parameter called Wave Batch Size determines the 
number of subwaves created. Each subwave creates a new request or thread to the email sending 
daemon.

For email campaigns, the Email marketing server can process parallel tasks for improved scalability.   
To enable the generation of email files for each thread, be sure to split the Email Server list format 
correctly.

Process of Launching Campaigns
You may choose to manually launch one or more waves of a campaign. You can launch a campaign 
using the applet menu on the campaign form in any of the campaign views or by right-clicking on 
the campaign in the program flow.

To launch a campaign, perform the following tasks:

■ Launching Campaigns Manually on page 164

■ Launching Email and Fax Campaigns on page 165

■ Checking Campaign Launch Status on page 166

■ Suspending and Relaunching Email Campaigns on page 166

Launching Campaigns Manually
Before launching a campaign manually, make sure you have performed the following tasks:

■ Add a position to the marketing Administrators Access Group. The position of the person who 
launches the campaign must be a member of the Marketing Administrators access group. If the 
position is not part of this access group, the launch buttons are unavailable. For instructions, read 
Siebel Marketing Installation and Administration Guide.

NOTE: This requirement also applies to a partner using the Siebel Partner Portal.

■ In the Campaign List Distribution view, set up vendors and export list formats.

■ Load any segments, segment tree cells, and lists that you plan to use into the campaign history.

■ If you plan to send offers that use a distribution profile, test the campaign to make sure that the 
profile is set up correctly and that offer is sent with expected results. For more information on 
testing campaigns, read Testing Campaigns on page 142.

You may choose to manually launch one or more waves of a campaign. You can launch a campaign 
using the applet menu on the campaign form in any of the campaign views or by right-clicking on 
the campaign in the program flow.
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After performing tasks in Launching Campaigns Manually on page 164 you are ready to launch the 
campaign. Launching a campaign calls the Marketing Campaign Launch workflow process. After 
launching a campaign, you can check the results by looking at history records for programs, stages, 
and campaigns.

To manually launch campaigns 

1 Navigate to the Campaigns screen, and in the Campaigns list, click the campaign name.

2 From the campaign form menu, choose Launch Campaign.

The Launch Campaign Dialog Box contains the valid waves that are available for launching. 
Waves with a status of Loading, Load Failed, Scheduled, Launched, Purged, or Purge Failed do 
not appear.

3 In the Launch Campaign dialog box, select one or more waves to launch, and click OK.

Launching Email and Fax Campaigns
If you have tested your email or fax campaign, and the results are satisfactory, you are ready to send 
the email offers to campaign recipients.

To send email and fax offers

1 Navigate to the Campaign Management screen.

2 In the Campaigns list, select the campaign.

3 Click the campaign name.

4 Click the Design view tab.

5 In the Campaigns form, click the menu button, and choose Launch Campaign.

6 In the Launch Waves dialog box, select a wave to launch, and click OK.

Understanding the Marketing Campaign Launch 
Workflow Process
When you launch a campaign, the Marketing Campaign Launch workflow process initiates. For more 
information about workflow processes, read Siebel Business Process Designer Administration Guide.

Siebel Marketing sends the exported list file to each vendor in the List Distribution list of the Waves 
view, using distribution adapters and profile information. For example:

■ Email. Siebel Marketing emails the exported list file to the vendor�s primary contact.

■ FTP. Each vendor has a profile specifying the host name, user name, and password. Siebel 
Marketing sends the exported list file using File Transfer Protocol to the vendor�s FTP server.
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For each wave, the server receives a request to send each valid offer in the campaign on the day the 
program is executed, adding to that date any lag days defined in the wave. Only those contacts or 
prospects assigned to a particular wave receive the offer.

Checking Campaign Launch Status
After you launch a campaign you can check its status and determine if it was successfully launched 
or if it failed.

To monitor campaign launch status

1 Navigate to the Campaigns screen, and in the Campaigns list, click the campaign name that you 
launched.

2 Click the Execute view tab.

3 In the Execute view link bar, click System Task.

4 In the System Tasks list, search for the Campaign Launch and Wave Launch jobs.

Use the Wave # field to find the wave that you launched.

5 In the System Tasks list, click Refresh to update the values in the record.

The Status field has three indicator boxes as shown in the following table. 

6 To display the Task Log list, scroll down.

NOTE: If you cannot view color indicators, refer to Siebel Business Applications Accessibility Guide 
for assistance.

If campaign launch fails, you can display an error log using the Administration - Server Management 
screen�s Tasks view.

Suspending and Relaunching Email Campaigns
A wave of a campaign can be suspended and relaunched in the event of an error or need to roll back 
a wave. For example, if email offers are not delivered because of a setup problem in the Email 
Marketing Server, you can relaunch the wave to resend the offers.   Also, if you launch a wave into 
the call center, you can recall the wave so that it no longer appears to sales agents until the wave is 
relaunched.

Position Color Meaning

1 Red An error occurred. The error message appears in the System Tasks and Task 
Log lists.

2 Yellow Pending. The launch has not yet completed.

3 Green The launch completed successfully with no errors.
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To suspend a campaign wave

1 Navigate to the Campaigns screen.

2 In the Campaigns list, click a campaign name.

3 Click the Execute view tab.

4 In the Execute link bar, click Execution Status.

5 Locate the Wave with a Launched or Launch Failed status.

Use the Wave # field to confirm that you are displaying the correct wave.

6 To suspend the wave, select the wave record and click Suspend Wave.

7 After the wave is suspended, Suspended appears in the Status field.

Make the necessary corrections, and then relaunch the campaign wave.

To relaunch a suspended campaign wave

1 Navigate to the Campaigns screen.

2 In the Campaigns list, select a campaign to relaunch.

3 Click the Execute view tab.

4 In the Execute link bar, click Execution Status.

5 Locate a wave to relaunch.

Use the Wave # field to confirm that you are displaying the correct wave.

6 In the Wave list, select the wave record, and click Launch Wave.

Launching a suspended wave resends any email offers, wireless offers, and vendor list files. It 
also causes the campaign members in the wave to reappear in the call center.

To identify and resend failed emails

1 Navigate to Administration-Communications > Outbound Request Overview.

2 Using the Description and Request # fields, locate your email campaign.

3 If the Status does not indicate successful completion, check the Status Message field to 
determine the cause.

4 After you have resolved the cause, resend the failed emails by clicking Submit.

Process of Using the Schedule Calendar 
View
When you complete a program design using Program Flow, you can schedule a stage of the program 
for execution using the Schedule calendar view.

To use the schedule calendar view, perform the following tasks:
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■ Scheduling a Stage Execution on page 168

■ Scheduling the Execution of Campaigns on page 169

■ Understanding the Marketing Campaign Launch Workflow Process on page 165.

Schedule Calendar View
When you complete a program design using Program Flow, you can schedule a stage of the program 
for execution using the Schedule calendar view. During automatic program execution, the Campaign 
Load and Marketing Campaign Launch workflow processes run for each campaign in the stage. If the 
stage is recurring, when the run of the stage is completed, it reschedules itself for the next run. For 
more information about workflow processes, read Siebel Business Process Designer Administration 
Guide.

The Schedule view displays the details of the selected program in the Program form at the top and 
a calendar at the bottom.

Scheduling a Stage Execution
Use the following procedure to schedule stages of a program for automatic execution.

To schedule the execution of a stage

1 Navigate to the Programs screen.

2 In the Programs list, click the program name.

3 Click the Schedule view tab.

4 In the Calendar view, click the calendar icon for the date that the program starts.

5 In the activity form, complete the fields using Table 44 on page 168 as a guide.

6 Select the Active Flag so that the scheduling takes effect.

If you select the active flag, the stage executes as soon as the activity time arrives. If you do 
not select the active flag, no execution occurs.

7 Click Save This One when you are ready to save the schedule.

The stage name and launch time appear in the Schedule calendar. The calendar also reflects any 
recurrence of the stage.

Table 44. Activity Fields for a Stage Execution

Field Comment

Comment Enter more information about the program schedule, if desired.

Description This field displays the previously added program description. Enter more 
information if desired.
Siebel Marketing User Guide Version 7.8, Rev. A168 



Launching Programs and Campaigns ■ Process of Using the Schedule Calendar View
To edit the schedule

1 Navigate to the Programs screen.

2 In the Programs list, click the program name.

3 Click the Schedule view tab.

4 In the Schedule�s calendar, click the program name.

Make sure the Active Flag is still checked so that execution occurs.

5 In the Schedule form, make changes, and click Save This One.

To delete a schedule

1 Navigate to the Programs screen.

2 In the Programs list, click the Schedule view tab.

3 In the Schedule�s calendar, click the program name to open the Schedule form.

4 Click the menu button, and choose Delete This One.

If the stage repeats over time, you are asked if you want to delete a single instance or every 
repeating instance.

Scheduling the Execution of Campaigns
Campaigns can be created and set up to execute according to a schedule.

CAUTION: Do not perform this procedure if you already plan to schedule the parent stage for the 
same campaign. Doing so causes the campaign to be launched twice.

Frequency If the program is repeating, choose the repeat cycle from the list. Options are 
Daily, Weekly, Monthly, Quarterly, and Yearly.

Planned 
Completion

The default value in this field is the program�s end date. Click the calendar select 
button, use the calendar controls to set the date and time.

Planned Start The default value in this field is the program start date. Click the calendar select 
button, and use calendar controls to set the start date and time for program 
execution.

Stage (Required) You must select the stage of the program that should execute.

Type (Required) The Type field displays Stage Execution as the default. If Stage 
Execution does not appear in the field, select it from the list.

Until If the stage repeats over time and you want to delete every repeating instance, 
choose Delete All.

Table 44. Activity Fields for a Stage Execution

Field Comment
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To schedule the execution of a campaign

1 Navigate to the Campaigns screen, and in the Campaign list, click the campaign name.

2 Select the Schedule view tab.

3 In the Schedule calendar, click the calendar icon in the day that the campaign starts.

4 In the activity form, in the Activity Type field, select Campaign Load and complete the remaining 
fields using Table 44 on page 168 as a guide.

NOTE: Be sure to check the Active Flag for the scheduling to take effect. If the active flag is set, 
the campaign load launches as soon as the activity time arrives. If the active flag is not set, no 
execution occurs.

5 Click Save This One when you are ready to save the schedule.

The campaign name and load time appear in the Schedule calendar. The calendar also reflects 
any recurrence of the activity.

6 Click New to create another activity.

7 In the activity form, in the Activity Type field, select Campaign Launch, and complete the 
remaining fields using Table 44 on page 168 as a guide.

Make sure to set the start time of the campaign launch activity so that the preceding campaign 
load activity completes before the corresponding campaign launch begins.

8 Verify that the Active Flag is set so that the scheduling takes effect.

9 Click Save This One when you are ready to save the schedule.

The campaign name and launch time appear in the Schedule calendar. The calendar also reflects 
any recurrence of the activity.

Displaying Campaign Charts in Siebel 
Campaigns
Only Siebel Campaigns uses Campaign charts, and you use these charts to review performance and 
graphically display results in a chart for areas such as incentive compensation, completed calls, lead 
quality by campaign, and so on. When you display a chart, the saved query in the upper-right corner 
filters the information shown in the chart.

To display charts in Siebel Campaigns, perform any of the following tasks:

■ Displaying Campaign Achievement Charts on page 171

■ Displaying Call Status Analysis Charts on page 171

■ Displaying Call Status Analysis by Employee Charts on page 172

■ Displaying Lead Quality Analysis by Campaign Charts or Response Charts on page 172

■ Displaying Opportunity Revenue Analyses on page 173

■ Displaying Order Revenue Analysis Charts on page 174

■ Displaying Campaign Trend Analyses on page 174
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Displaying Campaign Achievement Charts
The Campaign Achievement chart displays the results of the Sales Quota Plan set up for each 
campaign. The chart represents the percentage achievement of quota for each campaign and applies 
Incentive Compensation functionality to campaigns.

To prepare for generating the Campaign Achievement charts.

1 Create a quota plan, and associate quota plan objectives and participants with the plan.

Quotas are discussed in Creating Campaign Quota Plans on page 135. For more information, read 
Siebel Incentive Compensation Administration Guide.

2 Enter achievement values by performing these tasks:

a Navigate to the Sales Quotas screen.

b In the Quota Achievement list, select the quota plan.

c Enter the amount you achieved compared to quota numbers.

You can add Achievements manually or by using a workflow process that completes 
achievements based on actions in Siebel Call Center.

You can display the Campaign Achievement Chart from the Achievement Analysis view of the Sales 
Quota screen or the Charts view of the Campaigns screen.

To display Campaign Achievements in Siebel Campaigns

1 Navigate to the Campaigns screen.

2 In the Campaigns link bar, select Charts.

3 In the drop-down list, select Campaign Achievements.

4 In the Objects Against Achievement list, select the plan name.

5 In the By drop-down list, select Campaign Name or Objective Name.

6 Select the chart type from the third drop-down list.

7 Click Go to display the chart.

Displaying Call Status Analysis Charts
The Call Status Analysis chart displays the number of calls that have been completed compared to 
the number of calls that have not been completed for each campaign. This chart can be used by a 
call center manager to determine which campaigns are lagging and where to shift resources.

To update the Call Status field

1 Assign any contacts and prospects you are contacting to the campaign.

For more information, read Adding Contacts and Prospects to Campaigns Individually on page 156.
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2 After each contact or prospect is called, update the status in the Call Status field in the Contacts 
or Prospects list or form.

The chart is based on information from this field. A Call Completed flag indicates that the call is 
completed and the number of contacts and prospects targeted by the campaign.

Displaying Call Status Analysis by Employee Charts
The Call Status Analysis by Employee chart displays completed and uncompleted calls by a specified 
employee for each campaign. The values for this chart may be derived from lists of contacts and 
prospects assigned to the position and the Calls Completed field for the contact or prospect record 
in the Contacts or Prospects view.

A campaign list can be associated with a position. When such association occurs, the position 
becomes the owner of the Campaign Contacts or Campaign Prospects. If the OwnerID is assigned, 
then only the employees of that position can display the Campaign Contacts or Prospects for a 
particular campaign. If the list is not assigned, then the OwnerID is NULL and any employee assigned 
to the Campaign Team or Campaign Group can display the Contacts or Prospects view.

To prepare for generating the Call Status Analysis by Employee chart

1 If the employee position is evaluated based on lists of contacts and prospects, assign the lists to 
the position in the Campaign Lists view.

The position becomes the owner of the list�s contacts and prospects.

When you associate a list with a campaign, if the Position field is not empty, then the OwnerID 
or each contact or prospect in that list is associated with that position.

Most companies do not assign the contacts or prospects to a position, so the OwnerID is NULL. 
In such cases, the chart shows only one employee: Unknown.

2 Update call status in the Campaign Contacts view.

The chart draws its values on which contacts have been called based on the Done flag in the Call 
Status field. Make sure this field reflects the current status of the call.

Displaying Lead Quality Analysis by Campaign Charts or 
Response Charts
The Lead Quality Analysis by Campaign chart displays the opportunities that have been created for 
the campaign when the Response Type is set to Opportunity. Using this chart, you can display 
opportunities by number of opportunities, by total opportunity revenue, or by average opportunity 
broken out by lead quality.
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To prepare for generating the Lead Quality Analysis by Campaign chart

1 In the Campaigns list, click the campaign name, click the Responses view tab, and verify that 
the Response Type field is set to Opportunity.

2 In the Opportunities screen, for each opportunity created for a campaign, make sure values are 
entered in the Lead Quality, Revenue, and Source fields.

You can use the My Opportunities or All Opportunities views to display the opportunities you need 
to check.

The Lead Quality by Response chart displays the opportunities that have been created for a campaign 
when the campaign�s Response Type is set to Response. The chart displays opportunities by number 
of opportunities, by total opportunity revenue, or by average opportunity broken out by lead quality.

To prepare for generating the Lead Quality by Response chart

1 In the Campaigns list, make sure the Response Type is set to Opportunity.

The Response Type field is in the Response�s view tab, after drilling down on the campaign name.

2 In the Opportunities screen, make sure that the Revenue, Lead Quality, and Source fields are 
completed for each opportunity.

Displaying Opportunity Revenue Analyses
You can display opportunity revenue analyses on two charts:

■ Opportunity Revenue Analysis Chart

■ Opportunity Revenue Analysis by Employee Chart

Opportunity Revenue Analysis Chart
The Opportunity Revenue Analysis chart displays the campaign�s Number of Opportunities and the 
Expected Revenue for those Opportunities. The left axis is Opportunity Revenue and the bar chart 
corresponds to Revenue. The right axis is the Number of Opportunities and the line chart corresponds 
to Revenue.

When using the chart, Opportunity Revenue Analysis by Campaign, only campaigns set to response 
type Response are used to create the chart.

This chart displays the relationship between the amount of revenue and the number of opportunities 
for campaigns. For example, a campaign administrator may use the chart to identify campaigns that 
are generating a high volume of opportunities but have a low potential for revenue and campaigns 
which generate a smaller number of opportunities but have a higher potential revenue per 
opportunity.

Before generating the chart, navigate to the Opportunities screen and make sure that the Revenue 
field contains a value for each opportunity associated with the campaign.
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Displaying Opportunity Revenue Analysis by Employee Charts
The Opportunity Revenue Analysis by Employee chart shows the number of Opportunities and the 
potential revenue for opportunities for each employee. This chart displays information in the same 
way as the Opportunity Revenue Analysis chart, but it targets employees in the analysis.

To prepare for generating the Opportunity Revenue Analysis by Employee chart

1 Navigate to the Opportunities screen.

2 Select an opportunity associated with the campaign.

3 Make sure that the Revenue contains a value.

4 In the Sales Team field, enter the User ID of the agent generating the opportunity.

Displaying Order Revenue Analysis Charts
The Order Revenue Analysis Chart shows the total revenue for orders generated by campaign. Before 
you can create this chart, you must verify that an order is associated with a response. If it is not, 
you can associate it using the following procedure.

To associate an order to a response

1 Navigate to the Campaigns screen.

2 Select a Campaign with the Response Type set to Response.

NOTE: This chart only shows data for campaigns with Response Type set to Response.

The Response Type field is in the Response�s view tab, after drilling down on the campaign name.

3 Click the campaign name.

4 Click the My Contacts/Prospects view tab.

5 Click Create Response.

6 For this response, click the Orders tab, and create a new record.

7 Click the Order number to enter details for the order.

Displaying Campaign Trend Analyses
You can display campaign trend analyses using two charts:

■ Campaign Trend Analysis Chart

■ Campaign Trend Analysis by Employee Chart
Siebel Marketing User Guide Version 7.8, Rev. A174 



Launching Programs and Campaigns ■ Process of Displaying Response Charts in Siebel
Campaigns
Displaying a Campaign Trend Analysis Chart
The Campaign Trend Analysis chart displays the total number of responses for each campaign over 
a period of time. The period can be set to day, week, month, quarter, or year.

Before generating the chart, review responses for each campaign by navigating to the Campaigns 
view, selecting the campaign, and clicking the Responses view tab.

Displaying a Trend Analysis by Employee Chart
The Campaign Trend Analysis by Employee chart displays the total number of responses generated 
by each employee across campaigns over a period of time. The period can be specified by day, week, 
month, quarter, or year. 

To verify that each response is associated with an employee

1 Navigate to the Campaigns screen.

2 In the Campaigns list, click the Name.

3 Click the Track Results view tab.

4 In the Track Result link bar, click Responses.

5 Review the list of responses, making a note of the description and user.

6 Navigate to the Responses screen.

7 For each response you found in Step 5, make sure that the Created By field contains the User ID 
of the employee who handled the response and, therefore, owns it.

Process of Displaying Response Charts 
in Siebel Campaigns
Siebel Marketing and Siebel Campaigns include response charts. Use response charts to analyze 
response to your campaigns in areas such as opportunities, revenue, campaign offers, and so on. 
When you display a chart, the saved query in the upper-right corner filters the information shown in 
the chart.

To display response charts in Siebel Campaigns, perform the following tasks:

■ Accessing the Response Charts on page 176

■ Displaying the Campaign Analysis (Response) Charts on page 176

■ Displaying the Opportunity Analysis (Response) Charts on page 176

■ Displaying the Offer Analysis (Response) Charts on page 177

■ Displaying the Offer Type Analyses (Response) Charts on page 177

■ Displaying the Revenue Analysis (Response) Charts on page 178

■ Displaying the Average Opportunity Revenue Analysis (Response) Charts on page 178
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Accessing the Response Charts
Response charts analyze the response to your campaigns in areas such as opportunities, revenue, 
campaign offers, and so on.

To access Response charts

1 Navigate to the Responses screen > Charts view.

2 In the Charts view use the visibility filter to select the type of data to display.

3 In the drop-down list below the Show field, select the type of chart, and click Go.

To change the type of chart, select a different type, and click Go.

Displaying the Campaign Analysis (Response) Charts
The Campaign Analysis chart displays the total number of responses for each campaign. Before you 
can create this chart, you must verify that the response is associated with a campaign. If it is not, 
you can associate it using the following procedure.

To associate the response to a campaign

1 Navigate to the Responses screen.

2 In the Campaign Name field, associate the response with a campaign.

Displaying the Opportunity Analysis (Response) Charts
The Opportunity Analysis chart displays the total number of opportunities created for each campaign, 
based on the Source field in the opportunity record. Before you can create this chart, you must verify 
that opportunities have been created for the campaign.

If no opportunities have been created for the campaign, you can create them using the following 
procedure.

To verify the opportunities are created

1 Navigate to the Responses screen.

2 For each response to your campaign, verify that opportunities are created (if applicable).

To create an opportunity for the campaign

1 Select the response record in the Responses list.
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2 In the Response form, click Create Opportunity.

An opportunity is created for the campaign and the campaign name is entered in the Source field 
for the opportunity.

Displaying the Offer Analysis (Response) Charts
The Offer Analysis chart shows the total number of responses per offer based on the offer associated 
with the response. Before you can create this chart, you must verify that the correct offer is 
associated with the response.

To verify the correct offer is associated with the response
Perform the following tasks before generating the chart:

1 Navigate to the Responses screen.

2 For each response to campaigns featuring the offer, make sure the correct offer is associated with 
the response by reviewing the response record�s Offer field.

Displaying the Offer Type Analyses (Response) Charts
You can display offer type analyses (response) through two different charts:

■ Offer Type Analysis (Response) Chart

■ Offer Type Analysis (Response) by Campaign Chart

Displaying Offer Type Analysis (Response) Charts
The Offer Type Analysis chart displays the total number of responses for each offer type across all 
campaigns. Before you can create this chart, you must verify that the offer is identified for the 
response.

To verify the offer is identified for the response

1 Confirm that each offer associated with the campaign has an offer type and offer name specified. 
For more information about finding or completing these fields, read Creating, Modifying, and 
Associating Products with Offers on page 72.

2 Add the responses received during the campaign.

The offer is identified for the response in the Offer Name field.

3 Generate the chart, using the procedure on Process of Displaying Response Charts in Siebel 
Campaigns on page 175.
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Displaying Offer Type Analysis (Response) by Campaign Charts
The Offer Type Analysis by Campaign chart displays the total number of responses per offer type for 
each campaign. Each campaign can have many offers.

To generate the Offer Type Analysis by Campaign chart

1 Confirm that each offer associated with the campaign has an offer type and offer name specified. 
For more information about finding or completing these fields, read Creating, Modifying, and 
Associating Products with Offers on page 72.

2 Confirm that the offers you want in the chart have been added to the campaign. For more 
information about this procedure, read Associating Offers with Campaigns on page 123.

3 Add the responses received.

4 Generate the chart, using the procedure on Process of Displaying Response Charts in Siebel 
Campaigns on page 175.

Displaying the Revenue Analysis (Response) Charts
The Revenue Analysis (Response) chart displays the total revenue for each campaign and the total 
number of opportunities for each campaign. The bar chart shows the revenue by campaign and the 
line graph shows the number of opportunities for each campaign.

Values for this chart are derived from the Revenue and Source fields in the Opportunity screen�s My 
Opportunities or All Opportunities list. The revenue number is derived from the sum of the Revenue 
fields in the Opportunity records, with the Source field set to the campaign name. Before generating 
this chart, make sure to complete these fields for opportunities used in this analysis.

Displaying the Average Opportunity Revenue Analysis 
(Response) Charts
The Average Opportunity Revenue Analysis chart displays the average revenue for each campaign. 
For each opportunity created for the campaign, the revenue is added and the average is taken across 
opportunities created for the campaign.

Values for this chart are derived from the Revenue and Source fields in the Opportunity screen�s My 
Opportunities or All Opportunities list. The revenue number is derived from the average of the 
Revenue fields in the Opportunity records, with the Source field set to the campaign name. Before 
generating this chart, make sure to complete these fields for opportunities used in this analysis.
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Use List Management to create and manage lists of contacts and prospects within applications for 
use in marketing campaigns.

This chapter contains the following sections:

■ Siebel List Management Module on page 179

■ Process of Importing and Managing External Lists on page 180

■ Process of Creating and Managing Internal Lists and Subscription Lists on page 193

■ Promotion of Prospects to Contacts on page 198

■ Process of Viewing and Maintaining Lists on page 201

■ Integrating List Management with D&B on page 205

Siebel List Management Module
The List Management module is available to users with a license for Siebel Marketing or Siebel 
Campaigns.

NOTE: The Siebel Campaigns module can be added to any base application, including Siebel Sales, 
Siebel Call Center, and Siebel PRM.

Use List Management to create and manage lists of contacts and prospects within your applications 
for use in marketing campaigns. A list in Siebel Marketing is a grouping of contact or prospect records 
in the Siebel database.

Contacts are customers already in the Siebel database. Prospects are potential customers that have 
yet to be screened, qualified, and promoted to contacts. By using this distinction, List Management 
can eliminate prospects that do not qualify for promotion to contacts.

For example, you rent a magazine subscriber list containing 1,000 names and addresses. You want 
to contact these people, but because the list is rented, you may not add the records into your Siebel 
database as contacts unless they become customers generating revenue. You must be able to 
remove the names from your database when you return the list. Use Siebel List Management to 
identify these names and addresses as temporary prospects until they can be promoted to contacts.
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Process of Importing and Managing 
External Lists
External lists are created by importing an external file into your application using the List Import 
utility. Imported lists can come from any source, as long the list can be saved in one of the supported 
file formats, including Comma Separated, Tab Delimited, and Fixed Width. Common examples of list 
sources include rented or purchased lists from marketing bureaus, registration lists from trade shows 
or events, and output lists from other applications.

When you integrate Siebel Marketing or Siebel Campaigns with Siebel Data Quality (optional 
module), incoming records can be cleansed and matched against existing contacts and prospects in 
the database. This additional process helps prevent creation of duplicate records for incoming 
prospects that are already contacts. For more information about Siebel Data Quality, read Siebel 
Data Quality Administration Guide.

To import and manage external lists, perform the following tasks:

■ Verifying Preinstallation Requirements on page 180

■ Creating Records for Importing External Lists on page 184

■ Matching Approach and Match Resolution on page 184

■ Selecting Matching Approach and Match Resolution on page 185

■ Mapping External List Columns to Database Columns on page 186

■ Maintaining Attributes for List Records on page 189

■ Mapping Fields on page 190

■ Applying List Import Formats on page 191

■ Displaying Import Status and Error Messages on page 192

Related Topics
■ About Importing External Lists on page 183

■ Launching Import Requests and Tracking the Import Status on page 187

■ Campaign and Response Data on page 188

■ List Import Format Settings on page 191

Verifying Preinstallation Requirements
Before importing a list, you need verify the status of the server components, the data quality 
settings, and the structure of the incoming data.

Verifying Status of Server Components and Tasks
Before importing a list, you need to verify that server components are enabled and that server tasks 
are running.
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To enable server components and run tasks, you use the Administration - Server Configuration 
screen, Components view. For more information, read Siebel System Administration Guide.

Make sure that the following server components are enabled and the following server tasks are 
running:

■ List Import Service Manager: Enabled.

Clicking Launch Import in the List Import view tab of the List Management screen submits the 
import request. The actual import is performed by the List Manager server component on the 
Siebel Server.

■ Server Request Processor: Running.

■ Server Request Broker: Enabled or running.

To import a list, you must be connected to the Siebel Server. If the client cannot detect a running 
Siebel Server at the time you launch the import, you receive a warning message. You can continue 
to submit the import request if you are sure that a Siebel Server is available to handle the request 
later.

For the request to be queued, you must have a Siebel Gateway Name Server running in the 
background. The request is routed through the gateway name server to a Siebel Server that has the 
List Import Service Manager server component enabled. If you do not have a gateway name server 
running, you receive an error message:

Unable to connect to gateway name server.

Verifying Data Quality Settings
When you use the optional Data Quality module, you should verify your settings for the following 
server components before importing files:

■ Data Quality Manager.

■ List Import Service Manager.

■ The object manager for the application in which your users promote prospects. For example, if 
you promote prospects using Call Center, you need to enable the Call Center Object Manager.

If you need to enable a server component, read Siebel Marketing Installation and Administration 
Guide. For more information about data quality configuration, read Siebel Data Quality 
Administration Guide.

To verify the data quality settings

1 Verify that these server components are set to Enabled.

2 Verify the component parameters for these server components are set for deduplication and data 
cleansing.

To enable Data Matching:

a Use the Components view in the Administration - Server Configuration screen and query for each 
of these server components.
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b Click the Component Parameters view tab, query for the DeDuplication parameters, and verify 
that the DeDuplication Enable Flag is set to TRUE.

To enable Data Cleansing during import, query for the Data Cleansing parameters. The Data 
Cleansing Enable Flag should be set to TRUE.

3 Verify the matching threshold for List Import.

The Match Threshold setting in the Data Quality Settings view of the Data Administration screen 
determines if an incoming name is considered a match with existing data. You can specify a 
different threshold for List Import than the rest of the Data Quality module.

CAUTION: Reboot Siebel Server before launching any import tasks so that new parameter 
values take effect. Otherwise, the old parameter values remain in effect.

4 Make sure that you set the Data Quality Settings in the Data Administration screen.

You should generate and refresh the match keys for the existing contact and prospect data before 
importing any files.

To specify a different threshold for List Import

1 Navigate to the Components view of the Administration - Server Configuration screen.

2 Select the List Import Service Manager.

3 Click Component Parameters and query for Dedup Threshold.

4 Set the value to the match score threshold that you want to apply to the List Import utility.

Validating the Structure of the Incoming Data
Some columns for a prospect correspond to an LOV (List of Values) or MLOV (Multilingual List of 
Values) field in the application. Be sure that your incoming data for these columns only use values 
from the LOV or MLOV. Any nonmatching values are set to NULL in the new prospect record.

The date format is set in the Regional and Language Options control panel for the machine on which 
the Siebel Server is running. For date fields, you should make sure you use the correct date format 
that corresponds to the locale settings for your environment.

Common Issues to Check If the Import Is Not Complete
■ Check the license keys.

■ Check that Disable DataCleansing and Disable DeDuplication settings are not selected. These 
settings override those specified in the Server Administration screen. They are specified in the 
Application Administration screen > Data Quality Setting.

■ Check User Preference > Data Quality settings. They override those specified in Application 
Administration.

■ If a key is generated but Siebel Marketing did not find any duplicates, verify if the search type is 
too low and threshold is too high. To change it, use Application Administration-> Data Quality 
Setting.
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■ If you are having troubles updating records with List Import, enter it using the List Management 
screen and check the record�s score. List Import assigns the same score. Check to see if the score 
is below the threshold you normally put (instead of the very low threshold you used for the 
troubleshooting test).

■ Both Real Time DeDuplication and List Import with DeDuplication Enable will insert keys into the 
key tables. Make sure the following new keys are inserted:

■ Account: S_ORG_DEDUP_KEY table. ACCNT_ID column stores the row id of the account

■ Contact: S_PER_DEDUP_KEY table. PERSON_ID column stores the row id of that contact

■ Prospect: S_PRSP_DEDUPKEY table. PRSP_ID column stores the row id of that prospect

■ Batch Key Generate generates keys for old records in the database. If you enable Real Time 
DeDuplication, you do not need to run Key Refresh that often.

■ Make sure you have enabled DeDuplication in the correct Object Manager. The Data Quality 
Manager is only used by Batch mode tasks, it is not the central server for all Real Time 
DeDuplication requests. You should enable Real Time DeDuplication in Call Center, but not Data 
Quality Manager.

■ You cannot match against records that did not have keys generated. You need to run Key 
Generate first if you want to find duplicate records in existing table.

■ Key generation should be run at regular intervals. This is done to refresh the generated keys and 
to include newly added or changed records. Both Batch and Real-Time matching require access 
to the match keys generated by the key generation process.

■ To catch duplicate records for a record entered before DeDuplication was enabled, you should 
run Batch Key Generate which is used to generate keys for old records in the database.

■ If you are using a custom SRF file, test with the standard SRF file.

About Importing External Lists
Lists that you import must be in text (TXT) format. When you import a list, List Management 
performs the following tasks:

■ Loads the list names into the prospects table as individual records.

■ Matches incoming names to existing records and handles the matches according to your 
requirements, based on your settings of Matching Approach and Match Resolution values.

■ Saves and reuses the file structure you develop during the import process by mapping the 
columns of the file.

■ Controls the matching and address cleansing settings applied by Siebel Data Quality (optional 
module).

When the import is finished, the imported list and its associated contacts and prospects display in 
the List Contacts and Prospects list.
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Creating Records for Importing External Lists
Before you import an external list, you must create a record in your application that describes the 
list. This record tells the list import utility what file to import.

To create a record for importing an external list

1 Navigate to the List Management screen > Lists view.

2 In the Lists list, create a new record and complete the fields.

Some fields are described in Table 45.

3 Save the record.

Matching Approach and Match Resolution
You need to specify how you want duplicates handled before importing a list. If Siebel Data Quality 
is not installed or enabled, you can elect to the use the exact match matching approach. If Data 
Quality is enabled, you can use Data Quality (intelligent matching) as the only matching approach 
or you can use Data Quality with exact matching. For more information, read Siebel Data Quality 
Administration Guide. You can choose one of three modes for match resolution, as described in this 
topic.

Table 45. Fields Used to Create a List Record

Field Comments

Data Type List Import attempts to determine the format of the attached text file. Values are:

■ Comma Delimited. If the first row of data in the file contains a comma in any 
of the field values, a best practice is to use tab delimited format to make sure 
that the correct file format is detected.

■ Fixed Width

■ Other Delimited. You can enter another character as the delimiter. If you 
attempt to add >1 character, the value is truncated.

■ Tab Delimited

List Name (Required) This field is populated when you add the record, but you can modify 
the name.

List Type Automatic. The possible values are Imported, Internal and D&B. If Siebel 
Marketing detects an incorrect file type during attachment, you can change it.

Source The company from which the list was purchased. The company must be an 
account record in the Siebel database.
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Reject Import Record Mode
In this mode, if a match is detected by the matching process, any incoming records matching existing 
contacts or prospects are not added as new records in the database. Instead, the matching record 
which already exists in the database is associated with the list. Each skipped record is recorded in 
the List Import log file for reference. If the incoming record matches more than one existing record, 
the record with the highest matching score is added to the list and listed in the list import log file.

Overwrite Existing Record Mode
In this mode, if a match is detected by the matching process, any incoming records can overwrite 
the existing match in the database. The columns that can be overwritten are set by the administrator 
for the List Import Format used by the file. To set which fields are updated by an incoming record, 
navigate to the List Import Formats view in the List Management screen and select the Allow Field 
Updates check box. For reference, the List Import log file records all records that are updated as well 
as the old and new values for any updated fields.

If you use Overwrite Existing Record as the matching approach and an imported field value does not 
match any value on the bounded LOV, then the application does not change the field on the existing 
prospect record (the original value is preserved).

NOTE: Update Existing Duplicates Mode only updates prospect records. It does not update contact 
records.

Create Additional Record Mode
In this mode, matches are detected but the incoming record is added to the database as new 
prospect without changing or overwriting the preexisting record. Using this mode the administrator 
can resolve any matches later on a case-by-case basis or by using the Siebel Data Quality module. 
To resolve duplicates, you can use the Duplicate Prospect Resolution view tab in the Data Quality 
view of the Data Administration screen. In resolve mode, all matches are recorded in the list import 
log file.

NOTE: If the matching process detects a matching contact, the match results do not appear in the 
Data Quality resolution views. This process can only display matching prospects for resolution.

Selecting Matching Approach and Match Resolution
You need to specify how to handle duplicates before importing a list.

To select a matching approach

1 Navigate to the List Management screen > Lists view.

2 In the Lists list, select your list.

Some fields are described in Table 46.

3 Click the list name.

4 Click the List Import view tab.
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5 Select a Matching Approach.

The choices are:

■ Exact Matching Only. This option uses the fields marked as Exact Match Fields in the List 
Import Format and queries for any existing contacts or prospects that exactly match the 
values from the incoming record.

■ Intelligent Matching Only. This option uses the data quality matching service to search for 
matching contacts or prospects.

■ Exact and Intelligent Match. This option uses both exact matching and data quality matching. 
The option first searches for an exact match in the existing contacts and prospects, and then 
uses intelligent matching to search for matches if no exact match is found.

■ No matching. This option disables matching for the import job.

6 In the Match Resolution drop-down list, select an action to apply.

For more details, read Matching Approach and Match Resolution on page 184.

Mapping External List Columns to Database Columns
Every column in the file to import must be mapped to an existing column in the prospects table in 
the Siebel Database or to an attribute created for this purpose. If you import response or campaign 
data, you can also map to response and campaign fields. For more information about mapping 
attributes, read Adding Additional Attributes to a List on page 190.

CAUTION: Make sure that you map every column before launching the import.

To map list columns to database columns in the prospect table

1 Navigate to the List Management screen > Lists view.

Table 46. Fields Used for List Import View

Field Comments

Additional 
Actions

Assign to Campaigns, Responses, or Campaigns and Responses. Used 
whenever the import file contains campaign history or response data 
about contacts and prospects. For more information, read Campaign 
and Response Data on page 188.

Cleanse Data 
During Import

A check box for which the default is off. When this flag is checked, 
incoming records are cleansed by Siebel Data Quality. If your company 
has not licensed Siebel Data Quality, this feature is not functional.

List Import 
Format

Indicates the saved column sequence for the file. Formats can be 
reused across lists. For more information, read Applying List Import 
Formats on page 191.

List Import Mode For descriptions, read Matching Approach and Match Resolution on 
page 184.
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2 Click the list name.

3 Click the List Import view tab.

4 Scroll down to the List Import Format list and map every column to an existing database column 
in the prospect table or to an attribute created for this purpose.

5 In the List Import Format list, save the format in one of the following ways:

a The first time you save a format, click Save as New.

Save as New retains the original format and saves the modified format separately. Saved 
formats appear in the List Management screen�s List Imports Formats view tab.

b Click Save to overwrite the original format.

Use this save option if you make changes to the mappings and want to preserve them.

To verify which database columns are used for matching and update

1 In the form in the List Import view, copy the name of the List Import Format in the List Import 
Format field.

2 In the List Management link bar, click List Import Formats.

3 Query for the name that you copied in the List Import view.

The lower list displays the columns that you mapped from the import file.

4 In the Exact Match Column field, check each column from the list to use for an exact match.

NOTE: These settings are only used when you have selected Exact match or Exact and Intelligent 
match as the matching approach.

5 In the Allow Field Updates field, check the fields to allow to be overwritten when using the 
Overwrite existing record match resolution.

Launching Import Requests and Tracking the Import 
Status
After creating a list record, identifying the Matching Approach and Match Resolution, and mapping 
list columns to database columns, you can import the list and track the status of the request.

To launch a list import request

1 Navigate to the List Management screen > Lists view.

2 Click the list name.

3 Click the List Import view tab.

4 In the List Import form, click Launch Import.
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After you submit the import request, the status field on the List Import list contains a value of In 
Progress. You can refresh this view to track the status of your request. When the import is finished, 
the status field contains a value of Successfully Completed.

There are three methods that can be used to view the status and details of an import job:

■ During the import process, end users and administrators can review the List Import task status 
in the List Management > System Tasks view.

■ Administrators can also view the log details for the List Import server task in the Components 
view in the Server Management Administration screen. In the Component Tasks list, select tasks 
for the List Import Service Manager.

■ Administrators can also review List Import log files.

Campaign and Response Data
List Import can be used to import campaign and Response Data about contacts and prospects. For 
example, your company may run a campaign against a target list of contacts, but it collects the 
responses in an external application or through an outside service company. You can import the 
response results from these sources and attribute the responses to the original campaign.

The List Import view provides the following additional actions that you can select in the Additional 
Actions field to include response and campaign data in the file:

■ Assign to Campaigns. Adds the contacts and prospects in the import file to the campaign 
included in the file. This action does not create any response data.

■ Assign to Responses. Creates response records for the contacts or prospects in the list. The 
action does not add, delete, or modify the set of contacts and prospects already associated with 
the campaign.

■ Assign to Campaigns/Responses. This action takes contacts and prospects records from the 
import file, adds them to the campaign, and creates responses for them.

Campaign and response data is not created unless you select one of these additional actions, even 
if you mapped response or campaign fields. If you do not select an additional action, the import utility 
ignores response and campaign columns and only creates a list of contacts and prospects.

The List Import view includes the following response fields for mapping import data:

■ Offer Code

■ Offer Language

■ Offer Name (required)

■ Response Date

■ Response Description (required)

■ Response Method

■ Response Score,

■ Response Status
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■ Response Type (required)

The List Import view includes the following campaign fields for mapping import data:

■ Campaign Name (required)

■ Campaign Source Code

When mapping, response and campaign fields, be sure to map all the fields required to create a 
response in the application. The import provides some default values you do not include all the 
required fields.

■ If you do not specify Offer Name, the response defaults to the primary offer for the campaign.

■ If you do not specify Response Type, the type defaults to Unclassified Response.

■ If you do not specify Response Description, the type defaults to Imported Response.

If you enable the response business service that performs automatic lookups for Campaign Source 
Code and Offer Code, you can map the Campaign Source Code and Offer Code fields as an alternative 
to Campaign Name and Offer Name. In this case, the import utility performs the lookup and defaults 
to the related Campaign Name and Offer Name. For more information, read About Using Response 
Management on page 143.

NOTE: The Campaign Source Code field in the List Import mappings indicates the source code value 
assigned individually to each Campaign Contact and Prospect. It does not refer to the Source Code 
field in the Campaign record (the field displayed on the Campaign form).

Maintaining Attributes for List Records
Prospects have a predefined set of information fields. These are the standard types of information 
about your prospects that normally include address, phone number, email address, and so on. These 
values are defined in Siebel Tools under the Prospect Business Component.

If the list to import has attributes not contained in the standard prospect table, you can create 
additional attributes to capture the data. After they are created, additional attributes appear on the 
list of available columns that can be mapped in the List Import view.

An additional attribute can contain any type of information, as long as it can be contained in a single 
field and can relate directly to the prospect record. For example, additional attributes may include 
hobbies, special contact information (for example, pager #), product interests, survey responses, or 
demographic attributes.

Creating Additional Attributes for List Records
To make an additional attribute available during list mapping, you must first make sure your desired 
attribute exists and then associate the attribute with the specific list.

To create additional attributes

1 Navigate to the List Management screen > Additional Attributes view.
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2 In the Additional Attributes list, create a new record.

NOTE: The maximum number of additional attributes is 19, and no attribute can map to an 
empty column.

3 In the Additional Attribute field, enter the name of the new attribute.

You can create the overall attribute type, such as Hobby or Pager #.

4 Enter a description for the additional attribute, if needed.

Adding Additional Attributes to a List
After you create the additional attributes needed to capture the data in the list to import, you must 
add them to your specific prospect list and map them to one of the List Import columns.

To add additional attributes to a list

1 Navigate to the List Management screen > Lists view.

2 Click the list name.

3 Click the List Additional Attributes view tab.

4 In the List Additional Attributes list, create a new record.

5 In the Pick Additional Attribute dialog box, select the attribute, and click OK.

Mapping Fields
After you import a list, you must map the fields in the imported list to the fields in the Prospect 
Business Component. When you do this mapping, the values in the list fields are transferred 
accurately into the correct fields in the prospect records.

When there is a dedicated column in the prospect table, you should map fields in the imported list 
to existing fields in the prospects record. Try to avoid mapping fields to additional attribute columns 
in the database extension table. When a value is stored in the main Prospect table, there is more 
flexibility to configure the location where the promoted field value should be mapped on the Contact 
record in the promotion map in the repository. Additional Attribute values can only be promoted to 
Contact Category data.

To map fields when importing a list

1 Navigate to the List Management screen.

2 In the List Management link bar, click Additional Attributes.

3 Query for each attribute to use, and verify that they exist.

4 In the List Management link bar, click Lists.

5 Click a list name and click the List Additional Attributes view tab.

6 To associate attributes with the list, in the attributes list, create a new record.
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7 In the Pick Additional Attribute dialog box, perform the following steps:

a To create new attributes, create a new record, and in the attributes list, enter a name and 
description.

b To associate predefined attributes to the list, select an attribute, and click OK.

8 Associate the attributes with the list using the List Additional Attributes tab.

9 Navigate to the List Import view tab.

10 At the top of each column in the external list, select the appropriate field or attribute to which 
the column should be mapped.

11 Click Save as New.

12 At the top of each column in the external list, select the appropriate prospects record attribute 
to which the column should be mapped.

13 Create additional attributes for columns in your list which have no corresponding Prospect field.

Applying List Import Formats
Before you import a file, you must save the List Import Format (the sequence of columns that 
correspond to your file). The list format name consists of the list name followed by the saved date/
time stamp. For example, My Target List 09/1/2004 12:30:15pm. For more information, read 
Mapping External List Columns to Database Columns on page 186.

To apply an existing List Import Format to your list

1 Navigate to the List Management screen.

2 Click the list name.

3 Click the List Import view tab.

4 In the List Import Formats field, click the select button.

5 In the List Import Formats dialog box, select a format to use. If necessary, perform a query to 
locate the format.

NOTE: You may not be able to apply an existing format to a fixed-width file if the data was originally 
created for comma separated or tab delimited file. For CSV or tab delimited files, the column width 
value defaults to 20, and this value may not match the width of the fixed width file that is being used.

List Import Format Settings
You can administer the precise settings associated with your list import format. If the Import Format 
is to be used in Overwrite Existing Record match resolution, you can specify which columns are 
allowed to be overwritten in the database. The Allow Field Updates column in the lower list indicates 
which columns are set to be overwritten. If the column is checked, that field is overwritten in any 
existing prospect record that matches the incoming record. By default, all columns are unchecked, 
so that no existing information can be overwritten without the administrator�s consent.
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If you are using Exact Match or Exact and Intelligent Match as the matching approach, you need to 
specify the columns that should be used to perform the exact match query.   In the List Import 
Mappings list, check the box in the Exact Match Column column for each list field to be used in the 
exact match query.

For files with a fixed width file type, the server detects the column width and displays the width in 
the List Import Formats view. To display the column width settings, from the visibility filter, select 
List Import Formats and in the List Import Formats list, select the list that relates to your list. If the 
List Import Format was originally created from a comma separated or tab delimited file, the value 
defaults to 20, although the width does not have any effect during the import task.

NOTE: Columns mapped to Additional Attributes cannot be updated in Update Mode. If you check 
Allow Field Updates for this column in the List Import Formats view, the application ignores the 
setting.

List Import can load a text file in one of three types: comma separated, fixed width, and tab 
delimited. For files with a fixed-width data type, you can specify the width of each column. The 
default width is 20. The bottom list displays the column sequence that you have defined in the List 
Import list. Enter the width in the Width field.

Displaying Import Status and Error Messages
When you launch an import task, the List Import list displays the status of the task. The status may 
show any of the following messages: Submitted Import Request, In Progress, Successfully Complete, 
Error, or Completed with Errors.

You can view the detailed results of the List Import task by reviewing the log file from the Siebel 
Server. The log file contains the following information:

■ The status of the file import task (in progress, completed, or error)

■ The number of incoming records

■ The number of records imported

■ Notification of any record that experienced an error

■ Notification of any record that detected a duplicate contact or prospect

■ Notification of any record that was updated (update mode only)

■ Notification of any response record or associated campaign that experienced an error

To view the system task for the List Import job

1 Navigate to the List Management screen > System Tasks view.

2 Query for tasks in which the Process Name is List Import and the User is the user who submitted 
the import job.

3 Sort the tasks by date and find the task for your list import job.

To verify that the task is for the correct file, read the logging messages in the lower list.
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To view the log file for the List Import job

1 Navigate to the List Management screen > System Tasks view.

2 Query for tasks in which the Process Name is List Import and the User is the user who submitted 
the import job.

3 Sort the tasks by date and find the task for your list import job.

To verify that the task is for the correct file, read the logging messages in the lower list.

4 In the lower list, read the Log File field to find the name of the log file.

5 Open the log file using any text processing application.

Process of Creating and Managing 
Internal Lists and Subscription Lists
List Management creates lists of contact and prospect records stored within your applications. 
Internal lists are created within the List Management module by querying existing contact or 
prospect records in the database.

After you have created these lists, you can reuse the list any number of times for campaigns. Lists 
are used by Siebel Marketing and Siebel Campaigns. You can use lists in List Management to serve 
as subscription lists for Email campaign.

To create and manage internal lists, perform the following tasks:

■ Associating Prospect Lists in Siebel Marketing on page 193

■ Creating Internal Lists on page 195

■ Adding Prospects or Contacts to Internal Lists on page 196

■ Creating Lists of Prospects Using Additional Attributes on page 196

■ Creating and Managing Subscription Lists on page 197

Associating Prospect Lists in Siebel Marketing
Marketing campaigns can include prospects in a using one of the following approaches:

■ Associating an internal list of prospects with the campaign.

■ Associating a segment from the Marketing segmentation module where the campaign load list 
format is configured to load the Marketing Prospect integration object.

To associate an internal list with a campaign

1 Navigate to the Campaigns screen > Campaign List view.

2 Click the campaign Name.

3 Click the Design tab.
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4 In the Design link bar, click Segments/Lists.

5 Click Add List to associate an internal list.

To associate more lists, repeat Step 5.

6 After the desired lists are associated, click the menu on the upper campaign form and choose 
Load Campaign to associate the members of the list to the campaign.

7 Pick a time and date for the load request, and click OK.

Marketing campaigns can include prospects in a using one of the following approaches:

■ Associating an internal list of prospects with the campaign.

■ Associating a segment from the Marketing segmentation module where the campaign load list 
format is configured to load the Marketing Prospect integration object.

To associate a segment of prospects with a campaign

1 In the Marketing Module, create a segment. Make sure that the Campaign Load List Format for 
the segment is configured to load data into the Marketing Prospect integration object.

2 Navigate to the Campaigns screen > Campaign List view.

3 Click the campaign Name.

4 Click the Design tab.

5 In the Design link bar, click Segments/Lists.

6 Click Add Segment to associate the segment.

If the segment has never been used in a campaign previously, click Choose a new segment, and 
select the segment from the folder location where you saved it.

7 To associate more segments, repeat Step 6.

8 After the desired segments are associated, click the menu on the upper campaign form, and 
choose Load Campaign to associate the members of the segment to the campaign.

9 Pick a time and date for the load request, and click OK.

Table 47 describes how prospects and contacts can be used in segments associated with campaigns.

Table 47. Scenarios for Using Segments of Contacts and Prospects in Campaigns

Scenario Data Source
Integration 
Object Comments

Segment 
contains only 
contacts

Siebel OLAP or 
Siebel OLTP

Marketing 
Contact

Fully supported. Contacts exist in the Siebel 
transactional database, so data is inserted 
only into the S_CAMP_CON table.

Segment 
contains only 
contacts

Non-Siebel 
database

Marketing 
Contact

Fully supported. New contacts and accounts 
(if mapped) are created in the Siebel 
transactional database.
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Creating Internal Lists
The contacts or prospects you target for each campaign vary depending on the campaign objective. 
For example, you may want to select the contacts who have a certain job title or live in a specific ZIP 
or Postal Code. In another campaign, you may want to combine sets of contacts or prospects that 
were selected by several different criteria into a single list.

You create an internal list of contacts or prospects in the List Management screen using the Contacts 
or Prospects view. You can also use these views to add contacts or prospects to existing lists.

NOTE: To create an internal list, your employee login must have a responsibility associated with it 
that includes the List Management views.

You can reuse lists in any number of campaigns or marketing programs.

To create an internal list of contacts or prospects

1 Navigate to the List Management screen > Contacts or Prospects view.

2 In the Contacts or Prospects list, select the individuals that you would like to include, or perform 
a query to find this information.

3 After you receive the results of your query, you can select any number of the records for inclusion 
in the list.

4 With the desired records selected, click Add to List.

5 In the Pick List dialog box, click Create New List.

6 In the second Pick List dialog box, enter a name for the list, and click OK.

7 In the Pick List dialog box, select the list you created and click OK.

Segment 
contains only 
prospects

Siebel OLAP or 
Siebel OLTP

Marketing 
Person

Fully supported. Prospects exist in the 
Siebel transactional database, so data is 
inserted only into S_CAMP_CON.

Segment 
contains only 
prospects

Non-Siebel 
database

Marketing 
Prospect

Fully supported. New prospects are created 
in the Siebel transactional database.

Segment 
contains contacts 
and prospects

Siebel OLAP or 
Siebel OLTP

Marketing 
Person

Fully supported. Contacts and prospects 
exist in the Siebel transactional database, 
so data is inserted only into S_CAMP_CON 
and S_DD_USER_KEY tables.

Segment 
contains contacts 
and prospects

Non-Siebel 
database

N/A Currently not supported.

Table 47. Scenarios for Using Segments of Contacts and Prospects in Campaigns

Scenario Data Source
Integration 
Object Comments
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8 To display the new list, in the List Management link bar, click Lists.

NOTE: The list type is defaulted to Internal. You can rename the list to give it a more appropriate 
reference name or type at any time.

Adding Prospects or Contacts to Internal Lists
Adding to an existing internal list is similar to creating a new internal list. You can use Add to List to 
attach prospects to a list of type Internal, D&B, or Imported. You can attach prospects from the All 
Prospects list or the Prospects by Attribute list.

To add contacts or prospects to an internal list

1 Navigate to the List Management screen > Contacts or Prospects view.

2 In the Contacts or Prospects list, select the individuals to include or perform a query to find this 
information.

After you receive the results of your query, you can select multiple records for inclusion in the list.

3 With the records selected, click Add to List.

4 In the Pick List dialog box, select the appropriate list, and click OK.

5 To display the new list, in the List Management link bar, click Lists.

6 Select the appropriate list, and click the list name.

7 Click the List Contacts and Prospects view tab to verify that your selected contacts or prospects 
have been added.

Creating Lists of Prospects Using Additional Attributes
You can create lists of prospects by querying the additional attribute data for prospects. For example, 
you may create an additional attribute for hobby and then record these values for many of your 
prospects. For a campaign, you may want to create a list of prospects with certain hobbies, such as 
sailing or painting.

You can create a list of prospects by using the Prospects by Attribute list. In this list, the New Internal 
List and Add to List functions are also available. Query the list of prospects using the appropriate 
attribute and attribute value. Then, select the desired records and either create a new list or add to 
an existing list.

Due to the many-to-many relationship between prospects and attributes, you cannot have multiple 
combinations of attributes and values in a single query. To create of a list that combines queries, for 
example Hobby = Skiing AND Preferred Language = Spanish, perform separate queries, and use the 
Add to List function to combine the results.

To create an internal list of prospects using attributes

1 Navigate to the List Management screen > Prospects by Attribute view.
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2 In the Prospects by Attribute list, select one or more prospects to include in your internal list.

3 With the desired records selected, click Add to List.

4 In the Pick List dialog box, click Create New List.

5 In the second Pick List dialog box, enter a name for the list, and click Save.

6 In the Pick List dialog box, select the list you created, and click OK.

7 To display the new list, in the List Management link bar, click Lists.

To add to an internal list using prospect attributes

1 Navigate to the List Management screen > Prospects by Attribute view.

2 In the Prospects by Attribute list, select the prospects that you would like to include in your 
internal list, or perform a query if necessary.

After you receive the results of your query, you can select any number of the records for inclusion 
in the list.

3 With your desired records selected, click Add to List.

4 In the Pick List dialog box, select the appropriate list, and click OK.

5 To display the new list, in the List Management link bar, click Lists.

6 Select the appropriate list, and click the list name.

7 Click the List Contacts and Prospects view tab to verify that your selected contacts or prospects 
have been added.

Creating and Managing Subscription Lists
You can use lists in List Management to serve as subscription lists for Email campaigns. A 
subscription list is a set of contacts or prospects that have indicated that they wish to receive 
communications about a certain topic. After creating a subscription list, you can associate the list 
with an Email Offer. Any responses to Subscribe or Unsubscribe from List then adds and removes 
members from this list.

Before you can create a subscription list, create an internal list of contacts, prospects, or both using 
one of the following methods:

■ The Add to List button in the List Management views

■ The Create Target List feature (Siebel Industry Applications only)

■ EIM or other custom configuration

To create a subscription list

1 Navigate to the List Management screen > Lists view.

2 Find the list you created.
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3 Change the Type to Subscription.

To associate the subscription to an email offer

1 Navigate to the Offers screen > Email Offers view.

2 Query for an Email Offer with which to associate the list.

3 Click the offer and in the form below, add the subscription list.

Promotion of Prospects to Contacts
When a prospect satisfies a set of screening criteria, he or she can be promoted to become a contact. 
The new contact record contains the same name and address information as the prospect record. 
The additional attribute data associated with the prospect is promoted to categories and category 
values for the new contact.

NOTE: You can have duplicate contacts in the same account. For example, duplicate contacts from 
different companies might belong to the same account.

When you promote a prospect, the application checks for the following items:

■ List Management confirms whether Data Quality deduplication is enabled. If so, the promotion 
matches the prospect against existing contacts. If a match is found, a pop-up window appears 
showing the matching contacts. You can then pick or ignore the matches and proceed with the 
promotion:

■ If the user chooses an existing contact from the pop-up window, the prospect record is 
marked as Promoted and its associations with any campaigns, lists, or responses are linked 
to the selected contact.

■ If the user ignores all matches in the Pop-up Window, the promotion continues as if no match 
was detected.

■ If Data Quality finds no matching contact or Data Quality is not enabled, the promotion checks 
whether the combination of the Account Name and Account site fields matches an existing 
account record.

■ If the combination of the Account Name and Account Site fields match an existing account record, 
one of the following occurs:

■ If the account name exists but the account site is empty, the promotion compares with 
existing accounts that have the same Account Name and Account Site. If an identical account 
exists, the promotion links the contact to the existing account. For the prospect address 
fields, either an update or an insert on the Account Address is performed, based on the 
combination of Street Address, City, and State (Industry Applications also use Postal Code 
as well). If there is not a match with an existing account, a new account is created and the 
prospect personal address becomes the account address.

■ If no account location or account name is specified, an account is not created or associated 
with the promoted prospect. The prospect personal address becomes the contact personal 
address.
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Promoting Single or Multiple Prospects
You can promote a single prospect or multiple contacts, using the Prospects More Info view or the 
views in the List Management screen. You can promote multiple prospects using the Promote Many 
button in some views in the List Management screen. This action promotes any prospects for which 
Data Quality does not find any matches.

CAUTION: Promotion is only intended for promoting relatively small numbers of prospects at one 
time (fewer than 100). If you select more prospects, the process could take many minutes to 
complete. To see the promotion result, you must query repeatedly until the process completes.

Prospects that have at least one matching contact are not promoted when you click Promote Many. 
If you do not enable Data Quality, selected prospects are promoted to contacts.

When a prospect is promoted, a contact record is created with matching field information, and the 
prospect is removed from the list of prospects.

To promote a single or multiple prospects using the Prospects More Info view

1 Navigate to the List Management screen > Prospects view.

2 Use one of the following methods to promote prospects:

■ In the Prospects list, select a prospect record, and click Promote.

■ To promote multiple prospects, select the prospect records to promote, and click Promote 
Many.

To promote a single or multiple prospects using the views in the List Management 
screen

1 Navigate to the List Management screen > Lists view.

2 Click the list name.

3 Click the List Contacts and Prospects view tab.

4 Use one of the following methods to promote prospects:

■ In the Contacts and Prospects list, select a prospect record, and click Promote.

■ To promote multiple prospects, select the prospect records to promote, and click Promote 
Many.

To promote a prospect to an opportunity using views in the Campaigns screen

1 In Navigate to the Campaigns screen.

2 In the Campaigns list, select a campaign.

3 Click the Overview view tab.

4 In the Overview list, select a prospect record, and click Create Opportunity.
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About Promoting a Prospect�s Response to an Opportunity
A prospect that responds to a campaign offer can be promoted by promoting the response to an 
opportunity in the Responses screen. For more information, read Promoting Responses to 
Opportunities on page 152.

Promotion Map Modifications
List Management provides a default path for information to move from the prospect record to the 
contact record during promotion. Prebuilt maps specify where in the contact record prospect fields 
should be copied when a prospect is promoted. List Management provides three prebuilt maps for 
moving prospect information during promotion. Table 48 contains prospect information.

Using Siebel Tools, you can redirect any of these prospect fields to a field associated with another 
business component. For example, you may decide that you do not want to use the Alias field for the 
prospect and would like it to hold some other information such as a Back Office Account ID. You may 
also want to promote that ID to populate a specific field on the contact record, possibly an extension 
column added to your implementation. To view or change the promotion map, in Siebel Tools, 
navigate to Business Components >List Mgmt Prospective Contact > Business Component User 
Properties.

You can display the destination business component by looking under Business Component User 
Properties for the List Mgmt Prospective Contact and searching for the Map Name in the Name 
column. The path for the map is displayed as Destination Business Component: Source Business 
Component. For example, Contact: List Mgmt Prospective Contact.

In this case, all three default maps use the List Mgmt Prospective Contact business component as 
the source.

Table 48. Prospect Information

Map Name
Information 
Promoted

Source Business 
Component

Destination 
Business 
Component

LM Contact Map Contact related 
information such as 
First Name, Email 
Address, and Job Title

List Mgmt Prospective 
Contact

Contact

LM Account Map Account related 
information such as 
Annual Revenue and 
Line of Business

List Mgmt Prospective 
Contact

Account:List Mgmt 
Prospective Contact

LM Business Address 
Map

Business Address 
information such as 
City, Country, and 
Postal Code

List Mgmt Prospective 
Contact

Business Address
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To modify the promotion map, you can change a user property in the map to promote the information 
to a different field in the Destination Business Component for the map.

Alternatively, if you wish to promote user properties to a destination business component other than 
the three default maps, you could create a new map for those user properties.

Modifying Map Entries
To insert or modify a map entry, first determine which map to use for a given set of source and 
destination fields. Then add an entry using the following syntax:

Name: Promotion Map:[Destination Integration Component].[Field Name of Destination 
Integration Component]
Value: [Field Name of Source Integration Component]

■ Map Name. The name of the map specified under the corresponding row in the Business 
Component User Properties.

■ Destination Field. Field in the Destination Business Component to receive source data. The 
Destination Business Component is map specific but configurable.

■ Source Field. Field in the Source Business Component from which to extract data. Source 
Business Component is map specific but configurable.

Example:

Name: Promotion Map.Contact.First Name
Value: First Name

Each map only works with a specific source and destination Business Component. However, you can 
make copies of the Business Components and rename them.

To modify the source and destination Business Components of these mappings, modify the following 
Business Component User Prop:

Name Column: [Map Name]

Value Column: [Destination Business Component]:[Source Business Component]

Process of Viewing and Maintaining Lists
A list in Siebel Marketing is a group of contact or prospect records in the Siebel database. The list 
file name is assigned by Siebel Marketing in the following format:

{P or L}/[campaign source code][wave code]_[unique identifier].txt

NOTE: P stands for Preview and L stands for List.

If there is a need to influence the list�s file name, you can change the Campaign Source Code by 
modifying the Source Code Field in the Campaigns screen�s All Campaigns across Organizations view 
or change the campaign�s Wave Code in the Campaigns screen�s Waves view tab.

To view and maintain lists, perform the following tasks:
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■ Displaying Lists of Contacts or Prospects on page 202

■ Deactivating or Deleting Lists on page 203

■ Removing Prospects or Contacts from Lists on page 203

Displaying Lists of Contacts or Prospects
You can view the list members and details about them in several ways. If you know the name of the 
list, you can start at the Lists view. To display other lists a contact or prospect may be on, you can 
also start at the Contacts or Prospects List view.

To display a contact or prospect list from the Lists view

1 Navigate to the List Management screen > Lists view.

2 In the Lists list, select the list record.

3 Click the list name.

The List Contacts and Prospects view appears. This view shows the contacts or prospects on the 
list you selected. If the Contact column is checked, the person is a contact. In addition, the 
person�s name appears either in the Contact Last Name or Prospect Last Name column to further 
identify if the person is a contact or prospect.

4 Click the Last Name, and one of the following views appears:

■ If you clicked a Contact name, the Contacts > Contacts List view appears, with the Activities 
view tab selected.

■ If you clicked a Prospect name, the List Management > Prospects view appears, with the 
More Info view tab selected.

To view contact or prospect information from the Contacts or Prospects List view

1 Navigate to the List Management screen > Lists view.

2 From the List Management link bar, click Contacts or Prospects.

Depending on which you chose, the Prospect List view or Contact List view appears.

3 Select the record of the Contact or Prospect you are interested in.

4 Click the Last Name, and one of the following views appears:

■ If you clicked a Contact name, the Contact Detail view appears, with the Activity view tab 
selected.

■ If you clicked a Prospect name, the Prospective Contact Market Segment view appears, with 
the Prospect Additional Attributes view tab selected.
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Deactivating or Deleting Lists
You can deactivate or delete lists using the following procedures.

Deactivating Lists
Many times lists are acquired from outside sources such as other companies, Web sites, and events 
such as seminars and trade shows. Because this data typically represents prospective customers who 
are not active customers, you may wish to deactivate any remaining prospects who have not been 
promoted to contacts. Additionally, lists can be generated by different users for a specific campaign 
or business situation, so you may want to keep lists active only for a specified period of time.

To deactivate a list

1 Navigate to the List Management screen and select the Lists view.

2 In the Lists list, select a list to deactivate.

3 In the Lists form, change the status to Inactive, or set the expiration date.

The expiration date is an information-only field and does not affect your use of the list.

Deleting Lists
This action deletes the list as well as the association with any contact or prospect records.

NOTE: Deleting a list does not delete the contact or prospect records, only the association between 
the list and contact or prospect records. This is because those names may also be used on other lists.

To delete a list

1 Navigate to the List Management screen and select the Lists view.

2 In the Lists list, select a list to delete.

3 Click the menu button and choose Delete Record.

Removing Prospects or Contacts from Lists
You can remove prospects or contacts from lists using the following procedures.

Removing Prospects from Lists
A prospect cannot be removed from a list using the List Contacts and Prospects view, because the 
prospect may appear on more than one list. You have more control over individual prospect lists 
when you remove the association between the prospect record and its list. If you remove the list 
associations for a prospect, the prospect record is deleted.
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To remove a prospect from a list

1 Navigate to the List Management screen > Lists view.

2 Click the list name.

3 Click the List Contacts and Prospects view tab.

4 In the List Contacts and Prospects list, select a record to remove, and click the first or last name 
of the prospect.

5 Click the Prospect Lists tab.

6 In the Prospect Lists list, select and delete the list or lists from which to remove the prospect.

If you select and delete all of the lists, the prospect record is also deleted.

You can also purge all prospects from a list using the following procedure.

NOTE: The contacts that remain in a purged list do not load into campaigns. Do not associate a 
purged list with a campaign.

To purge all prospects from a list

1 Navigate to the List Management screen > Lists view.

2 In the Lists list, select the list record.

3 In the lower form, click Purge List.

4 When the confirmation dialog appears, click OK, and then click OK again to submit the request.

This action removes all prospects where the Promoted By and Promoted Date are NULL 
(indicating they have never been promoted).

5 To confirm the prospects were deleted, drill down on the name of the list in the upper list applet, 
and go to the List Contacts and Prospects view tab.

Removing Contacts from Lists
Contacts can be removed from all lists, but the Contact record remains in the database.

To remove a Contact from a list

1 Navigate to the List Management screen > Lists view.

2 Click the list name.

3 Click the List Contacts and Prospects view tab.

4 In the List Contacts and Prospects list, delete the record.
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Integrating List Management with D&B
List Management can be used in conjunction with Siebel Dun & Bradstreet (D&B) Integration Solution 
to generate lists of prospects from the D&B dataset. Within Siebel Dun & Bradstreet Integration 
Solution, you can perform a query on D&B accounts and generate a list of prospects from the results 
of the query. These prospects can then be targeted in a campaign and promoted to active contacts.

List Management uses the D&B D-U-N-S number to provide data consistency throughout this 
process. The D-U-N-S number is associated with prospects derived from the D&B data. After a D&B 
prospect is promoted to a contact, the D-U-N-S number is used by the D&B update routine to 
continually refresh the data for those new contacts and their associated account information.

Viewing Account Data for D&B Prospects
The account related to a D&B prospect may already exist as a Siebel account. You can use the 
following procedure to view account information after you promote an account from a D&B account 
to a Siebel account.

To view the account information for a D&B prospect

1 Navigate to the List Management screen > Lists view.

2 In the Lists list, click the D&B list name.

3 In the List Contacts and Prospects list, click the name in the Prospect Last Name field.

NOTE: Make sure you select the Prospect Last Name and not the Contact Last Name.

4 Click the More Info view tab.

5 In the Prospects list, click the Matched Account Name.

If there is no matching account name, the field is blank.

Promotion of D&B Prospects
When you promote a D&B prospect to a contact, promotion checks if a Siebel account with the same 
D-U-N-S number exists and the following actions occur:

■ If a Siebel account exists with that D-U-N-S number, the promotion proceeds according to the 
standard promotion process in Promotion of Prospects to Contacts on page 198. After the 
promotion, any other prospects from that same D&B account are removed from the list.

■ If there is no Siebel account with that D-U-N-S number, the application invokes the D&B account 
promotion, which then promotes the account and its associated contacts, industry information, 
and other information. For more information, read the chapter about D&B in Applications 
Administration Guide.

NOTE: List Management does not promote a prospect with an invalid D-U-N-S number. A D-U-N-S 
number is considered invalid if it is not contained in the D&B Accounts table.
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10 Setting Up and Using Web 
Marketing
Siebel Web Marketing is an optional Siebel Marketing module that provides you with the tools and 
templates to manage and execute Web-based marketing. It provides the Web site visitor a method 
of viewing a Web offer, downloading literature, and using preconfigured Web response forms to 
request more information or ask you to contact them by telephone.

You can modify the look and feel of Web Marketing to match your existing Web site.

Siebel Web Marketing Web sites can be deployed in more than one language. For more information 
about deploying applications in a multilingual environment, read Global Deployment Guide.

This chapter contains the following sections:

■ Web Marketing Web Site Visitors on page 207

■ Siebel Web Marketing Installation Requirements on page 209

■ Control of User Access to the Web Marketing Web Site on page 209

■ Default Responsibilities and Users for Web Marketing on page 210

■ Default Campaigns and Default Offers on page 211

■ Use of Siebel Personalization with Web Marketing on page 211

■ Customization of the Web Marketing User Interface on page 212

Web Marketing Web Site Visitors
A Web site visitor can navigate to the Web Marketing home page by typing the URL or by clicking a 
hyperlink on another Web page. At this point, the visitor is anonymous and can choose to register, 
log in (with an existing user name and password), or continue to navigate anonymously. When the 
anonymous visitor arrives at the Web Marketing home page, the default campaign offers and the 
details for the first offer in the Featured Offers list appear. If the visitor registers or logs in, the visitor 
sees other campaign offers for which he or she is eligible. For more information about default offers 
and default campaigns, read the description of featured offers in Web Marketing Offers Page on 
page 215.

If a contact logs in using the contact�s user ID and password, any responses generated by this 
customer are tagged with the customer�s account ID and with the associated campaign ID. For more 
information about setting up users, read Default Responsibilities and Users for Web Marketing on 
page 210.

Web site visitors can also navigate to the Web Marketing site by clicking an embedded URL from 
within an email offer. Only contacts or prospects receive these offers. When an email contact or email 
prospect clicks an embedded URL, the Web Offer page for this offer appears. Any responses to the 
offer from this contact or prospect are tagged with the associated campaign ID and offer ID, so 
marketers can track response rates for specific campaigns. For a list of responses that are captured, 
read Response Management on page 213.
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Visitors to your Web Marketing home page are categorized as follows:

■ Anonymous Visitor on page 208

■ Email Contact on page 208

■ Email Prospect on page 208

■ Logged-In Contact on page 209

Anonymous Visitor
Any visitor can enter the Web Marketing URL into a Web browser and navigate to your Web Marketing 
home page. This visitor sees no personalized Welcome message and responses are not captured 
when the visitor clicks a Recommended Product link or downloads literature. However, an anonymous 
visitor can create a product information or call response by clicking the Send Product Information or 
Request a Call link in the Offers page or Information page. The profile information that the 
anonymous visitor enters creates a prospect record that is associated with the responses.

Email Contact
When a contact clicks an embedded link in an email, your Web Marketing home page appears and 
the Contact Id is set in an anonymous session. At this point, the email contact is not logged in. The 
contact must be a registered contact and must log in to access profile information in the My Accounts 
link or to perform any other tasks that require the contact to be a registered contact. The email 
contact can generate responses by clicking a Recommended Product link, downloading literature, or 
requesting product information or a telephone call.

In the Web Marketing home page, the contact can log in. After logging in, the email contact becomes 
a logged-in contact.

If an email contact clicks the My Accounts link during an anonymous session, the User Login (user 
registration) view appears, requiring the anonymous visitor to log in before continuing.

Email Prospect
When a prospect clicks an embedded link in an email, your Web Marketing home page appears, and 
the Prospect Id is set in an anonymous session. At this point, the email prospect is not logged in. 
The prospect must become a registered contact and must log in to access profile information in the 
My Accounts link or to perform any other tasks that require the prospect to be a registered contact. 
The email prospect can generate responses by clicking a Recommended Product link, downloading 
literature, or requesting product information or a telephone call.

In the Web Marketing home page, the email prospect must register as a new contact before the 
prospect can log in. In the User Login applet, the email prospect can enter a user ID and password 
or click the New User link to register as a new contact and obtain a user ID and password.
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In the User Login view, the User Login (user registration) view appears, requiring the anonymous 
visitor to log in or to register as a new user before continuing. When registration is complete, the 
prospect is converted to a new logged-in contact. However, the original email prospect�s responses 
are not associated with the new contact record. After logging in, the email prospect becomes a 
logged-in contact.

NOTE: If an email prospect clicks the My Accounts link during an anonymous session, the User Login 
(user registration) view appears, requiring the anonymous visitor to log in or to register as a new 
user before continuing.

Logged-In Contact
This contact has access to the My Account link and can perform all other tasks that a registered 
contact is eligible to perform. The logged-in contact can generate responses by clicking a 
Recommended Product link, downloading literature, or by requesting product information or a 
telephone call. These responses are associated with the contact record in the database.

Siebel Web Marketing Installation 
Requirements
Before you install and use Web Marketing, you must install the following:

■ Siebel Web Engine and related components. To deploy information on the Web and customer 
applications, you must install the Siebel Web Engine and the components on which it depends. 
These include a Web server, Siebel Gateway Name Server, and Siebel Server. For more 
information about installing components, read the Siebel Server installation guide for the 
operating system you are using.

■ Siebel Applications. To perform administrative tasks such as server administration, creating 
Web offers, and managing marketing activities, you must install an employee application such 
as Siebel eSales and add the Siebel Web Marketing license key. For more information about 
installing an employee application, read the appropriate administration guide, for example, 
Siebel eSales Administration Guide.

NOTE: Siebel Web Marketing is an add-on module to Siebel Marketing. Siebel Web Marketing 
requires the Web Marketing Object Manager component, which is part of the Marketing Component 
Group. For more information about installing Siebel Marketing, read Siebel Marketing Installation and 
Administration Guide and the Siebel Server installation guide for the operating system you are using.

Control of User Access to the Web 
Marketing Web Site
To control user access in your Siebel Web Marketing Web site, the following options are available:
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■ Using external authentication using LDAP (Lightweight Directory Access Protocol)

LDAP is an Internet protocol that email programs use to look up contact information from a 
server.

■ Creating database users for LDAP to use in database access

■ Defining visibility for views and products

■ Assigning a proxy employee

■ Creating users through registration or user administration

■ Associating users with accounts

■ Allowing various levels of access such as Anonymous, Implicit login, and Explicit login

■ Customizing access to home and login pages. For more information, read information about the 
New User link in Web Marketing Offers Page on page 215.

■ Using Web Single Sign-on (SSO) functionality

■ Allowing another application to log in

■ Adding fields to registration forms

For more information on controlling user access, read Security Guide for Siebel Business 
Applications.

Default Responsibilities and Users for 
Web Marketing
Responsibilities control which views the users can display. The views to which a user has access 
determines the links and page tabs that the user gets. For example, if a user has a responsibility 
that does not permit access to the Credit Cards view, no Credit Cards link appears in the My Settings 
view. If no views within a business object are visible, the page tab that maps to that business object 
is not displayed.

The responsibilities predefined for Siebel Web Marketing include:

■ Web Anonymous User. Grants view visibility to anonymous users such as anonymous visitors, 
email prospects, and email contacts. For more information about these user types, read Web 
Marketing Web Site Visitors on page 207. This responsibility allows the user to access views that 
do not have the Requires_Explicit_Login flags set to TRUE in Siebel Tools. For more information, 
read Using Siebel Tools.

■ Web Registered User. The end user of the application in a business-to-consumer model such 
as a logged-in contact. For more information about these user types, read Web Marketing Web 
Site Visitors on page 207. This user has registered and is recognized by the application either 
through their login, or because the user enters the site by clicking an embedded link in an email 
offer.

■ Web Corporate User. The end user of the application in a business-to-business model. A Web 
corporate user is associated with an account and must be authorized by the Web Delegated 
Customer Administrator to access the site. An administrator can add new Web corporate users.
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For more information about setting up and managing responsibilities, read Security Guide for Siebel 
Business Applications.

Default Campaigns and Default Offers
Assigning a default campaign and offer is part of the Web Marketing setup process. An offer 
associated with the default campaign can be designated as the default offer.

You specify the default campaign and default offer in the Application Administration screen in the 
System Preferences view. To assign a default campaign, complete the Default Campaign Code field. 
To assign the default offer, complete the Default Offer Code field.

The default campaign and default offer determine which offers are presented to the customer during 
that customer�s Web Marketing session. These offers appear in addition to any targeted offers such 
as an embedded link in an email offer.

For more information about default offers and default campaigns, read the Featured Offers topic in 
Web Marketing Offers Page on page 215

Use of Siebel Personalization with Web 
Marketing
Siebel Personalization delivers personalized content and offers to a customer profile, needs, 
interests, and history. Personalized content includes greeting users by name, presenting them with 
content targeted to their needs and interests, and showing them recommended products and offers 
based on their needs and history.

Using Siebel Personalization, you can define rules to show and hide content dynamically during a 
visitor's experience with Siebel Web Marketing. Personalization deployment rules can depend on data 
such as user's profile information, date ranges, company information, products and services that 
visitor has already purchased or reviewed, and specific session information.

The home page in Siebel Web Marketing includes the salutation applet in the upper-left corner. It 
typically includes a personal greeting, but it can be configured to deliver targeted content such as 
product promotions, announcements, birthday greetings, and offer updates. The home page also 
contains a list of recommended products and featured offers, both of which can be personalized 
based on user-specific information. Conditional expressions can be used to hide applets under certain 
conditions.

You manage personalization in the Personalization Administration screen in your application. For 
more information about administering personalization, read Siebel Personalization Administration 
Guide.
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Customization of the Web Marketing 
User Interface
The product provides a set of Web templates and cascading style sheets (CSS) to create the look 
and feel of an application. Customers can create their own look and feel by modifying corporate 
logos, colors, and fonts in the style sheets and Web templates. When you modify these elements, 
make sure you save a backup copy in case you want to restore the original files.

NOTE: These elements are not automatically upgraded during the upgrade process.

The Siebel Web architecture uses the Siebel Web Engine (SWE) to dynamically generate HTML pages. 
The SWE uses configuration information in the Siebel Repository (SRF) and HTML layout information 
in the Siebel Web Template (SWT) to merge data with the template when creating the HTML page.

Web Templates
A Web template defines the layout and formatting elements of the user interface (UI), such as views, 
applets, and controls. These UI elements are associated with the templates by using Siebel Tools. 
The associated information is stored in the SRF file. For example, you may have a View object with 
three applets. You associate a View Template with the view, and map each applet to a placeholder in 
that template. The advantage of this approach is that the UI objects in the repository are not hard-
coded in individual templates. As a result, a number of View objects can share the same template if 
they share the same layout. The same process and design applies to applet objects.

The three primary templates types are Container, View and Applet. The final HTML pages created by 
the SWE places the applet in the view and the view in the container. Siebel Business Applications 
provide numerous applet and view templates with the product. They can be viewed in Tools, but are 
edited in an external editor. For more information about the physical user interface layer, read Using 
Siebel Tools.

To change the look and feel of your Web site, the following modifications are available:

■ Adding or removing applets

■ Changing colors

■ Changing controls

■ Making fields in a form appear

■ Modifying behavior caused by clicking a button

■ Modifying views and applets

■ Modifying Web Templates

For more information about customizing the user interface, read Using Siebel Tools.
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Web Marketing Without Frames
Customer and partner applications use HTML frames for compatibility when running in browser-based 
applications. HTML frames creates portions of the browser window that can scroll independently of 
the rest of the window. For example, you can place the navigation elements in one frame and content 
in another frame. You can scroll the content while the navigation elements remain in a fixed location.

Customer and partner applications can be implemented without using frames. Before choosing this 
method, consider the following limitation. In an unframed application, all UI elements exist in the 
same window. Therefore, the contents list may scroll off the page you scroll down. For example, if 
you scroll down to review content, the navigation elements may not be visible.

Full-Text Search
Siebel Search for Customers is a subset of the Siebel Search product. Use it to scan database tables 
and documents for pertinent information. Siebel Search is included with every license of an Oracle 
Siebel application. For more information about Siebel Search and Siebel Search for Customers, read 
Siebel Search Administration Guide.

Response Management
Siebel Web Marketing to capture a series of responses during a customer interaction. Table 49 lists 
the responses captured.

Table 49. Responses Captured by Siebel Web Marketing

Response Description

Clicked on Product URL Captured when the recipient clicks the embedded link for the product 
in an email or Web offer.

Clicked on Web Offer Captured when the recipient clicks the embedded link for a Web offer 
in an email offer.

Clicked on Web Survey Captured when the recipient clicks the embedded link for the Web 
survey in an email or Web offer.

Completed Web Survey Captured when the recipient clicks Finish on the Web survey view. 
The survey answers are captured if the Save Answer field is checked 
for the question on the SmartScript Administration views. For more 
information, read Siebel SmartScript Administration Guide.

Downloaded Info/File Captured when the recipient clicks the embedded link for the 
document that is downloaded in a Web offer.

Requested call back Captured when the recipient submits a request after clicking the 
embedded link in an email or Web offer.

Requested more info Captured when the recipient submits a request after clicking the 
embedded link in an email or Web offer.
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Additional responses and events can be captured through configuration. For more information, read 
the event tracking topics in Using Siebel Tools.

Siebel Web Marketing Web Site
The Siebel Web Marketing Web site consists of the Offers page, the Information page, and their 
related views. Using the navigation bar, you can manage your personal profile by changing 
preferences in the My Settings view.

Web visitors access the My Settings view by clicking the My Account link in the navigation bar of any 
Web Marketing page. Table 50 lists the links in the My Settings view that users and visitors can use 
to manage their personal profiles.

NOTE: Auction Privilege, Lister Payment, Notification Preferences, and Shipping Terms, are not used 
at this time.

Requested Unsubscribe Captured when the recipient submits a subscription preference 
updates after clicking the embedded link in the email offer. In 
addition to the response, the contact profile is updated.

Submitted Source Code Captured when a contact or prospect enters a source code and offer 
code in the Do you have Another Offer form in the Offers page.

Table 50. Personal Profile Links in the My Settings View

Link Description

Address Book A list of available addresses for the visitor. Visitors can add, delete, 
and modify their address, and the changes update their information 
in the Siebel database.

Credit Cards A list of available credit cards for the visitor. This view is not 
required if you do not implement the Siebel eSales module or if you 
do not want to use credit card management.

Subscription Preferences A series of channel-specific and general communication preferences 
for each visitor. This view could be modified through Siebel Tools to 
include additional subscription preferences, for example by product 
or area of interest. These preferences could then be used to drive 
marketing activities for that visitor. This view appears when a visitor 
clicks on the Request Unsubscribe embedded URL in an email and a 
response is created when the visitor clicks Submit. The individual�s 
preferences are also updated in the Siebel database.

User Profile A series of user profile fields, which the visitor can modify. This view 
can be extended to display additional profile information.

Table 49. Responses Captured by Siebel Web Marketing

Response Description
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Web Marketing Offers Page
The default home page for Web Marketing is the Offers page. The center applet of this view contains 
the specific Web offer intended for each Web site visitor. The Offers page provides links to other 
views, including additional offers, product information, Web surveys, and account and contact profile 
information.

The Offers page has several configurable applets, which this topic describes.

Salutation
The salutation text that appears depends on the personalization rules that are applied for the visitor 
who accesses the page. After logging in, registered email recipients or Web users get a greeting 
customized with their names. An anonymous Web visitor�s greeting says �Welcome!� You can change 
the salutation greeting text in the Personalization Administration views.

NOTE: When Web Marketing is deployed as part of the eCustomer application (a bundle of eSales, 
eService and Web Marketing), the visitor can display the Offers page (Web Marketing home page) 
and the eCustomer home page. Because the eCustomer home page has a salutation greeting, the 
salutation greeting is suppressed in the Offers page (Web Marketing home page).

The New User Link
You can set up the New User link that appears in the User Login applet so a Web site visitor can create 
a user ID and password for limited access to your Web Marketing Web site. When a visitor clicks New 
User on the Web Marketing home page, the registration views appears. The process is managed by 
a workflow business process that you can modify in Siebel Business Process Designer. For more 
information, read Siebel Business Process Designer Administration Guide.

NOTE: If a prospect registers, the prospect is converted to a contact. After becoming a contact, 
responses captured for the prospect are not associated with the new contact record. For more 
information, read Security Guide for Siebel Business Applications.

Web Offer
The center applet of the Offers page displays Web offer details. The applet contains the contents of 
the Web offer presented to the visitor. The Offer that appears is determined in the following ways:

■ The offer details are based on the Web-offer link that the visitor selects in an email.

■ The offer details are based on how Siebel Personalization sorts the offers in the Featured Offers 
applet. Details for the top offer in the Featured Offers applet appear in the center applet.

NOTE: If no featured offers exist, the Featured Offers area displays nothing.

Recommended Products
This applet contains a list of recommended products, customized for each visitor based on that 
visitor�s Web profile attributes. This list can be modified using the Personalization Administration 
views. Unidentified visitors get a default listing.
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Featured Offers
This applet displays every Web offer for which the contact or prospect is eligible. When a visitor logs 
onto a Web site and clicks the Send Product Information or Request Call Back link, the response is 
captured for the default campaign and offer.

Web-offer types have the following characteristics:

■ Web offers associated with the default campaign. When you specify a default campaign, 
the offers associated with that campaign appear in the Featured Offers list. The default campaign 
does not need to be loaded with campaign contacts and prospects. However, the campaign and 
associated Web offers must have active dates, and the Inbound Active flag must be checked.

■ Web offers associated with other active campaigns. These have been loaded with contacts 
and prospects. The offers must have active dates and the Inbound Active flag must be checked. 
Only those contacts and prospects targeted get these Web offers in the Featured Offers applet.

For more information about setting the default campaign or default offer, read Default Campaigns and 
Default Offers on page 211.

Information
This applet contains hyperlinks to the following applets in the Information page:

■ Downloads

■ Send Product Information

■ Request a Call

For more information about these applets, read Web Marketing Information Page on page 217.

Do you have another offer?
This applet contains fields that a visitor can use to enter the offer code and source code and then 
click Submit. An alternate Web offer then appears, and Siebel Web Marketing creates a response. 

Web Marketing Product Detail View
When a visitor responds to an offer (email or Web) by clicking an embedded product URL, a page 
with product details appears for that offer. This view displays details and incentive pricing for the 
selected offer. The price list associated with the offer determines the price shown in this view. The 
person who created the offer is responsible for associating the products and the correct price list with 
the offer. This combination determines the products that can be embedded in the offers and the price 
that appears. For more information about price list administration, read Pricing Administration Guide.

Additionally, this view contains the Related Items applet, showing products that may be of interest 
to the Web visitor. Items in the Related Items list are based on previous purchases or literature 
requests.
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In addition to viewing details, the Web visitor using Siebel eCustomer may purchase the product from 
this view by clicking Add Item. After adding the product, the selected item appears in the Last Item 
Added applet.

NOTE: Checkout functionality exists only if the customer has purchased Siebel eCustomer. If you 
are not using eCustomer, the Add Item button is unavailable.

Web Marketing Web Survey View
When the Web site visitor clicks an embedded URL for a Web survey in an email or Web offer, a 
survey wizard appears that navigates the visitor through a series of questions about the product. 
Survey results can be stored and then analyzed and used for future marketing activities. Web 
surveys are administered using Siebel SmartScripts. For more information, read Siebel SmartScript 
Administration Guide.

About Adding Unstructured Content
Oracle�s Siebel Web Marketing has the ability to display general external and unstructured content 
in the Web Marketing site using the Microsite Management module. For more information, read 
Applications Administration Guide.

Web Marketing Information Page
Web site visitors can use the Information page to download product information and request more 
information. The visitor can reach this page clicking the Information page tab. The Information page 
contains the following applets:

■ Downloads. Clicking a hyperlink opens the literature using the default viewer for that type of 
literature. The visitor can sort this list or search for any specific literature item by name, 
description, type, or date.

■ Request More Information. Used by visitors to request product information (Send Product 
Information) and request a telephone call (Request a Call) using response forms.

Web Marketing Send Product Information View
The Send Product Information view displays a form that Web site visitors can complete to request 
that product information be sent to them.

This view can be accessed from the Offers and Information pages or as an embedded URL link in an 
email offer or a Web offer. The Available Products area lists products for which more information is 
available. This is determined by Catalog visibility. For more information, read Product Administration 
Guide.
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When the Send Product Information or Request Call Back views are accessed using an offer�s 
embedded URL, the list of products is restricted to the products associated with the offer. The visitor 
can browse the list, selecting products of interest, and then move the items to the Selected Products 
list by clicking Add.

A visitor can request information about the one or more items in the Selected Products list by 
selecting the check boxes. To clear an item from the list, choose a Selected Product item, and then 
click Remove. After the Web site visitor chooses the products for which he or she wants more 
information, the visitor clicks Continue to move to the delivery form. In the delivery form, the Web 
site visitor can choose direct mail, email, fax, or phone as the delivery method, and then fill in the 
necessary information for the delivery method. When the visitor clicks Submit, the Confirmation view 
appears listing the products for which the visitor requested information and the delivery information. 
This information is stored as a response of the type Requested More Info.

Web Marketing Request a Call View
The Web site visitor can use the Request a Call view to request a callback about one or more 
products. This view can be accessed from the Offers or Information pages or as an embedded URL 
in an email offer or a Web offer. When accessed from an email or Web offer, the products available 
are limited to those products associated with the offer. When accessed from the Offers or Information 
pages, the products are limited by Catalog visibility.

Requests for a telephone call are initiated in the same way as requests for product information, using 
Available and Selected product lists. After the visitor chooses the products that he or she wants to 
discuss in a callback, the visitor clicks Continue to move to the Request Call form. There the visitor 
provides a phone number, the time of day to call, and adds comments. When the visitor clicks 
Submit, a Confirmation appears containing a list of products for which the visitor requested a 
callback and a list of call preferences. This information is stored as a response of the type Requested 
Call Back.
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error message 160
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offers, about how links appear in an 

offer 105
offers, associating with (procedure) 105
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executing
marketing programs 17
programs 69
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See also internal lists, creating and managing
about 180
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importing 188
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mapping 188, 189
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mapping list columns to 186
existing List Import Format, applying to your 

list 191
fields, mapping to when importing a 

lists 190
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performed 183
List Import Format, about editing the 

settings 191
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server components and tasks, verifying status 

of 180

F
fax offers

See also Delivery Profiles
about and Fax Offer view 98
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offer 99
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Featured Offers applet, about 216
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using aggregate fields 39
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activities, creating and using; 
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list management
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marketing plan organization and 
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about 16
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marketing programs

See also automatic execution of programs
campaign launch status, monitoring 166
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launching 59
designing programs, about 57
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expenses 26, 27
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multilingual deployment, Web 
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multistage programs

about and types of programs 58
launching, about 59

N
named blocks personalization element 96
nested segment

defined 35
using a results set 43

nested segment node 54
net count, defined 35
new features in this release 11
New User Link applet, about 215
not included count, defined 35
Nth splits

creating 53
defined 51

N-tile splits
creating 53
defined 52

O
Offer Analysis (Response) chart, 

viewing 177
offer templates, creating and editing

See also offers, creating and using
about and offer types associated with 75
creating an offer template 76
email offer, associating with 83, 102
offer template associated with an offer, 

editing in the Offers screen 84
offer template associated with an offer, using 

the HTML editor 85
Offer Templates list, adding a template 

to 77
Personalization Categories, about using 90
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template not associated with an offer, 
editing 77

Offer Type Analysis (Response) by Campaign 
chart, viewing 178

Offer Type Analysis (Response) chart, 
viewing 177

offers
applying localization rules 98
campaign, associating with 123
contact call 106
contact call, associating with response 

templates 107
email, about merge fields 93
email, using merge fields 92
merge fields 92, 93
offer code lookups, performing 146
previewing 90
specialized 106
wireless, about 109
wireless, creating 109
wireless, monitoring status 110
wireless, tracking 110

Offers page, using and configurable 
applets 215

offers, creating and using
See also Delivery Profiles; email offers; offer 

templates, creating and editing
delivery profiles, about 99
delivery profiles, associating with a fax 

offer 101
delivery profiles, creating a delivery 

profile 100
direct mail offers, about and Direct Mail Offer 

view 107
fax offers, about and Fax Offer view 98
fax offers, associating an offer template 

with 99
globalization rules, applying to offers 98
literature, associating with an offer 111
media offers, about and Media Offers 

view 107
offer template, associating with an email 

offer 102
offer, creating 72, 80
offers, about 15, 71
offers, modifying 72
product, associating with an offer 75
Web offers, adding attachments to 102
Web offers, Web surveys, events, and URLs. 

about how links appear in an 
offer 105

Web offers, Web surveys, events, and URLs. 
about Web Survey view 104

Web offers, Web surveys, events, and URLs. 
associating with offers 
(procedure) 105

opportunities, campaign, creating for 176
Opportunity Analysis (Response) chart, 

viewing 176
Opportunity Revenue Analysis by Employee 

chart, viewing 174
Opportunity Revenue Analysis chart, 

viewing 173
Order Revenue Analysis chart, 

viewing 174
overwrite existing record mode

about 185

P
personalization categories 90
Personalization Categories drop-down list, 

about and using 90
Personalization, using with Web 

Marketing 211
phone offers, working with

call guides, about and creating 109
call guides, creating a call guide 109

Pick Campaign dialog box, using to define 
new campaign with offer 65

Plan Explorer, using to review marketing 
plan organization and associated 
tactics 29

plan tactics
associating with marketing plans 23
creating 23

planning and budgeting 19
Preview List, about preview not 

working 160
previewing offers 90
priority, defined 35
process flow, marketing 15
Product Detail view, about using 216
products, associating with offers 75
program and campaign organizational tools, 

about 114
program execution schedule

deleting 169
editing 169

Program Execution workflow, about using to 
launch multistage programs 59

program flow
campaigns 62
events 62
lists 62
segment 62
stage 62
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Program Flow Designer, about 57
Program Flow view

See also marketing programs, designing
about using 62
campaign, adding list to 67
new campaign with offer, defining 65
predefined campaigns with associated offers, 

adding 64
segments, adding to a program stage 64
stage, adding to the program 63

program templates
about 68
applying 69
by saving programs 69

programs
See also automatic execution of programs
about 16
campaign launch status, monitoring 166
documents, attaching to 118
email campaigns, suspending and 

relaunching 167
executing 69
loyalty 32
manually launching campaigns 

(procedure) 164
manually launching campaigns, requirements 

for 164
marketing programs, launching 163

promotion map
about modifying and prospect information 

(table) 200
map entries, modifying 201

prospect lists
deleting prospects from list 204
Lists view, viewing from 202

Prospect records, about updating using 
Update Existing Duplicates 
Mode 185

prospects
campaign, adding to 156
campaign, associating with 154
data matching and data cleansing 180
definition 179
list, removing from 203
viewing in Siebel Marketing 157

Prospects List view, using to view prospect 
information 202

Prospects More Info view, using to promote 
a prospect 199

prospects, promoting
Campaigns Opportunity, using to promote a 

prospect 199
List Contacts and Prospects view, using to 

promote a prospect 199

promotion map, modifying, about and 
prospect information (table) 200

prospect, promoting to a contact, about and 
application checks 198

prospect�s response to an opportunity, about 
promoting 200

Prospects More Info view, using to promote a 
prospect 199

purging results set 44

Q
quotas

See campaign quotas, setting up

R
random splits

creating 53
defined 51

ranked splits
creating 53
defined 51

Recommended Products applet, about 215
reject import record mode, about 185
related events, campaign, associating 

with 125
reloading server metadata 37
Request a Call view, about using and 

accessing 218
Request More Information applet, 

about 217
requested and assigned budget, about 24
requirements

result sets 43
response charts

accessing (procedure) 176
Average Opportunity Revenue Analysis 

(Response) chart, viewing 178
Campaign Analysis (Response) chart, 

viewing 176
Offer Analysis (Response) chart, 

viewing 177
Offer Type Analysis (Response) by Campaign 

chart, viewing 178
Offer Type Analysis (Response) chart, 

viewing 177
Opportunity Analysis (Response) chart, 

viewing 176
Revenue Analysis (Response) chart, 

viewing 178
Siebel Campaigns, about viewing in 175

response data
importing, about and List Import view 

described 188
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response fields for mapping import 
data 188, 189

Response Details form, fields (table) 148
response management, using

about 17, 143
attachments, adding 147
automatic response, about creating from 

opportunities and orders 152
offer code lookups, performing 146
opportunities, adding 147
orders, adding 146
products, adding 146
Response Details form, fields (table) 148
response information, adding 144
response, promoting to an 

opportunity 152
source code lookups, performing 145

response template, associating to contact 
call offers 107

responses
adding attachments to 147
adding opportunities to 147
adding orders to 146
adding products to 146

responses management, about 213
responsibilities, setting up for Web 

Marketing 210
result sets

purging 44
requirements 43
saving 43
segment tree 44
using as nested segment 43

Revenue Analysis (Response) chart, 
viewing 178

S
Salutation applet, about 215
saved result set, defined 35
Schedule Calendar view

See automatic execution of programs
Segment Designer

about 33
purpose 37

segment tree branch properties 49
Segment Tree Designer 46
segment trees

about 33
adding segments to 48
adding to stages 67
advanced options 45, 55
allocating 67
allocating to stages 68

constraining list data 54
creating 48
defined 36
eligible audience 54
saving result sets 44
updating counts in 48

segmentation, frequently used terms 34
segments

about 15, 33
adding criteria to 38
adding to segment trees 48
advanced options 45
creating 37
defined 36
nested, defined 35
nested, embedding 39
splitting 51
updating counts 40

selection rules 40
Send Product Information view, about using 

and accessing 217
server components and tasks, verifying 

status of
about and list of components 180
data quality settings, verifying 181
incoming data, validating the structure 

of 182
server metadata, reloading 37
set distribution periods

See waves
Siebel Campaigns, Campaign Achievements, 

viewing 171
Siebel Dun & Bradstreet

account data, viewing for a D&B 
prospect 205

D&B prospect, promoting 205
Siebel eMail Response, about configuring to 

capture email responses 144
Siebel Personalization, using with Web 

Marketing 211
Siebel Web Engine, about 209
skills

skill items defined 139
skill items, associating with a skill 140

SmartScript, setting up 126
source code lookups, performing 145
source codes, about 16
split-by-value node 54
splits

mixing random 52
Nth, creating 53
Nth, defined 51
N-tile, creating 53
N-tiles, defined 52
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random, creating 53
random, defined 51
ranked, creating 53
ranked, defined 51
selecting fields for 53
values, creating 54
values, defined 52

splitting and sampling, defined 36
splitting segments 51
stages

allocating segment tree cells to 68
follow-up 17

stand-alone campaigns
defined 16
executing 17

subject area, defined 36
submit budget requests 31
submitting budget requests 29
subwaves, determining the number 

created 164

T
target cells, defined 36
target level, defined 36
teams

campaign, assigning to 127
organizations inheritance, turning off 60

telemarketing offers, about defining 108
templates

See individual template entries, and offer 
templates, creating and editing

response management, using
See individual campaign items

testing campaigns and offers
See individual campaign items
about 142
business scenario 142
email and fax offers, sending 165
email campaign, testing 143

timelines
See also forecasting for campaigns
about 117

tools
See program and campaign organizational 

tools
tracking wireless offers 110
Trend Analysis by Employee chart, 

viewing 175

U
updating counts

in segment trees 48
in segments 40

URLs
offers, about how links appear in an 

offer 105
offers, associating with 104
offers, associating with (procedure) 105

user interface, customizing
about 212
full-text search, about 213
response management, about 213
Web Marketing without frames, 

implementing 213
Web templates, using 212

V
values sampling 54
values split 52
vendors, about 16

W
Wave Batch Size parameter, subwaves, 

determining the number 
created 164

waves
about 17
about using 65
multiple waves, setting up 66, 159

Web Anonymous User responsibility, 
about 210

web catalog, defined 36
Web Corporate User responsibility, 

about 210
Web Marketing, setting up and using

home page, accessing by visitors 208
Information page, about and applets 217
installing, applications to install before Web 

Marketing 209
Offers pages, using and configurable 

applets 215
Product Detail view, about using 216
Request a Call view, about using and 

accessing 218
responsibilities and users, setting up 

default 210
Send Product Information view, about using 

and accessing 217
Siebel Personalization, using with Web 

Marketing 211
unstructured content, additional 217
user access, tasks to control user 

access 209
user interface, customizing 212
Web site visitor, about 207
Web site, about 214
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Web Survey view, about using 217
Web Offer applet, about 215
Web offers

attachments, adding to 102
offers, about associating with 

(procedures) 105
offers, about how links appear in an 

offer 105
Web Offers Downloads, using to add 

attachments to Web offers 102
Web Registered User responsibility, 

about 210
Web site

user access, tasks to control user 
access 209

visitor, about 207
Web Marketing home page, accessing by 

visitors 208
Web Marketing Web site, about 214

Web Survey view, Web Marketing Offers 
page, about using 217

Web surveys
offers, about links appear in an offer 105
offers, associating with (procedure) 105
Web survey link, about clicking on 104

Web templates, using to customize the user 
interface 212

what�s new 11
wireless offers

about 109
creating 109
monitoring status 110
tracking status 110
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